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1 Introduction
The development of microarray technology means that researchers can now perform 
more experiments and collect more data from each experiment than ever before. 
Researchers need to analyze and organize this mass of data, which presents new 
challenges for the researchers and the software they use.

GCC provides flexible and powerful tools for:

• Entering and organizing information about the sample and GeneChip probe 
arrays.

• Controlling the instruments used to process probe arrays and collect the intensity 
data.

• Tracking the progress of an array through the array processing workflow.
• Working seamlessly with other tools for downstream analysis.

There are several GCC configurations:

• GCC and GeneChip Scanner 3000 system (GCS3000 and FS450)
• GCC and GeneTitanTM system

– GeneTitan Multi-Channel (MC) Instrument
• GCC Only
• GCC and GeneTitan Scanner system

– GeneTitan Scanner Instrument 

New features in v6.1

• Wash only option added to the Multi-Channel (MC) Instrument.
• Enhanced log file collection functionality.

Customer support

Visit thermofisher.com/support for the latest in service and support, including:

• Worldwide contact telephone numbers
• Product support, including:

– Product FAQs
– Software, patches, and updates

• Order and web support
• Product documentation, including:

– User guides, manuals, and protocols
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2 Getting started
GCC provides tools that enable you to process arrays, extract the intensity data for use 
by the probe level analysis software, and organize the resulting sets of data files.

You can use GCC to process:

• Cartridge Arrays
• Array plates for the GeneTitan MC instrument

See ̋ Different array typesʺ on page 14 for more information about the differences in the 
arrays.

To fully use the capabilities of GCC, you need to understand: 

• The components of the software
• The array processing workflow that the GCC components perform
• The types of files that GCC produces and uses
• The structures and tools that GCC uses to organize the resulting data

This chapter describes the above concepts in:

• ʺGCC componentsʺ on page 16
• ʺArray processing workflowʺ on page 21
• ʺFile types in GCCʺ on page 26
• ʺOrganizing dataʺ on page 30

IMPORTANT!  Before running GCC for a particular GeneChip Array, you must have the library 
files for that array type installed on your computer. 
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Different array types

The GCC software may be used to process both cartridge arrays and array plates for 
the GeneTitan MC instrument.

An array cartridge contains a single array, which is processed on its own through 
washing and staining and scanning by using the GCC Fluidics Control and GCC Scan 
Control with the FS-450 Fluidics Station and the GCS3000 scanner. Hybridization is 
performed using instruments that are not controlled by the GCC software. The array 
cartridge is identified by a bar code that can be scanned and used to track the array 
workflow.

Multiple arrays can be scanned sequentially if you use the GCS 3000 AutoLoader.

A 384 or Mini-96 format array plate can be used on the GeneTitan MC instrument. A 
96-format array plate may contain 16, 24, or 96 arrays. 

All the arrays on the plate are processed from hybridization to scanning using the 
GeneTitan MC instrument and the GCC GeneTitan Control software. This enables 
increased automation and consistency in processing when dealing with large numbers 
of samples 

Figure 1   384-format, 96-format, and 24-format array plates and Cartridge array
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The array plate has a barcode for tracking. Each individual array on the plate is 
identified by its row and column. For example, the circled array in the figure below is 
array D05.

Figure 2   Arrangement of arrays on an Array Plate for the GTMC instrument
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GCC components

The features and functions of GCC vary depending upon which instrument or 
instruments it is being used with.

GCC is comprised of the following components:

• GCC Portal: software for sample registration, data organization, and tracking the 
array processing workflow. GCC Portal uses a web interface for user access. 
Other GCC components are installed on your computer and run behind the 
scenes on your computer. These include the Indexer, a service that tracks the 
relationships of files in the GCC data roots. The information is used to keep track 
of the GCC files, for example, in the Folders and Projects views. The services 
typically run behind the scenes without user control, but you may need to change 
their configuration in some circumstances. See ʺGCC servicesʺ on page 33 for 
more information.

• GCC Fluidics Control and GCC Scan Control for processing cartridge arrays:
– GCC Fluidics Control: Software for running the Fluidics Station 450. 
– GCC Scan Control: Software for the GeneChip Scanner 3000 (GCS 3000) and 

GCS 3000 with AutoLoader (AutoLoader). 
• GCC GeneTitan Control and GCC GeneTitan Scanner for processing array plates:

– GCC GeneTitan Control software for running the GeneTitan Multi-Channel 
(MC) instrument.

– GCC GeneTitan Scanner for running the GeneTitan Scanner instrument.

• GCC Viewer: Software for viewing image data and workflow status and 
performing manual gridding.

These tools are used to install necessary files or manage other GCC functions:

– Library File Importer
– Fluidics Script Importer
– GeneTitan Library File Installer
– Data Upload Scheduler
– Email Configuration Editor

IMPORTANT!  A system used as a GeneTitan workstation requires a user account with specific 
privilege settings. In addition, some of the other features of Windows 10 Enterprise 2016 LTSB 
must be set up in particular ways or disabled to avoid causing problems when running GeneTitan 
IC software.

Your system has been set up for use with GeneTitan with the user account AFFXUser. This account 
has these privileges and features already set up.
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Before using GCC

The following prerequisites must be met:

• The necessary GCC components are installed.
• The proper Data Root is set up and selected.

See ʺAdding a data rootʺ on page 78.
• Libraries are installed for the probe array types you want to process.
• The correct fluidics scripts are installed for the probe array types you want to 

process.
See ʺInstalling protocolsʺ on page 175.

• If using remote network data storage or linked instrument control systems, you 
need to perform additional configuration.
See Appendix A, ʺNetworkingʺ on page 340.

Note: GeneChip Command Console (GCC) software has been validated for use 
with your Operating System’s built-in Windows Defender anti-virus software. 
Using other anti-virus software is not recommended, as it may cause 
incompatibility issues.

Starting the GCC launcher

1. Click Start →Thermo Fisher Scientific → GCC Launcher or double-click on the 
GCC Launcher shortcut on the desktop.
The appropriate Launcher appears:

ʺGeneTitan MCʺ on page 18
ʺGCS3000 with fluidicsʺ on page 19
ʺAnalysis onlyʺ on page 20

Required Operating System GCS3000/FS450 
Instrument

GeneTitan MC 
Instrument

GeneTitan 
Scanner

Analysis Only 
Workstation

Windows® 10 Enterprise 2016 LTSB Yes Yes Yes Yes

IMPORTANT!  GCC Launcher menu options vary, as they are based on the type of GCC software 
that was installed.
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GeneTitan MC

Command Console
• GCC Software Portal (See ʺGCC portal home pageʺ on page 47)
• Command Console Viewer (See Chapter 9, ̋ Using the GCC viewerʺ on page 271)
• Gene Titan Instrument Control (See Chapter 8, ̋ Controlling the instrumentsʺ on 

page 228)

Tools
• Thermo Fisher Cloud Administration (See ̋ Monitoring an instrument remotelyʺ 

on page 34)
• GeneTitan Library File Installer (See Appendix D, ʺInstalling library files and 

scriptsʺ on page 362)
• Email Configuration Editor (See Appendix E, ̋ Notification e-mailsʺ on page 370)
• GCC Data Uploader (See ʺScheduling auto-uploadsʺ on page 97)

Resources
• thermofisher.com (Home page)
• Support at thermofisher.com (Services and support page)
• NetAffx (Home page)

Figure 3   GCC Launcher menu - 
GeneTitan MC
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GCS3000 with 
fluidics 

Command Console
• GCC Software Portal (See ʺGCC portal home pageʺ on page 47)
• Fluidics Control (See Chapter 6, ʺControlling the fluidics stationʺ on page 154.
• Scan control (See Chapter 7, ʺScanning cartridge arraysʺ on page 182)
• Viewer (For more information, see Chapter 9, ʺUsing the GCC viewerʺ on 

page 271)

Tools
• Library File Importer (See Appendix D, ʺInstalling library files and scriptsʺ on 

page 362)
• Fluidics Script Installer (See ʺInstalling protocolsʺ on page 175)
• Log Collector (See ʺCollecting GCS3000/FS450 log filesʺ on page 374)
• Reconnector (See Appendix H, ʺReconnectorʺ on page 378)
• GeneTitan Library File Installer (See Appendix D, ʺInstalling library files and 

scriptsʺ on page 362.)

Figure 4   GCC Launcher menu - 
GCS3000 with fluidics
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• Email Configuration Editor (See Appendix E, ʺNotification e-mailsʺ on 
page 370.)

• Data Uploader (See ʺScheduling auto-uploadsʺ on page 97)

Resources
• thermofisher.com (home page)
• Support at thermofisher.com (services and support page)
• NetAffx (home page)

Analysis only

Command Console
• GCC Software Portal (See ʺGCC portal home pageʺ on page 47)
• Command Console Viewer (For more information, see Chapter 9, ʺUsing the 

GCC viewerʺ on page 271)

Tools
• Library File Importer (See Appendix D, ʺInstalling library files and scriptsʺ on 

page 362)
• Reconnector (See Appendix H, ʺReconnectorʺ on page 378)
• GeneTitan Library File Installer (See Appendix D, ʺInstalling library files and 

scriptsʺ on page 362.)
• Data Uploader (See ʺScheduling auto-uploadsʺ on page 97)

Figure 5   GCC Launcher menu - 
Analysis only
GeneChip™ Command Console™ (GCC) User Guide 20



Chapter 2 Getting started
Array processing workflow 2
Resources
• thermofisher.com (home page)
• Support at thermofisher.com (services and support page)
• NetAffx (home page)

Array processing workflow

GCC is used to process the arrays used in your experiment. While GCC provides 
several options and alternatives for processing arrays, the recommended workflows 
for cartridge arrays (Figure 6) and for array plates  (Figure 7) enable you to include 
data about the sample and experiment and to easily track the processing steps for the 
cartridge array or array plate. 

In the recommended array processing workflow for cartridge arrays, you create a 
sample file as the first step, assigning sample attributes and a physical array or arrays 
to the sample. You then:

• Hybridize the array and sample (step not controlled using GCC)
• Wash and stain the array(s)
• Scan the array(s) to create Image data (DAT) files. 

Figure 6   Processing cartridge arrays with GCC

GCC Cartridge Array 

Processing Workflow Steps

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Process Probe Array in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Step performed using:

GCC Portal

GCC Fluidics Control and 
Fluidics Station 450

 GCC Viewer

Thermo Fisher Scientific  and/or 
Third Party Data Analysis Software

GCC Scan Control and:
• GeneChip Scanner 3000 (GCS3000)
• GCS3000 With Autoloader

Hybridize Array and Sample
Not performed by GCC for 

Cartridge Arrays
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After that, GCC aligns a grid on the DAT files and computes the Cell Intensity data 
(CEL) file. 

In the recommended array processing workflow for Array Plates, you create sample 
files for all the arrays on the array plate as the first step. The Hybridization, Fluidics, 
and Imaging of the array plates are completed using the GeneTitan MC instrument. 
After that, GCC aligns a grid on the DAT files and computes the Cell Intensity data 
(CEL) file. 

The CEL data generated in the GCC software from array plate data or cartridge data 
can be used by other software packages for data analysis. 

The workflow steps are described in more detail in the following sections:

• ʺRegistering samples and arraysʺ on page 23
• ʺHybridizing arrays and samplesʺ on page 24
• ʺWashing and staining the arraysʺ on page 24
• ʺRunning scannersʺ on page 25
• ʺTracking gridding and CEL file generationʺ on page 25

The GCC Sample and data files that are created during the workflow are described in 
more detail in ʺFile types in GCCʺ on page 26.

Figure 7    Array Plate Processing Workflow in the GeneTitan MC 
system

GeneTitan Array Plate 

Processing Workflow Steps

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Fluidics on 
array plate

Image arrays on array plate and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Step performed using:

GCC Portal

 GCC Viewer

Thermo Fisher Scientific 
and/or Third Party 
DataAnalysis Software

 GCC GeneTitan MC Control

Hybridize Array Plate 
and Sample
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Registering 
samples and arrays

In GCC, the Sample file is the beginning of the data chain for a given experiment. The 
sample information is stored in a Sample file with an ARR extension. The arrays used 
in analysis and data files produced by analysis are linked to this Sample File. 

The information about the sample(s) and experiment(s) are collected as attributes. 
These attributes can then be used to locate particular Sample files in filtering and 
search operations.

The links between the sample and data files and the GCC tools used to generate the 
sample files are described in more detail below:

• ʺTemplate and user attributesʺ on page 23
• ʺSample registration optionsʺ on page 23

Template and user 
attributes

There are two types of sample attributes in GCC:

• Template Attributes
• User Attributes

Template attributes
A template in GCC is a list of attributes that can be assigned to a Sample file. When you 
create a template, you can specify:

• The attributes included in the template. 
• The data type for each attribute.
• Whether the attribute is required.
• Value options for a controlled data attribute.

After you have created a template you can assign the template to a new Sample file 
during Batch Registration (for cartridge arrays). This automatically adds all the 
attributes in the template to the Sample file. You can then enter values for each 
attribute. This enables you to standardize the attributes that are assigned to samples.

The template functions are described in ʺWorking with templatesʺ on page 330.

User attributes
User attributes are created dynamically during the registration of a sample and array. 
This enables you to create a quick note for a particular sample file.

User attributes are not listed in a template; they have usually been added to a specific 
sample file. They can be used in filtering and search operations, just like the template 
attributes.

Sample registration options
GCC provides multiple ways to create Sample files. To select the best one for your 
operation, evaluate:

• Whether you are creating sample files for cartridge arrays or array plates.
• The number of arrays you are going to be processing.
• Whether you want to enter sample attributes during registration.
• Whether you want to enter attributes at a later time.
• Whether you are creating sample files for samples that were processed in a 96-

well sample prep plate.
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For example:

• Batch Registration enables you to create a group of Sample files for cartridge 
arrays; you can assign attributes to each Sample file, along with one or more 
arrays.

• Detailed Registration creates a single Sample file for a cartridge array; you can 
assign attributes and one or more arrays to the sample file.

• Quick Registration creates multiple sample files for cartridge arrays, each with a 
single array and no attributes (attributes can be entered later).

• Sample Prep Plate Registration creates sample files for cartridge arrays for 
samples in up to two 96-well plates.

• Array Plate Registration creates the sample files for the arrays on an Array Plate 
for the GeneTitan MC System.

• Editing functions correct problems or add attributes to previously created sample 
files.

The Sample registration options are described in Chapter 5, ʺCreating and editing 
sample (ARR) filesʺ on page 102.

In addition, the Drop and Scan feature enables you to create a sample file for an array 
when the array is scanned. Drop and Scan is available for:

• Cartridge arrays (see ʺDrop and scanʺ on page 211)
• Array Plates (see ʺDrop and scan with array platesʺ on page 265) 

Hybridizing arrays 
and samples

For GeneChip cartridge arrays, hybridization is not controlled using the GCC 
software.

For Array Plates, the hybridization is controlled using the GCC GeneTitan MC Control 
software (see Chapter 8, ʺControlling the instrumentsʺ on page 228).

Washing and 
staining the arrays

Different instrumentation and instrument control software used to process Cartridge 
Arrays and Array Plates.

Cartridge arrays
The Fluidics Station 450 (FS450) is used to hybridize, wash, and stain the GeneChip 
arrays (called arrays in this manual). The FS450 can independently process an array 
using a different fluidics protocol in each of four different modules. 

The GCC Fluidics Control software is used to control the FS450. A workstation with 
GCC Fluidics Control software and a Sealevel card installed can control up to eight 
different fluidics stations. The software and its uses are described in Chapter 6, 
ʺControlling the fluidics stationʺ on page 154.

Array plates
The arrays on the Array Plate are washed and stained using the GeneTitan MC 
instrument, controlled using the GCC GeneTitan Control software. The software and 
its use are described in Chapter 8, ʺControlling the instrumentsʺ on page 228.
GeneChip™ Command Console™ (GCC) User Guide 24



Chapter 2 Getting started
Array processing workflow 2
Running scanners Different IC software and instrumentation are used to scan:

• Cartridge Arrays
• Expression Array Plates
• Genotyping Array Plates

Cartridge arrays
The array is scanned after hybridization, washing, and staining, using one of the 
following scanners:

• GeneChip Scanner 3000 (GCS3000) (scans one chip only)
• GCS3000 with Autoloader (load up to 48 chips for scanning without operator 

attention)
The GCC Scan Control Software is used to control the scanner. The software and its use 
are described in Chapter 7, ʺScanning cartridge arraysʺ on page 182.

Expression array plates
The arrays on the array plate are scanned using the GeneTitan MC instrument, 
controlled by the GCC GeneTitan Control software. 

The software and its uses are described in Chapter 8, ʺControlling the instrumentsʺ on 
page 228.

There are some differences in how the arrays from array plates are scanned and the 
data is managed, as described on ʺGeneTitan array platesʺ on page 275).

Genotyping array plates
The arrays on the genotyping array plates are scanned using the GeneTitan MC 
Instrument, controlled by the GCC GeneTitan Control software. 

The software and its uses are described in Chapter 8, ʺControlling the instrumentsʺ on 
page 228.

There are some differences in how the arrays from array plates are scanned and the 
data is managed, as described on ʺGeneTitan array platesʺ on page 275).

Tracking gridding 
and CEL file 
generation

After the array has been scanned, GCC:

• Aligns a grid on the Image (DAT) file to identify the probe cells.
• Computes the probe cell intensity data for the array and creates a CEL file.
• Generates JPG and RPT files.

The GCC Viewer enables you to track the progress of this step in the workflow and 
manually correct gridding problems, if necessary. The Viewer and its uses are 
described in Chapter 9, ʺUsing the GCC viewerʺ on page 271.
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File types in GCC

Different types of information are collected by GCC in different types of files:

• Information about the sample and experiment are collected in Sample files (see 
ʺSample filesʺ, below)

• Probe array data generated during scanning and processing are collected in Data 
files of various types (see ʺTracking files with GUIDsʺ on page 27).

• Audit and Log files contain information about array processing and other 
processes (see ʺOther file typesʺ on page 29)

Globally Unique Identifiers (GUIDs) are used to track the relationships between 
Sample files, physical arrays, and Data Files (see ʺTracking files with GUIDsʺ on page 
27)

Sample files The Sample (ARR) file (Figure 8) collects two types of information:

• Sample Attributes: information that you can use to interpret the experimental 
data. It can include information about the sample itself, the experimental 
conditions, or other information you may find useful. 
You can use the attributes to search for particular files; some attributes can be 
used by the probe level analysis software during analysis. You can use templates 
to manage the attributes used for a particular experiment (see ̋ Template and user 
attributesʺ on page 23 for more information).

• Array Information: Information about the array(s) used with the sample. More 
than one array can be associated with the sample. This is useful for tracking 
replicates; in addition, it can be used to simplify tracking data for multi-chip 
arrays.
Each array is assigned an array name during registration. The array name is used 
to identify the DAT, CEL, and CHP data files that are generated during analysis.
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Tracking files with 
GUIDs

A GUID, or Globally Unique Identifier, is assigned to each file for tracking (Figure 9). 
GUIDs are numbers generated to track a file that are unique to that file.

Figure 8   Sample File with associated arrays and data files

Sample File (Sample.ARR)
With Sample Attributes

Array name: FirstArray
(used for DAT, CEL, and CHP files)

Array name: SecondArray 
(used for DAT, CEL, and CHP files)

DAT File (FirstArray.DAT)

CEL File (FirstArray.CEL)

CHP File (FirstArray.CHP)

DAT File (SecondArray.DAT)

CEL File (SecondArray.CEL)

CHP File (SecondArray.CHP)

Figure 9   GUIDs in Sample and Data Files

Intensity (CEL) File(s) Probe Intensity (CHP) File(s)
Sample (ARR) File

File Name: Sample1.ARR

Sample1 ARR File GUID

Array Name: Sample1Array1

Sample1Array1 Array GUID

Image (DAT) File(s)

File Name: Sample1Array1.DAT

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID

File Name: Sample1Array1.CEL

Sample1Array1 CEL File GUID

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID

File Name: Sample1Array1.CHP

Sample1Array1 CHP File GUID

Sample1Array1 CEL File GUID

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID

Array Name: Sample1Array2

Sample1Array2 Array GUID

File Name: Sample1Array2.DAT

Sample1Array2 DAT File GUID

Sample1Array2 Array GUID

File Name: Sample1Array2.CEL

Sample1Array2 CEL File GUID

Sample1Array2 DAT File GUID

Sample1Array2 Array GUID

File Name: Sample1Array2.CHP

Sample1Array2 CHP File GUID

Sample1Array2 CEL File GUID

Sample1Array2 DAT File GUID

Sample1Array2 Array GUID
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During Sample registration the Sample file is assigned a Sample File GUID. In 
addition, an Array GUID is provided for every array name entered.

Every data file (DAT, CEL, and CHP) generated for an array will contain the Array 
GUID for the array, as well as the GUIDs for each of its parent data files.

The GUIDs enable you to trace the lineage of any data file independent of the file name.

Data files
A set of data files is produced for each array in the Sample file. (Figure 9)

The data files include:

• ʺImage (DAT) fileʺ
• ʺIntensity (CEL) data filesʺ on page 28
• ʺProbe analysis (CHP) Filesʺ on page 28

Each file is assigned a GUID, or Globally Unique Identifier, to be used in tracking the 
relationships between Sample files, physical arrays, and data files. See ʺTracking files 
with GUIDsʺ on page 27 for more information.

Image (DAT) file
The DAT file contains pixel intensity values collected from the scanner, along with the 
gridding information used during feature extraction.

When a DAT file is regridded, the underlying data used by previously generated CEL 
files is changed. A new GUID is assigned to the regridded DAT file, breaking the link 
to any previously generated CEL files. The CEL files are linked with the array via array 
GUIDs, but not to the regridded DAT file. CEL files generated after regridding are 
linked to the new DAT file via the DAT file GUID and to the array by the array GUID. 

Intensity (CEL) data files 
The CEL file stores the results of the intensity calculations on the pixel values of the 
DAT file. This includes an intensity value, standard deviation of the intensity, the 
number of pixels used to calculate the intensity value, a flag to indicate an outlier as 
calculated by the algorithm and a user defined flag indicating the feature should be 
excluded from future analysis. This data is used by the CHP writer software to extract 
the actual data of interest.

JPG files
JPEG files are a copy of the DAT file in a standard image file format; they provide an 
image file with a reduced file size for QC inspection, archiving, and publication.

Probe analysis (CHP) Files
These files, which have file extensions ending in CHP, contain the probe analysis data 
for the array. They are produced by the Analysis Application software and contain the 
actual data of interest (SNP calls, expression data, etc., depending upon the array type).
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Other file types Audit and Log files track the tasks performed by different software components.

Audit files
An Audit file is an XML file that tracks the processing of each physical array processed 
by GCC. An Audit file is produced for each physical array and tracks all the processing 
steps that were performed on the array, including multiple scannings and regridding. 

The audit file has the same root name as the physical array.

See ʺViewing audit filesʺ on page 66.

Log files
Log files are produced by different GCC components. The logs provide a record of the 
tasks performed by different components, such as the migration tools and the installer.

These log files may provide useful information for troubleshooting problems.

See Appendix F, ʺLog files generated by GCCʺ on page 372 for more information.
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Organizing data

To use GCC, you need to understand the structures and tools the software provides for 
organizing your data during and after generation.

This section describes:

ʺFoldersʺ on page 30
ʺProjectsʺ on page 32
ʺData organization tools in GCCʺ on page 33
ʺGCC network functionalityʺ on page 33

Folders GCC uses the Windows file folders on your hard drive to organize your data. 

Note: A folder must be designated as an GCC data root, or must be a sub-folder of a 
designated GCC data root, for the files in that folder to be tracked by GCC (Figure 10).

Windows file folders
These are folders that are on your hard drive, but have not been assigned to a GCC 
Data Root, either directly or by a parent/child relationship. 

These file folders are not searched by the Indexer and the files in them are not 
displayed in the GCC Portal. You can copy GCC files to a system folder using different 
GCC Portal functions, which is useful for sharing data with other users.

Figure 10   Organization of files in GCC

C:\Command_Console\Data Root 1 (on user’s computer)

Subfolder 1 [Project A]

Sample File A1

Sample File A2

SubFolder 2 (not associated with project)

Sample File F1

C:\Command_Console\Data Root 2 (on user’s computer)

Subfolder 1 [Project C]

Sample File C1

\\sharename\share\Network Data Root (on network storage)

Subfolder 1 [Project D]

Sample File D1

Sample File X

Windows® File Folder  (not associated with GCC)
GeneChip™ Command Console™ (GCC) User Guide 30



Chapter 2 Getting started
Organizing data 2
Data roots and sub-folders
A Data Root is a folder that has been specified for Command Console data. Data roots 
are searched by the Indexer and the files in them are listed in the GCC Portal. 

Note: On instrument control workstations, the default data root has to be on the local 
drive and cannot be a USB or an external network drive.

A default data root is created when the software is installed. You can assign other 
folders as data roots, too. A data root can be on the computer running GCC, or on a 
network data storage computer connected with a Windows network. 

A data root on a local drive is indicated as a local drive path: 
C:\Command_Console\Data for example.

Data roots on networked computers are specified using Universal Naming Convention 
(UNC) paths as \\server\share\filepath.

A sub-folder is a child folder created within a data root. The sub-folder and its files are 
also searched by the indexer and listed in the GCC Portal.

For information about setting the data root, see ʺManaging data rootsʺ on page 77.

For information about using a data root on a different computer on a Windows 
network, see Appendix A, ʺNetworkingʺ on page 340.

The data roots and sub-folders and their contents are displayed in the Folder view (see 
ʺFolder viewʺ on page 49).

File and folder security
You can use the Windows Sharing and Security settings to control access to your data 
when using network functionality. GCC supports setting permissions at the folder 
level, not the file level, even though the Windows settings can be set at the file level. 
You can change the settings for Sharing, permissions, and security for a selected file, 
but you need to be very careful about setting permissions when using GCC; you could 
lock yourself out of your own data or deny access to other people if the permissions are 
set incorrectly. Work with your IT department for help in setting the permissions. 

For more information, see Appendix B, ʺWindows sharing and security issuesʺ on 
page 350.

Default folders
A Default folder is a data root or sub-folder that has been set as a destination folder for 
files produced when certain operations are performed:

• Sample and data files produced when performing Drop and Scan.
• Data files for an array that is registered to a Sample file located on network data 

storage. 
For more information, see:

• ʺSpecifying a default folderʺ on page 92
• ʺDrop and scanʺ on page 211
• ʺDrop and scan with array platesʺ on page 265
• ʺGCC network functionalityʺ on page 33
• ʺThe Status window (Figure 220) displays the following information:ʺ on page 185
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Projects A project is a label assigned to a Data Root or sub-folder; the project label can be used 
to organize Sample and data files. If you assign a project name to a Data Root or sub-
folder, all the Sample and data files in that folder are assigned that project name. Any 
child sub-folders of that project folder are assigned the project name, as well. 

Projects have the following characteristics:

• Any Data Root or sub-folder can be a project.
• All sub-folders in a project folder are automatically a part of that project.
• One folder can be a member of more than one project.
• Folders in different locations can be in the same project.

After assigning a project name to a data root or sub-folder, any Sample file placed in 
that data root or sub-folder is assigned to the project. You can then use the project label 
to:

• Display file lists grouped by project
• Search on data limited to a project
• Create a spreadsheet listing the Sample (ARR) files assigned to the project with 

their attributes. The list can be reviewed as a summary of the project information 
or used to edit the Sample (ARR) file content using Batch Edit.

You can also assign a sample file to a project during its creation. This places the Sample 
File and the associated data files in the folder assigned to the project name.

You can move files between projects using Windows Explorer.

For more information, see ʺUsing projects to organize dataʺ on page 80.

Figure 11   Projects and folders in a data root
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Data organization 
tools in GCC

The data organization tools in GCC enable you to:

• View the files in data roots and folders
• Create and manage projects
• Search for files of interest by various attributes, including sample attributes 

entered during registration.
• Add and remove Data Roots
• Upload data to a data root

Note: To perform data management functions, you must use Windows Explorer.

See Chapter 4, ʺPortal and data organizationʺ on page 46 for more information on the 
data organization tools.

GCC services 
The following GCC Services run (in the background) on your computer: 

The following GCC Services run (in the background) on your computer: 

• GCCAuditLogger
• GCCIndexer.
• GCCTaskManager
• GCCWebServer
• GCC WorkflowBroadcastService: This service enables the instrument to notify 

analysis applications that data is available for analysis.
• GCC DeepLaserService: This service enables the instrument to send notifications 

and upload data to the Thermo Fisher Scientific Cloud.

Note: If using network functionality, you may need to change the configuration of 
these services. See ʺConfiguring GCC servicesʺ on page 346.

Displaying GCC WebServer status
For GCC, the GCC WebServer enables the display of the GCC Portal pages; it must be 
running to use GCC Portal. By default, it starts when the computer boots up.

Normal operation is indicated by an icon in the right side of the Taskbar (Figure 12).

GCC network 
functionality

When GCC is installed on a system, then connected to a Windows network, it provides 
additional functionality with options for running the array processing workflow and 
organizing data. These functions include:

• Consolidating the data from multiple GCC workstations on network data storage.
• Performing different parts of the workflow for an array on different workstations 

while consolidating the data on a single workstation.
You may need to change the settings for some GCC Services to use the network 
functionality. See Appendix A, ʺNetworkingʺ on page 340 for more information.

Figure 12   GCCWebServer Icon in status area of 
Taskbar
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remotely
Creating a cloud account

Before you can access and monitor an instrument remotely, you must first create a 
Thermo Fisher Cloud account. 

Note: The Cloud account option is only available on the GeneTtian GCC Launcher.

1. Double-click on the GCC Launcher Desktop shortcut  icon.
The Launcher window appears. (Figure 13)

2. Double-click Thermo Fisher Cloud Administration.
The Administration window appears. (Figure 14)

Figure 13   Launcher window

IMPORTANT!  Before signing up: a) You must have an active Internet connection. b) The Enable 
Thermo Fisher Cloud Connectivity check box must be checked, as shown in Figure 14.
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3. Click CLICK HERE, as shown in Figure 14.
The Thermo Fisher Connect web page appears.

4. Click SIGN UP NOW.
A registration page appears.

5. Complete all fields, then click Create account.
After a few moments, you will receive an email confirming you have been 
successfully added to the Thermo Fisher Cloud.

Figure 14   Thermo Fisher Cloud Administration
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Adding users

1. Click Add User.
The Add user window appears with an auto-generated QR code graphic and 
code, as shown in Figure 15.

Connecting to an instrument remotely 

Smart phone 
(Android OS 5.0+ 
and iOS 9.0+ only)

1. Go to your smart phone’s application store and download Instrument Connect.
2. Install the app as you normally would, then follow the registration and/or sign in 

instructions.
3. Use the Instrument Connect app to scan the auto-generated QR code graphic.

Non-smart phone 
users

1. Go to: apps.thermofisher.com/apps/ic/#/
The Instrument Connect page appears.

2. Click the Add an Instrument button (upper right).
The Add an instrument window appears.

3. Click the drop-down menu, select GeneTitan, then click Next.
After a few moments, you will receive an email confirming your instrument has 
been successfully added to your Thermo Fisher Cloud account.

IMPORTANT!  You cannot add a user(s) while the instrument/scanner is running.

Figure 15   Add user
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4. Open the email and confirm its content coincides with the specific instrument you 
wanted to connect to, then click on the Thermo Fisher Instrument Connect 
hyper-link.
Your browser opens to a Thermo Fisher Scientific/Returning Customer web page.

5. Enter your User Name and Password, then click Sign In.
A Thermo Fisher Cloud Terms of Use window appears.

6. Review and acknowledge the terms, then click Accept.
The Instrument Connect web page appears (Figure 16) and you are now remotely 
connected to the instrument.

The Instrument Connect page features the Instrument’s custom tile (Figure 16) 
that displays the current operational status of the instrument.
– Idle - Instrument is on standby and ready for use
– Running - Instrument is in use.
– Unknown - Instrument has stood idle for more than 24 hours.

Figure 16   Instrument Connect web page
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Managing users 
(optional)

If you are the Administrator or the first to log into the instrument, the Manage users 
link (Figure 16) is enabled (shown in blue).

1. Click on Manage users.
The Manage users window appears. (Figure 17)

– To add a user, return to the Thermo Fisher Cloud Administration window. 
(Figure 14 on page 35)

– To remove a user, click to highlight the user you want to remove, then click on 
the trash can icon. 

– Click Close to close the window.

Figure 17   Manage users window
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Viewing the 
instrument status in 
detail

1. Double-click on the Instrument’s custom tile.
The details page appears. (Figure 18)

The details page displays: 

• While the instrument is running, plate position information and ending time for 
a plate to finish its step is displayed. 

• Remaining lamp life hours.
• Error log window tabs. Any reported errors for the current day and/or past week 

are retained inside these window tabs for your review.

Figure 18   Instrument Connect web page
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Error logs

If needed, you can send instrument error logs to your support representative using 
your Thermo Fisher Cloud account or by emailing a zip file of your log files.

Using your cloud 
account

1. Double-click on the GCC Launcher Desktop shortcut  icon.
The Launcher window appears.

2. Double-click Thermo Fisher Cloud Administration.
The Administration window appears.

3. Click the Select Days drop-down menu to choose the number of logged days you 
want to collect. 

4. Click the Upload Logs to Thermo Fisher Cloud check box, then click Gather 
Logs. (Figure 19)

A percentage of completion wheel graphic appears (lower right), followed by a 
Logs uploaded successfully message. 

5. Click OK to acknowledge the message.
The error log file(s) now reside on the cloud and are ready for your support 
representative to review.

Using the email 
option

1. Double-click on the GCC Launcher Desktop shortcut  icon.
The Launcher window appears.

2. Double-click Thermo Fisher Cloud Administration.
The Administration window appears.

3. Click the Select Days drop-down menu to choose the number of logged days you 
want to collect. (Figure 20)

IMPORTANT!  Before accessing the cloud: a) You must have an active Internet connection. b) The 
Enable Thermo Fisher Cloud Connectivity check box must be checked.

Figure 19   Generate and gather log files
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4. Make sure the Enable Thermo Fisher Cloud Connectivity and Upload Logs to 
Thermo Fisher Cloud check boxes are unchecked, then click Gather Logs.
A percentage of completion wheel graphic appears (lower right). After a few 
moments, a message appears stating your logs have been collected and converted 
to a zip file on your Desktop. (Figure 21)

5. Click OK to acknowledge the message.
6. Compose an email to your support representative, attach the Log Files zip file, 

then send the email as you normally would.

Figure 20   Generate and gather log files

Figure 21   Logs collected message
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Uploading data manually

You can also manually upload your data results to your current cloud folder or sub-
folder, including failed data that has been successfully re-gridded and/or re-scanned.

To manually upload data to the cloud:

1. From the Data Connect web page, click .
A Destination of files window appears. (Figure 22)

IMPORTANT!  Uploading data with unresolved scanning or gridding failures is not 
recommended.

Figure 22   Data Connect web page
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Uploading a folder 1. Click Select Folder 
A Browse for Folder window appears. 

2. Navigate to your folder’s location, click to highlight it, then click OK.
An Uploading Files status window appears (lower right), followed by a Your 
files have been uploaded window.

3. Click X to close this window.
Your manually uploaded folder and its contents now resides in your cloud folder. 
(Figure 22) To share the folder, see ʺUsing the cloud to share data resultsʺ.

Uploading a file 1. Click Select File.
An Explorer window appears.

2. Navigate to your file’s location, click to highlight it, then click Open.
An Uploading Files status window appears (lower right), followed by a Your 
files have been uploaded window.

3. Click X to close this window.
Your manually uploaded file now resides in your cloud folder. (Figure 22) 
To share the file, see ʺUsing the cloud to share data resultsʺ.
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Using the cloud to share data results

While connected to the cloud, you can share your uploaded data results.

To do this:

1. Click the Data Connect  icon.
The Data Connect window appears.

2. From the folder list (left pane), click to select a data folder you want to share.
Any applicable sub-folders appear.

3. Click to select the appropriate folder.
The middle pane populates.

4. From the middle pane, click to highlight the folder or file you want to share, then 
click the Share with people button. (Figure 23)

A Share window appears. (Figure 24)

Figure 23   Data Connect web page
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5. In the Add emails field, enter the recipient’s email address, then click Add.
The email is now populated in the Shared with pane and is retained within the 
Add emails drop-down selection during your next session.

6. Click Confirm.
An email (with a hyper-link to your data) is sent to your recipient(s). 
To delete an email/recipient from the Shared with list, click its adjacent remove 
option.

Figure 24   Share window
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The data organization functions enable you to organize your data and copy files from 
place to place. The functions are described in:

• ʺStarting GCC portalʺ, below
• ʺViewing the data organizationʺ on page 49
• ʺSearching for filesʺ on page 67
• ʺManaging data rootsʺ on page 77
• ʺUsing projects to organize dataʺ on page 80
• ʺGenerating reports and summariesʺ on page 87
• ʺCopying filesʺ on page 88
• ʺSpecifying a default folderʺ on page 92
• ʺUploading data to network data storageʺ on page 92

Disabling fast user switching

Fast user switching is an option in Windows that enables multiple active sessions on 
the console.

This option must be disabled on computers with GCC Portal installed, because it may 
cause a user to take actions under a different user ID and ultimately lock the first user 
from their data.

Refer to your Windows 10 Enterprise 2016 LTSB documentation on how to disable Fast 
user switching.

Starting GCC portal

1. To start GCC Portal:

1. Open the GCC Launcher.
2. Click GCC Portal.

The Home page appears. (Figure 25)
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GCC portal home 
page

The GCC Home page (Figure 25) is your entry point to the GCC Portal functions. 

Home page features
• Menu Bar (see below)
• Search Functions (see ʺSearching for filesʺ on page 67)

Figure 25   GCC Portal Home Page
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The Basic Search Function (Figure 26) enables you to search for files by:

• Array Name
• Attribute Value
• File Name
• Project Name

For more information about the search options, see ʺSearching for filesʺ on page 67.

Home page • GCC Home Page
• Web site and Support links
• NetAffx Analysis Center

Data • Folder View
• Project View
• Data Management functions (see Chapter 4, "Portal and data organization" on 

page 46).

Samples • Sample Registration functions (see Chapter 5, "Creating and editing sample 
(ARR) files" on page 102).

Administration • Project functions (see "Using projects to organize data" on page 80).
• Template functions (See "Working with templates" on page 330).
• Workflow Monitor (see "Tracking the workflow" on page 338).

Help Online help

Figure 26   Search controls

Select Search type Enter search string Click to start search
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Viewing the data organization

You have two different options for viewing the organization of data in GCC Portal:

• The Folder View displays a list of all the Data Roots in the GCC system, along with 
a list of the Sample, Data, and other files in a selected Data Root or sub-folder (see 
ʺFolder viewʺ on page 49).

• The Project View displays the Sample and Data files associated with a selected 
project, showing parent and child relationships between the Sample and Data 
files (see ʺProject viewʺ on page 64).

See ʺOrganizing dataʺ on page 30 for more information about the way data is 
organized in GCC. 

Windows Security issues can impact your ability to view files and data. See 
Appendix B, ̋ Windows sharing and security issuesʺ on page 350 for more information.

Folder view The Folder View displays a list of all the Data Roots in the GCC system, along with a 
list of the content of a selected data root or sub-folder.

To use the folder view:

1. Click View Folder View.
The Folder View appears (Figure 27).
The left side of the page displays the Folders list. 
The right side displays the following items:
– Path to the selected folder
– Folder controls: used to open, add, and rename sub-folders
– Display controls: used to control the display of attributes and file types
– File List with Select controls: used to select files and perform operations on the 

selected files
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The data roots and project folders are displayed in the Folders list (see below). The 
contents of the data roots and project folders are displayed in the File list (see ̋ File listʺ 
on page 54). 

For a description of the file hierarchy used to organize GCC files, see ̋ Organizing dataʺ 
on page 30.

The page links enable you to go to additional pages of data.

Figure 27   Folder view

File List

Folder list

Folder controls
Display controls

Path to selected folder

Select controls
Page links

Figure 28   Folder view controls
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Folders list
The Folders list (Figure 29) shows the data roots, folders, and projects used to organize 
data.

The Folders lists displays the folder names and project names for sub-folders. 

Click on a folder to display its contents in the File list (see below).

The Folders controls enable you to:

• Add a folder (see ʺAdding folders and projectsʺ, below).
• Rename a folder (see ʺRenaming foldersʺ on page 53).
• Open a selected folder in Explorer (see ʺOpening foldersʺ on page 54).

Note: You can add or rename a folder using Windows explorer in addition to the 
GCC Portal functions.

Adding folders and projects
You can add a new sub-folder in a selected data root or sub-folder using the Add 
Folder button. You can optionally assign the folder to a project of the same name when 
you create the folder.

To add a new folder:

1. Select the data root in the Folders list in which you want the new folder to be 
created.

2. Click the Add sub-folder button in the Folder controls (Figure 30).

Figure 29   Folders list

Data Root

Project sub-folders

Sub-folder without project
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The Add Subfolder window opens (Figure 31).

3. Enter the new folder name in the box.
4. Select the Make folder and create project with same name check box to create a 

project in GCC with the same name as the folder.
5. Click Add Folder.

The Folder View page opens with the new folder and project displayed.

Figure 30   Folder controls

Figure 31   Add Subfolder window with folder name entered

Figure 32   New folder

Folder 
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Renaming folders
You can rename a folder using the Rename Folder link.

For information on changing the name of a project, see ̋ Managing Projectsʺ on page 80.

To rename a folder:

1. Select the folder to be renamed.
2. Click the Rename button in the Folders controls (Figure 30).

The Rename Folder page opens (Figure 33).

3. Enter the new folder name in the box.
Select the radio button if you want to change the project name, too.

4. Click Rename.
The Folder View page opens with the renamed folder (Figure 34).

Figure 33   Rename Folder page

Figure 34   Folder View with renamed folder
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Opening folders

To open a folder in Explorer:

1. Select the folder to be opened.
2. Click the Open button in the Folders controls (Figure 30).

An Explorer window opens displaying the contents of the folder. The GCC Portal 
browser shrinks to make room for the window (Figure 35).

File list
The file list displays a list of the files and folders in the selected folder (Figure 36).

The Display controls, at the top, allow you to change the display of attributes and files.

Figure 35   Explorer window with reduced GCC Portal 
browser

Figure 36   File List

Select controls

Display controls

File list

Links to other pages
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The select controls allow you to select files for various operations.

The numbered links below the Select controls enable you to switch from page to page 
of the File list. They are displayed only if the number of files in the selected sub-folder 
exceeds the display limit.

By default the File list displays a table of files with the following columns:

You can conceal some of these columns and display selected attributes in other 
columns. For information about displaying and concealing columns, see ʺSelecting 
attributes for the file listʺ on page 57.

To sort the file list by any column:
• Click on the column header.

Select Use the check box to select a file for different operations:
• Copy Selected Files (see "Copying files" on page 88).
• Create Report from Sample files in List (see "Copying files" on page 88).
• Change Probe Array Type (see Chapter 10, "Probe array types" on page 327).
See "Selecting files" on page 56 for more information.
Placing your cursor over the Select check box displays the full path and file name in a 
popup:

FileName The name of the file or folder.
In some cases the file name is a link. Click on the link to open the following file types:
• Folder: displays the contents of the folder in the file list.
• Sample File: opens the Sample/Array Attributes page (see "Detailed sample 

registration" on page 105).
• Image file (DAT) and Intensity File (CEL): opens the GCC Viewer (see Chapter 9, 

"Using the GCC viewer" on page 271).
• Audit file (AUDIT): opens the Audit File Viewer (see "Viewing audit files" on page 

66)
You cannot use the Action link to open the other file types displayed in the File list. 
These file types can be opened using a text editor (AUDIT, RPT, GRD) or the GCC Viewer 
(CEL, JPG).

Project Name The name of the project that contains the file.

Array Name Name assigned to the array during registration.

Barcode Barcode of probe array (may be an Applied Biosystems or a custom barcode).

Lot Number Manufacturer’s lot number for the array (only displayed with Applied Biosystems 
barcodes).

Expiration Date Expiration date for the array (only displayed with Applied Biosystems barcodes).

Probe Array 
Type

Model number of probe array.

Date Modified Last date the file was modified.
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File types
There are several different types of files in the File List:

• Sample files (ARR)
• Image files (DAT)
• Intensity Data Files (CEL)
• Probe Analysis Files (CHP)
• JPG files (JPG)
• Audit Information files (AUDIT)
• Grid Data files (GRD)
• Project files (PROJECT)
• Report files (RPT)

For more information about the different files, see ʺFile types in GCCʺ on page 26.

See ̋ Selecting file types for displayʺ on page 62 for more information about displaying 
different file types.

Note: Other file types, such as PARAM, may not be displayed in the list or the folders.

Selecting files
You can use the check boxes in the File list to select files for different operations:

• Copy Selected Files (see ʺCopying filesʺ on page 88).
• Create Report from Sample files in List (see ʺGenerating reports for selected 

sample filesʺ on page 87).
• Create Batch Edit file from Selected ARR Files in List (see ̋ Creating the batch edit 

fileʺ on page 149).
• Change Probe Array Type (see Chapter 10, ʺProbe array typesʺ on page 327).

The Select Files controls allow you to select files and operations. The number of 
displayed and selected files are also displayed.

To select files:
• Click the check box next to the file name; or

Click the Select All button.
Click the Unselect All button to deselect selected files.

Figure 37   Select Files controls
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Selecting attributes for the file list
You can add or delete attributes for display in the File List using the Folder View 
feature. The Folder view enables you to create and edit lists of attributes to be 
displayed, called views. You can then select a view for display to customize the 
attributes in the File list.

Note: When cartridge users upgrade, the default folder view does not have well 
position (Pos) in the default folder view. If they have GeneTitan Array Plate data and 
want to see this attribute in the folder view, they will either need to add it to the default 
folder or create a custom view with that attribute. The Pos attribute is part of the 
standard fields.

To select a previously created view:
• In the File controls, Click the View drop-down to select a view. (Figure 38)

The selected View is displayed.

To add a new View:

1. Click the View Customize button. (Figure 38)
The Customize page opens. (Figure 39)

Figure 38   File list with View controls
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There are three steps in creating a new view:
a. Enter a name for the view.
b. Select the source of attributes.
c. Select the attributes and saving the view.

2. Enter a name for the view in the New View Name box and click the Add button. 
(Figure 40)

The view name is displayed in the Select Existing View drop-down box. 
(Figure 41)

Figure 39   Add New Folder View page

Figure 40   New View Name
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In this step, you select the sources of the attributes. (Figure 42)

You have several options for doing this:
• You can limit the display to attributes that are organized in templates.
• You can display user attributes which have been created by the user for 

individual sample files.
• If you want to use standard fields, you can display the fields from all 

templates, or display attributes from templates you select in the Attributes 
Source list.

3. Select the attributes options and templates
The selected attributes are displayed in the Available Attributes list. (Figure 43)

Figure 41   New view name in the Select Existing 
View drop-down box.

Figure 42   Select Source controls
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The Available Attributes list displays the attributes (with template names) that 
are not being currently displayed.
The Displayed Attributes lists displays the attributes that are currently being 
displayed in the Folder view.
The File Name attribute is required and cannot be hidden. 

4. Select and deselect the items you want to display and conceal.
You can double-click on an item in one of the lists to move it to the other list or 
click and drag it over.
You can also use the center controls to add and remove attributes in groups.
Select the Sorted check box to display the available attributes in alphabetical 
order.

5. After selecting the attributes, click Save.
The Folder View is displayed with the newly created view selected in the View 
drop-down box. (Figure 44)

Figure 43   Selected templates with attributes
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To edit a created custom view:

1. Click the View Customize button.
The Customize page opens.

2. Select the view you want to edit from the Select existing view drop-down box. 
(Figure 45)
You can click the Delete button to delete the selected view.

The attributes in the view are displayed in the Select Attributes section. 
(Figure 46)

Figure 44   New View added

Figure 45   Selecting existing view to edit
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3. Select templates and attributes as described on page 57.
4. After you have selected and arranged the attributes, click Save.

You can click Cancel to cancel the changes.
5. The View is displayed in the Folders list with the new attributes selected. 

Selecting file types for display
The File Filter enables you to exclude or include particular file types in the File list.

You can:

• Use a previously created filter
• Create a new file filter.
• Edit a previously created filter

To use a previously created filter:
• In the Filter controls, select the File filter from the drop-down list.

The filtered files are displayed. 

Figure 46   Selecting attributes

Figure 47   Folder list with File Filter controls
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To create a new file filter:

1. In the top of the File list, click the File Filter Customize button (Figure 48).

The File Filters page appears (Figure 49).

2. Enter a name for the new filter in the new Filter list. 
3. Click Add.

The new filter name appears in the Name box.
4. Enter the file types you want to exclude or include in the Patterns box.

Format: *.file extension, (* = wildcard).
Enter multiple file types separated by semicolons (;).

5. Select whether you want to exclude or include the specified file types.
6. Click Save.

The Folder View appears with the edited filter selected.
The displayed files are filtered.

Figure 48   Folder list with File Filter controls

Figure 49   File Filter page
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To edit a file filter:

1. In the top of the File list, click the Customize button (Figure 47).

The File Filters page appears (Figure 50).

2. Select the filter you want to edit from the Filter Name drop-down list.
3. Enter the file types you want to exclude or include in the Patterns box.

Format: *.file extension, where * is a wildcard.
Enter multiple file types separated by semicolons (;).

4. Select whether you want to exclude or include the specified file types.
5. Click Save.

The Folder view appears with the edited filter selected.
The displayed files are filtered.

Project view The Project View displays the Sample and Data files associated with a selected project, 
showing parent and child relationships between the Sample and Data files:

• Array name(s)
• Image (DAT) file(s)
• Intensity Data (CEL) file(s)
• Probe Level Summarization (CHP) file(s)

The Project view also displays basic information about a selected file, and will allow 
you to open and view Sample, DAT, and CEL files.

To view the Sample and data files associated with a project:

1. Click View → Project View.
The Project View pages opens.

2. Select a project from the Project list.
A list of the Sample files associated with that project is displayed. (Figure 51)

Figure 50   File Filter page
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You can expand the file structure by expanding and contracting nodes in the tree.

3. Click on a file to display more information about the file in the right side of the 
page.
Different information is displayed for different files, as shown in Figure 52.

4. For certain files, you can click the Open button to display the file:
• Sample files: Opens the Detailed Registration Page (see ʺDetailed sample 

registrationʺ on page 105).
• DAT and CEL files: Opens the GCC Viewer (see Chapter 9, ʺUsing the GCC 

viewerʺ on page 271).

Figure 51   Project view page with sample files list

Figure 52   Information for selected CEL file
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Selecting files
You can use the check boxes in the Project data tree to select files for different 
operations:

• Copy Selected Files (see ʺCopying filesʺ on page 88).
• Create Report from Sample files in List (see ʺGenerating reports for selected 

sample filesʺ on page 87).
• Create Batch Edit file from Selected ARR Files in List (see ̋ Creating the batch edit 

fileʺ on page 149).
• Change Probe Array Type (see Chapter 10, ʺProbe array typesʺ on page 327).

The Select Files controls allow you to select files and operations. The number of 
selected files are also displayed.

To select files:

1. Click the check box next to the file name; or
Click the Select All button.
Click the Unselect All button to un select selected files.
When you select a parent file, all its child files are also selected. If you only want 
to select the parent file, deselect its child files after selecting the parent file.

2. Select an operation from the Command to Run drop-down.

Viewing audit files Audit files provide a record of the processing done to an array.

To open an audit file:

1. Click on the link in the File List
2. The Audit File page opens. (Figure 54)

Figure 53   Select Files controls
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The Audit File displays information about the processing steps the array has gone 
through, including the instruments and computers used in processing.

Searching for files

You have two options for locating files in GCC:

• ʺBasic searchʺ, below
• ʺAdvanced searchʺ on page 68

The results are displayed in the Search Results page (see ʺSearch results pageʺ on page 
76).

Note: Windows Security issues have an impact on the search function. for more 
information, see Appendix B, ʺWindows sharing and security issuesʺ on page 350.

Basic search The Search Function (Figure 55) enables you to search for files by:

• Array Name
• Attribute Value

Note: Searching by Attribute Value returns any file with any attribute with a 
value that matches the search string. To search for a particular attribute, use the 
Advanced Search.

• File Name
• Project Name

Figure 54   Audit File page
GeneChip™ Command Console™ (GCC) User Guide 67



Chapter 4 Portal and data organization
Searching for files 4
To search for a file:

1. From the Search Files By drop-down list, select your search criteria.
2. Enter a search string in the text box.

You can perform special searches by using the “*” symbol and “OR” operator
“*” Serves as a wild card function. Using searchstring* will return all 
arrays that contain an attribute that starts with the search string. Using 
*searchstring will return all arrays that contain an attribute that ends 
with the search string.
Using the “OR” operator between items (searchstring1 OR 
searchstring2) will return all arrays that contain an attribute that matches 
any of the search strings.

3. Click the Search button .
Files or Projects that match the search string are displayed in the Search Results 
page (see ʺSearch results pageʺ on page 76).

Advanced search The Advanced search provides several ways to refine your search.

To use the Advanced Search:

1. Click Advanced Search in the Search controls. 
The Advanced Search page opens. (Figure 56)

Figure 55   Search controls

Select Search type Enter search string Click to start 
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You create a search in three steps:
ʺStep 1: Specify Array Search Criteriaʺ on page 69
ʺStep 2: Specify Sample Attributesʺ on page 70
ʺStep 3: Select Optionsʺ on page 74

Step 1: Specify Array Search Criteria

This section enables you to search for arrays that match:

• Barcode
• Probe Array Type
• Array Names

2. Enter the criteria for the information you want to find.

Figure 56   Advanced Search page

Array 
Search 
Criteria

Sample 
Attributes

Options

Figure 57   Array Search Criteria
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Step 2: Specify Sample Attributes

This section (Figure 58) enables you to specify attributes used to describe the 
sample and experiment. Depending upon how the search is set up, the search may 
return:
– Samples with any of the specified attributes.
– Samples that match all of the specified attributes.
Four things have to be selected or entered to specify an attribute:
– the source of the attribute (template name or user attribute)
– the attribute name
– the type of comparison
– the value for the attribute
When the Advanced Search page first opens, the sample attributes has three drop-
down lists:
– Select Template
– Select Attribute
– Select Comparison
The Enter Value(s) box does not appear until you have selected a template and 
attribute.

To select an attribute:

3. From the Select Template drop-down list, select a template or other option.
Note: The Sample Attribute Conversion function may impact your selection of 
templates and attributes. For more information, see ʺSample attributes 
conversionʺ on page 118.
The Select Template list displays a list of the templates used by the files in GCC. 
You can also select:
• All attributes: Enables you to perform a blanket search over every attribute in 

the Sample files, both from templates and from user attributes. 
See ʺPerforming an all attributes searchʺ on page 75 for more information.

• No Templates: Enables you to select from user attributes, used in a Sample file 
but not included in a template.

Figure 58   Specifying sample attributes
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4. After selecting the template, a list of attributes appears in the Select Attributes 
drop-down list. (Figure 60)

5. Select the attribute you want to search on.
You can perform different types of comparisons for the search. 
If you select a numerical attribute, you can select from the following limits 
(Figure 61):
• Equal to
• Less than
• Less than or equal to
• Greater than
• Between (displays two entry boxes for the range limits).
• Any value

Figure 59   Selecting a template

Figure 60   Select attribute from list
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F

For date attributes, the comparisons are (Figure 62):
• Equal to today
• Within the last week
• On a specific date: (required)
• Before date: (required)
• After date: (required)
• Between dates: (required)
• Any value

For text string or SingleSelect attributes, the comparisons are (Figure 63):
• Equal to: exact match to the search string
• Contains: text string containing the search string

Figure 61   Comparisons for numerical attributes

Figure 62   Comparisons for dates
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6. Select the appropriate comparison for the attribute.
You can use comparisons with user attributes that have the data type specified, as 
well as sample attributes.

7. Enter a string for the attribute in the Enter Value(s) box.
You can perform special searches by using the “*” symbol and “OR” operator 
when searching for Text attributes.

Note: [*] serves as a wild card function. Using searchstring* will return 
all arrays that contain an attribute that starts with the search string. Using 
*searchstring will return all arrays that contain an attribute that ends 
with the search string.
Using the “OR” operator between items (searchstring1 OR 
searchstring2) will return all arrays that contain an attribute that matches 
any of the search strings.

For date attributes, click on the Calendar icon  and select the date from the 
calendar that appears. (Figure 64)

Click the < and > buttons to display a different month.
8. Click the Add button to add another attribute and repeat Step 3 through Step 7.

Figure 63   Comparisons for text string attributes

Figure 64   Selecting dates
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9. Select how the searches are to be combined:
• Results must match ALL of the selected attributes.
• Results can match ANY of the selected attributes.
After you have finished specifying the attributes, you can select other options.

Step 3: Select Options

This section enables you to search for files that match other criteria:

10. Select or enter the options for the information you want to find.
You can select multiple items in the Type of Results and Projects list by holding 
down the Shift key and clicking on the items.
You can deselect a project by holding down the Ctrl key and clicking on the 
project.
For date attributes, click on the Calendar icon  and select the date from the 
calendar that appears. (Figure 66)

Figure 65   Options for limiting search results

Type of results 
to return

Specify one or more of the following types of files:
• ARR
• CEL
• CHP
• DAT

Limit results 
to the Projects

Projects to be searched. Selecting none runs the search through all the files 
in the main data folder and in all the project folders. You can limit your 
search to one or more project folders using this box.

Creation Dates Date of file creation:
• Equal to today
• Within the last week
• On a specific date: (requires date value)
• Before date: (requires date value)
• After date: (requires date value)
• Between dates: (requires date value)
• Any value

Show results Limit on the number of results to be returned.
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Click the < and > buttons to display a different month.
11. Click Search.

The files that match the search criteria appear in the Search Results list. (Figure 67)

Performing an all attributes search
The All Attribute search enables you to search across all attributes of the following 
types:

• Date
• Number 
• Text

If you use the All Attributes search, it will return any file that has any attribute with a 
value that matches the search string. 

Figure 66   Select date

Figure 67   Search Results list
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Search results page The Search Results page lists the files that meet the criteria specified in your search. 
(Figure 68)

You can:

• Change sort order of the list by clicking at the head of the column you want to sort 
by.

• Change the attributes displayed in the list with the View controls (see ʺSelecting 
attributes for the file listʺ on page 57).

• Use the Select controls to select files for various operations.
Placing your cursor over the Select check box displays the full path and file name 
in a popup (Figure 69):

Selecting files
You can use the check boxes in the Selected column to select files for different 
operations:

• Copying Selected Files to a different location (see ʺCopying filesʺ on page 88).
• Create Report from Sample files in List (see ʺGenerating reports for selected 

sample filesʺ on page 87). The Report can be used to review the file attributes.
• Create Batch Edit file from Selected ARR Files in List (see ̋ Creating the batch edit 

fileʺ on page 149)
• Change Probe Array Type (see Chapter 10, ʺProbe array typesʺ on page 327).

Figure 68   Search Results list

Figure 69   Popup showing 
path and name
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The Select Files controls allow you to select files and operations. The number of 
selected files are also displayed.

To select files:

1. Click the check box next to the file name; or
Click the Select All button.
Click the Unselect All button to unselect selected files.

2. Select an operation from the Command to Run drop-down.

Managing data roots

A data root is a folder used to contain data files for GCC. The folder and files are 
displayed in the Folder View of Command Console. A default data root at 
C:\Command_Console\Data is created during installation, but you can create 
additional data roots to help you organize data from different researchers or for other 
purposes.

For more information about data roots, see ʺFoldersʺ on page 30.

You can:

• Create a data root (see ʺAdding a data rootʺ, below)
• Remove a data root (see ʺRemoving a data rootʺ on page 79)

Figure 70   Select Files controls

IMPORTANT!  Each workstation has its own data roots. Setting the data root on one station does 
not add the data root on other machines.

IMPORTANT!  Please make sure that the data roots used in GCC software on the instrument 
control workstations do not contain files that have non-Thermo Fisher Scientific file extensions 
(example: DLL, TMP, CPP, ASPX, OUT, etc). 
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Adding a data root To add a data root:

1. From the Data menu, select Data Roots Add.
The Add Data Roots page opens (Figure 71).

The Data Root page displays a list of the data roots currently assigned in GCC and 
the folders that can be selected as data roots. Expand the tree to view and select 
child folders.

2. Select a folder for the new data root from the Data Root list; or
In the Add a New Data Root box, enter the full path name and the name of the 
new data root.
Data roots on networked computers are specified using Universal Naming 
Convention (UNC) paths as \\server\share\filepath.

The folder cannot be:
• In the Windows directory
• In the Program Files directory
• In a root directory

Figure 71   Data Root page

IMPORTANT!  To select a data root on a networked computer, you must configure the GCC 
Services to permit access. See "Configuring GCC services" on page 346 for more information.

IMPORTANT!  Please make sure that the data roots used in GCC software on the instrument 
control workstations do not contain files that have non-Applied Biosystems file extensions 
(example: DLL, TMP, CPP, ASPX, OUT, etc). 
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3. Click Add.
The list displays the new data root (Figure 72).

The new data root is also visible in the Folder View (see ̋ Folder viewʺ on page 49).

Removing a data 
root

To remove a data root:

1. From the Data menu, select Data Roots Remove.
The Remove Data Root page opens (Figure 73).

The Remove Data Root page displays a list of the data roots available to GCC.
Note: You cannot delete the default data root. You must assign default status to 
another data root before deleting the current default data root. For more 
information, see ʺSpecifying a default folderʺ on page 92.

2. Select the radio button next to the data root.

Figure 72   New data root added

Figure 73   Remove Data Root page
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3. Click Remove.

Using projects to organize data

A project is a label assigned to a Data Root or sub-folder that can be used to organize 
Sample and data files. If you assign a project name to a Data Root or sub-folder, all the 
Sample and data files in that folder are assigned that project name. Any child sub-
folders of that project folder are assigned the project name, as well. A project name can 
be assigned to multiple Data Roots or sub-folders, in order to group data on multiple 
folders together.

Project folders enable you to organize your data. After organizing data into projects 
you can:

• Display data grouped by project
• Search on data limited to a project
• Create a spreadsheet listing the Sample (ARR) files assigned to the project. The list 

can be reviewed as a summary of the project information or used to edit the 
Sample (ARR) file content using Batch Edit.

The Projects functions provide tools for:

• ʺManaging Projectsʺ
• ʺCopying filesʺ

Managing Projects To open the Manage Projects page:
• From the Administration menu, select Project Manage.

The Manage Projects page opens (Figure 74).

IMPORTANT!  Deleting a data root in GCC does not delete the actual root directory or data files 
in Windows.

Figure 74   Manage Projects page
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The page has a folders list on the left side, similar to the one in the Folder View page.

The work area on the right has controls that allow you to:

• Create a new sub-folder.
• Assign a project name to a folder.
• Designate a primary folder for a project.
• Add or delete folders for a project.

Creating a project
The Create New Project controls of the Manage Projects page enables you to:

• Assign a previously created Data Root or sub-folder to a project
• Create a sub-folder and assign it to a project.

To create a sub-folder and project:

1. From the Administration menu, select Project Manage.
The Project Management page opens. (Figure 76)

Figure 75   Create New Project controls
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2. In the Folders tree, select the Data Root or sub-folder where you want to create 
the new sub-folder and Project. (Figure 77)

3. Enter a sub-folder name in the Create Subfolder window (Figure 78), then click 
Create.

Figure 76   Manage Projects page

Figure 77   Folder selected as location for new sub-folder
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Note: The name of the location folder is entered automatically in the New Project text 
box. Ignore this if you do not want to use the same name for folder and project.

The new sub-folder appears in the Folders list (Figure 79).

4. Select the folder that you created in the previous steps in the Folder list.
The folder name appears in the New Project box and the path to the folder 
appears. (Figure 80)

5. Enter a new project name, if desired, and click Create.
The selected sub-folder has a project label assigned to it. (Figure 81)

Figure 78   Entering name of new sub-folder

Figure 79   New sub-folder created

Figure 80   Project name entered
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You can also assign a project label to a previously created sub-folder by:

1. Selecting the sub-folder in the Folders list
2. Entering a Project name in the New Project box and clicking the Create New 

Project button.

Managing existing projects
The Manage Existing Projects controls of the Manage Projects page (Figure 82) enables 
you to:

• Add an existing sub-folder to a previously created project.
• Specify a Primary sub-folder for a project with multiple sub-folders. A Primary 

sub-folder functions as the default folder for the project. The Primary sub-folder 
cannot be deleted.

• Delete sub-folders that are not Primary sub-folders.
• Delete a selected Project.

Note: This deletes only the Project label. The sub-folders and files are not deleted.

Figure 81   New sub-folder with project label assigned
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To add an existing sub-folder to a previously created project:

1. Select the project from the Select Project drop-down list (Figure 82).
2. Select the sub-folder to be added in the Folders list. 

Note: You can assign a sub-folder to more than one project.

The Add button appears with the path of the selected folder (Figure 83).

3. Click Add.
The selected sub-folder is added to the Projects Folder list (Figure 84).

Figure 82   Manage Existing Projects controls

Figure 83   Add button with path
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Projects with multiple folders will have one folder specified as the primary folder. 
When files are assigned to the project during registration, they are placed in the 
Primary folder for the project. The Primary folder cannot be removed from the project; 
you must designate another folder as the Primary or delete the entire project.

To designate a primary sub-folder for a project:

1. Select the project from the Select Project drop-down.
The folders associated with the project are displayed in the Project Folder list 
(Figure 84).

2. For the folder you want to designate as primary, click the Primary check box.
The folder is designated as the primary folder.

To remove sub-folders from a project:

1. Select the project from the Select Project drop-down.
The folders associated with the project are displayed in the Project Folder list 
(Figure 84).

2. Click the red X for the folder you want to remove. 

The sub-folder is removed from the project. 
Note: You cannot remove primary folders from the project using this method. 
Designate another folder as primary or delete the entire project, as described 
above.

To delete a Project:

1. Select the project from the Select Project drop-down.
The folders associated with the project are displayed in the Project Folder list 
(Figure 84).

2. Click the Delete Project Name button. 
The project is deleted.
Note: This deletes only the Project label. The sub-folders and files are not deleted.

Figure 84   Folder added to Projects Folder list
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Generating reports and summaries

You can generate:

• Reports for selected Sample Files.
• A summary report file for the Sample files in a Project.

Generating reports 
for selected sample 
files

You can generate a report file in a tab-delimited text format on selected Sample (ARR) 
files, which you can then view in a text editor or spreadsheet program. 

You can also create a Batch Edit file for the selected sample (ARR) file. See ʺCreating 
the batch edit fileʺ on page 149 for more information.

To generate a report for selected Sample files:

1. Select the Sample files from the:
• Folder view page
• Project view page
• Search Results page

2. From the Command to Select drop-down (Figure 85), select Create Report from 
Selected Arr files link.

The report is created and the Summary page opens (Figure 86).

The page displays the location and file name of the report.
The report file can be viewed in a text editor or spreadsheet program.

Figure 85   Create Report command

Figure 86   Summary page
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Generating a 
project summary

You can create a report for the Sample (ARR) files in a project.

The report can be used to review data.

To generate a Project Summary:

1. From the Administration menu, select Projects → Summary.
The Generate Summary page opens.

2. Select the project you want a report on from the drop-down list.
3. Click the Create button.

The Summary page displays the name and location of the generated report.
The report file can be viewed in a text editor or spreadsheet program.

Copying files

The Copy Files function enables you to select files and place a copy of those files to a 
new location.You can select:

• The Sample (ARR) files in a project.
• Selected Sample (ARR) files in: 

– Folder view page
– Project view page
– Search Results page

This can be useful for giving other users access to data. 

Projects are described in ʺUsing projects to organize dataʺ on page 80 of this manual.

Note: You can copy to any folder you have access to, as you are not limited to copying 
files only to a Data Root or sub-folder.

To copy files associated with a project:

1. From the Data menu, select Copy Project.
The Copy files page opens. (Figure 87)
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2. Select a destination folder from the Folders List, or
Enter the path to the destination folder in the Destinations box.

3. Select a project for copying from the Projects drop-down.
4. Select the file types you want to copy:

• Sample (ARR)
• Audit
• Image (DAT)
• Intensity Data (CEL)
• Probe level summarization (CHP)
• The file types are described in ʺFile typesʺ on page 56.

5. Click Copy.
The progress of the transfer is displayed in the Status window.

Figure 87   Copy Files page
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To copy selected files:

1. Select the Sample files from the:
• Folder view page
• Project view page
• Search Results page

2. From the Command to Select drop-down, select Create Report from Arr files in 
List link.
The Copy files page opens (Figure 89).

Figure 88   Status window
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3. Select a destination folder from the Folders List, or
Enter the path to the destination folder in the Destinations box.

4. Review the Files to be copied list.
5. Click Copy.

The progress of the transfer is displayed in the Status window (Figure 90).

Figure 89   Copy Files page

Figure 90   Status window
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Specifying a default folder

The Default folder is used as a destination folder for data when:

• Performing Drop and Scan.
• Scanning data for an array for a Sample (ARR) file located on another computer, 

connected through a network.
See Appendix A, ʺNetworkingʺ on page 340 for more information on the Network 
functionality of GCC.

When GCC is installed, C:\Command_Console\Data\Default is used for the 
default folder.

You can change the Default folder if you want.

To change the Default folder:

1. From the Data menu, select Default Folder. 
The Set Default Folder page appears. (Figure 91)

A Folder list is displayed on the left side of the page. The right side displays the 
current default folder and the selection controls.

2. Select a folder from the Folder list. You can select a data root or a sub-folder.
3. Click Set.

The selected folder is used for the Default folder.

Uploading data to network data storage

You can create Sample (ARR) files on any data root your GCC system has access to, 
including network data storage. However, you cannot create DAT files over a network 
connection to network data storage; instead, the DAT files are created in the Default 
folder on the local computer. This is done to protect the DAT file from any problems 
related to the networks, so that an array can always be scanned successfully even when 
a network is unreliable.

The Upload Data function can be used to automatically transfer DAT, CEL, and other 
files from the Default folder to the network data storage where the Sample (ARR) file 

Figure 91   Set Default Folder
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is located. Upload Data is useful when you want to consolidate data from different 
workstation computers onto one network data storage site.

The use of the Data Upload function is explained in:

• ʺUploading data manuallyʺ on page 95
• ʺScheduling auto-uploadsʺ on page 97

The Overview section below provides information on why you may want to use the 
Upload Data function.

Overview You can create Sample (ARR) files on any data root your GCC system has access to, 
including network data storage.

However, you cannot create DAT files over a network connection to network data 
storage; instead, the DAT files are created in the Default folder on the Scanner 
Workstation computer (Figure 92). This is done to protect the DAT file from any 
problems related to the networks, so that an array can always be scanned successfully 
even when a network is unreliable.

The Upload Data function can be used to automatically transfer DAT and CEL files 
from the Default folder to the network data storage where the Sample (ARR) file is 
located (Figure 93). Upload Data is useful when you want to consolidate data from 
different workstation computers onto one network data storage site.

Figure 92   Creating DAT and CEL files on the Scanner Workstation Default Folder

Scanning the Array on the Scanner Workstation

Windows
Network

Scan the array using the Scanner Workstation. Since AGCC cannot create a DAT file over a Windows network, the DAT and CEL file will be 
created on the Scanner Workstation Data Root.

AGCC Scanner Workstation Network Data Storage

Image (DAT) File(s)

Tissue Type B Array 1.DAT

Intensity (CEL) File(

Tissue Type B Array 1.CEL

Scanner Workstation

Data Root

Default Folder

The DAT file  on the Scanner Workstation Data 
Root is linked with the Sample (ARR) file on the 
Network Data Root.

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Audit File

Tissue Type B Array 1.Audit

Researcher Folder
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Figure 93   transferring the DAT and CEL files using the GCC Upload Data function

Transferring the DAT and CEL Data with GCC Data Upload

Windows
Network

GCC Scanner Workstation Network Data Storage

Finally we move the DAT and CEL file to the same folder as the ARR file on the Network Data Root using the GCC Upload Data function

Scanner Workstation

Data Root

Default Folder

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Image (DAT) File

Tissue Type B Array 1.DAT

Intensity (CEL) File

Tissue Type B Array 1.CEL

Researcher Folder

Audit File

Tissue Type B Array 1.Audit
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Uploading data 
manually

To upload data:

1. From the Data menu, select Upload Data.
The Upload Data page is displayed. (Figure 94)

A new window opens with info on the files to be uploaded. (Figure 95)

The page displays a list of data files in the Default folder that are associated with 
a Sample (ARR) file on a network drive:

Figure 94   Upload Data page

Figure 95   Data for uploading displayed

From Current location and file name.

To The file destination (location of the Sample (ARR) file).

Status The current status of the move.
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2. Click Start Uploading to upload the files to the locations.
A notice informs you that the move is in progress. (Figure 96)

The status of the move is displayed in the lower part of the page, with a list of the 
files that have been transferred and their status.
When the upload is finished, the status is displayed in the page. (Figure 96)

The uploaded files can be seen in their new location. (Figure 97)

Figure 96   Move in progress

Figure 97   Data in new location
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Scheduling auto-
uploads

The Data Uploader Scheduler enables you to run the Data Upload automatically on a 
schedule you determine.

To schedule auto-uploads:

1. Click the Data Uploader icon  in the Launcher. 
The GCC Data Uploader Scheduler window opens. (Figure 98)

The dialog box has three tabs:
• Task
• Schedule
• Settings
The Task tab enables you to set the options for the task itself.

2. In the Run box, enter the path to the file to be run as a scheduled task.
Use quotation marks around the task path if the path includes spaces.

3. Enter information in the Start In box on the location of the folder with the task or 
other necessary files.

4. Use the Comments box for notes about the task.
5. In the Run As box, enter the user account for running the scheduled task.

Specify user account (must be the same account used for the GCC Services, with 
permissions on both the computer and the remote storage location).

6. Enter the password for the user account:
a. Click Set Password.

The Set Password dialog box opens (Figure 99).

Figure 98   GCC Data Uploader Scheduler, 
Task tab.
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b. Enter and confirm the password for the user account and click OK in the Set 
Password dialog box.

7. Select other options:
• Run only if logged on.
• Enabled (scheduled task runs at specified time).

8. Click the Schedule tab to set up the schedule for the upload.
The default setting is to run the upload function daily at 2 AM.

The Schedule tab (Figure 100) provides options for setting the schedule.
9. Select a period for performing the task from the Schedule Task drop-down.

You can schedule the task to run:
• Daily
• Weekly
• Monthly
• Once
• At System Startup
• At Logon
• When idle

Figure 99   Set Password dialog box

Figure 100   Schedule tab with settings for 
daily task
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The options for task schedule change with the time period (Figure 101).

Click Advanced Options (Figure 102) to set Start/Stop dates and to specify how often 
to repeat the task. 

10. Enter a time for the task to start in the Start time box.

11. You can enter multiple schedules:
a. Select the Show Multiple Schedules check box.

A schedule drop-down list appears at the top of the tab screen with New and 
Delete buttons.

Figure 101   Settings for Weekly task

Figure 102   Advanced Schedule 
Options dialog box
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b. Click New to create a new schedule.
c. Set the schedule using the Schedule Task controls, as described in steps 9 and .
d. Click Delete to delete a scheduled task.

12. Click the Settings tab.

The Settings tab (Figure 104) enables you to set options for the upload:
• Scheduled Task Completed: Use these to set the options for a task that is only 

running once.
• Idle Time: Use these to start the task only if the computer has been idle for a 

specified period of time

Figure 103   Multiple schedules

Figure 104   Settings tab
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• Power Management: Use these to set the options for power management if 
using a laptop.

13. Click OK when you have finished setting the task, schedule, and settings options.
The task is scheduled and will run at the set times.

When the scheduled time comes, the Upload Utility window (Figure 105) appears on 
your desktop and shows the progress of the upload.

You can set up the GCC Email Configuration Editor to notify you when the Upload 
Utility runs or if problems arise. See Appendix E, ̋ Notification e-mailsʺ on page 370 for 
more information.

Figure 105   Upload utility running
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5  Creating and editing
sample (ARR) files
Sample Registration is the first step in the recommended array processing workflow, 
as shown in Figure 106.

For information on scanning arrays without registering them first, see ̋ Drop and scanʺ 
on page 211.

This chapter describes the following options for creating Sample files and registering 
arrays:

• ʺDetailed sample registrationʺ on page 105
• ʺQuick sample registrationʺ on page 124
• ʺBatch registrationʺ on page 129
• ʺSample prep plate registrationʺ on page 135

Figure 106   Array processing workflow

GCC  Array Processing 

Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Wash and Stain operations on 
array(s) in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Hybridize Array(s) and Sample (not 
performed by GCC for Cartridge Arrays)
GeneChip™ Command Console™ (GCC) User Guide 102



Chapter 5 Creating and editing sample (ARR) files
Introduction to sample registration 5
• ʺGeneTitan array plate registrationʺ on page 139
You can also edit previously created Sample (ARR) files

• ʺEditing files and copying attributesʺ on page 111
• ʺAdding a barcode to a sample fileʺ on page 146
• ʺBatch editingʺ on page 148

For information on selecting a Sample Registration method, see ʺRegistering samples 
and arraysʺ on page 23.

See ʺIntroduction to sample registrationʺ for an introduction to the types of 
information that can be collected in a Sample file.

Introduction to sample registration

To get the most out of GCC, you need to understand the types of information that are 
collected in the Sample file, as described below:

• ʺInformation in the sample fileʺ, below
• ʺCharacters allowed in GCCʺ on page 105

Information in the 
sample file

In GCC, the samples are the beginning of the data chain for a given experiment. The 
sample information is stored in a Sample file with an ARR extension. 

The Sample (ARR) file collects two types of information:

• Sample Attributes: information that you can use to interpret the experimental 
data. It can include information about the sample itself, the experimental 
conditions, or other information you may find useful.

• Array Information: Information about the array(s) used with the sample. More 
than one array can be associated with the sample. This might be useful for making 
sure that data from products that contain more than one array remain related or 
to help describe experiments that use replicates.

Sample attributes
There are two types of attributes in GCC:
– Template Attributes, which have the attribute name, data type and other 

information specified in a template.
For more information on creating and managing templates, see ̋ Working with 
templatesʺ on page 330.

– User Attributes, which are created individually during registration.
Each attribute in a template is assigned one of the following data types:

• Text: Text string
• Number: Integer or floating point number
• Date: Calendar data
• SingleSelect: Presents a list of items for the user to choose

User Attributes may be Text, Number, or Date data types.
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Beta Versions of GCC included other deprecated data types which are no longer 
available, such as:

• Integer
• Floating Point
• MultiSelect

The data type determines the type of value that can be entered, and the types of 
comparisons that can be performed during an Advanced Search.

Array information
The Sample file also contains information about the array(s) used with the sample. 
More than one array can be associated with the sample. This is useful for tracking 
replicates; in addition, it can be used to simplify tracking data for multi-chip arrays, 
such as 500K arrays.

Each array is assigned an array name during registration. The array name is used to 
identify the DAT, CEL, and CHP data files that are generated during analysis. 
(Figure 107)

The array information includes:

• Array Name
• Probe Array Type
• Barcode 

Figure 107   Sample File with associated arrays and data files

Sample File (Sample.ARR)
With Sample Attributes

Array name: FirstArray
(used for DAT, CEL, and CHP files)

Array name: SecondArray 
(used for DAT, CEL, and CHP files)

DAT File (FirstArray.DAT)

CEL File (FirstArray.CEL)

CHP File (FirstArray.CHP)

DAT File (SecondArray.DAT)

CEL File (SecondArray.CEL)

CHP File (SecondArray.CHP)
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Characters allowed 
in GCC

You can only use a certain set of characters in GCC Sample File names, Folder Names, 
Project Names, and Array Names:

These names can contain:

• Basic Latin letters (A-Z, a-z)
• Digits (0-9)
• Spaces
• The following set of punctuation marks: ! # $ % & ʹ ( ) + , - . ; = @ [ ] ^ _ ` { } ~ 

These names cannot use the following characters: \ / : * ? ʺ < >|

International characters are not allowed.

Sample attribute names can contain: 

• Numbers
• Letters
• International characters
• The following set of punctuation marks: ! # $ % & ʹ ( ) + , - . ; = @ [ ] ^ _ \ / ` ~ 

Sample Attribute names cannot contain any of the following characters: { } : * ? ʺ < > |

Sample attribute values of Text type can contain any characters.

Detailed sample registration

The Detailed Sample Registration page enables you to register a single sample and its 
associated cartridge arrays, along with any sample attribute you want to include. You 
can use templates to determine which attributes need to be entered for registration, 
and you can add user attributes that are unique to that sample. 

You cannot register a GeneTitan System array plate using the Detailed Sample 
Registration (use ʺGeneTitan array plate registrationʺ, described on on page 139).You 
can add a cartridge array to a previously created array plate Sample file with the 
editing functions of the Detailed Sample Registration. 

For more information see ʺCreating a new sample fileʺ.

The page can also be used for:

• Editing previously created Sample files
• Renaming a Sample file and/or the Array name
• Copying the attribute data over to a new file
• Adding physical arrays to an existing Sample (Arr) file

For more information, see ʺEditing files and copying attributesʺ on page 111.

If you have edited or deleted templates and attributes, you may need to change the 
attributes in a Sample file when you try to edit it. For more information, see ʺSample 
attributes conversionʺ on page 118.
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Creating a new 
sample file

To create a new Sample File:

1. From the Samples menu, select Register.
The Detailed Sample Registration page opens (Figure 108).

The Detailed Sample Registration page has four sections:
• Project and File Name (at the top of the page)
• Sample Attributes from Templates
• Additional Sample Attributes
• Arrays list

2. Select a Project from the drop-down list (optional) (Figure 109).
3. Enter a name in the Sample File Name box (Figure 109).

The Sample Attributes from Templates section displays a list of the attributes in 
the Default template when the page is first opened. See ʺManaging default 
templatesʺ on page 337 for more information.

Figure 108   Detailed Sample Registration page

Project and File
Name

Sample Attributes
from Templates

Additional Sample
Attributes

Arrays

Figure 109   Entering Project and File Name
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You can:
• Enter attribute values for the Default template (see Step 6 on page 108).
• Add and remove templates with additional attributes (optional—see Step 4, 

below).

4. To add Templates, use one of the following options:
• Select the template from the drop-down list and click Select (Figure 111); or

• Click Options to open the Template Select page.  (Figure 112) Note: You can 
also use the Template Select page to delete templates from the Sample (ARR) 
file.

The Template Select page displays a list of the available templates on the left side.

Figure 110   Sample Attributes from Templates

Figure 111   Template List

Figure 112   Template Select page
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The right side displays a list of the attributes in the selected templates.
– Select the template(s) you want to use.
– Review the attributes in those templates in the Sample Attribute list.
– Click Select to add selected templates to the Sample (ARR) File.
The Detailed Sample Registration page returns with the attributes in the selected 
template(s) displayed (Figure 113).
Click Cancel to return to the Detailed Sample Registration page without adding 
templates.

5. To delete a selected template and all its attributes, click the red X at the top of the 
template’s attribute list (Figure 113).

6. To enter values for the Template Attributes:
a. Enter values for the text, numerical, and date attributes.
b. Select values from the drop down lists for the SingleSelect attributes 

(Figure 114).

7. Add user-defined attributes to the Sample by using the Additional Sample 
Attributes list:
a. Click Add under the Additional Sample Attributes list.

An empty line appears in the list. (Figure 115)

Figure 113   Added Templates

Click to delete 
selected template and 
all attributes

Figure 114   Entering values for the sample attributes
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b. Enter the attribute name and value.
c. Select an attribute type for the user attribute:

• Text: text string
• Number: Floating point or Integer
• Date: Calendar data

The attribute type determines the sorts of comparisons you can perform 
during an advanced search. For more information, see ̋ Sample attributesʺ 
on page 103 andʺAdvanced searchʺ on page 68.

d. Repeat to add more attributes.
The Arrays list (Figure 116) enables you to assign an array or set of arrays to the Sample 
(ARR) files.

You can include the following information on the array(s):

• Barcode (optional)
• Array Type
• Array Name

To assign an array to the Sample (ARR) file:

8. Enter the barcode (optional):
Enter the barcode using the keyboard; or
a. Click in the Barcode field. 
b. Use the barcode reader to scan in the barcode on the array. (Figure 117)

Figure 115   Additional Sample Attributes list after adding new field

Figure 116   Arrays list
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The reader reads and sends the barcode to the Barcode field.
Note: You can use custom barcodes to register an array in Detailed Sample 
Registration.

The array’s lot number and expiration date are displayed below the barcode 
(Applied Biosystems barcodes only).
Probe Array Position is an attribute for the GeneTitan System array plates and 
is not applicable to cartridge arrays.

9. Select the array type.
Note: If you are using Applied Biosystems barcodes, the array type is selected 
automatically after the barcode is entered. If you are using custom barcodes, 
you must select the array type manually.

The Derive array names from sample names check box is selected by default and 
an array name is created by linking:
• The Sample file name entered in the first set of steps
• The array type
• Incremental numbers added if necessary to distinguish arrays

Figure 117   Reading the array barcode

Figure 118   Arrays list with array entered
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10. If you want to enter a different array name:
a. Deselect Derive array names from sample names check box.
b. Enter the name in the Array Name column.

To register additional arrays:

11. Click Add Array.
An empty line appears in the list. (Figure 119)

The line enables you to enter data on an array.
12. After you have entered arrays, click Save.

A Sample file has been successfully saved message appears. (Figure 120)
13. Click OK.

Editing files and 
copying attributes

You can use the Detailed Sample Registration to:

• Edit data in the Sample (ARR) file
• Rename the Sample (ARR) file 
• Change the Array name in the Sample file
• Copy attributes over to a new file

To open the Detailed Sample Registration page for a Sample file:
• Click the Sample file link in the Folder View or Search Results pages.
• While displaying information about a Sample file in the Project view, click the 

Open button.
If there are template and attribute discrepancies, the Sample Attributes 
Conversion page will open. 
See ʺSample attributes conversionʺ on page 118 for more information about what 
you should do.

There are additional controls in the page when you have opened a previously created 
Sample file. (Figure 121)

Figure 119   Array list with second array added

Figure 120   Sample 
File Saved notice
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The Rename button enables you to change the name of the Sample file or array.

The Save As button copies the sample attribute and array type information over to a 
new Detailed Registration page which can be used to create a new file.

If you have made changes in a template used for the array file since creating the array 
file, you will see a notice and the Update button at the top of the Detailed Sample 
Registration page.

Click the Update button to review the differences between the attributes and to correct 
the problem. 

See ʺSample attributes conversionʺ on page 118 for more information.

Figure 121   Detailed Sample Registration page with controls for editing

Figure 122   Warning message and Update button
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Editing the data in a sample file

To edit the sample attributes in a Sample file:

1. Open the Sample file in the Detailed Sample Registration page.
2. Edit the attributes as desired.

Note: You cannot edit the barcode or array type information after an array has 
been scanned.

3. Click the Save button.
A notice that the Sample file has been successfully saved appears in a dialog box. 
(Figure 123)

Renaming the sample file

To rename a Sample (ARR) file:

1. Open the file in the Detailed Sample Registration page.
2. Click the Rename button next to the Sample File Name at the top of the page.
3. The Sample name can now be edited, and the Save button at the bottom of the 

page is replaced by the Rename button. (Figure 124)

Figure 123   Sample 
File Saved notice

IMPORTANT!  If the Derive Array Name from Sample File check box is selected, changing the 
Sample file name will require changing the names of all the data files associated with the Sample 
file.
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4. Enter a new name for the Sample file.
5. Make other changes as necessary.
6. Click Rename.

The Rename Sample File page opens with list of the DAT and CEL files that will 
be renamed. (Figure 125)

Figure 124   Using the Rename function
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7. Click Yes to rename the sample file.
The page displays a list of the files with the new names. (Figure 126)

Changing the array name(s) for a sample file
Changing the array name for a sample file results in renaming all the data files 
associated with the array.

This can be done while editing or renaming a file.

To rename the array name(s) for a Sample file:

1. Open the Sample file in the Detailed Sample Registration page.
2. Deselect the Derive array names from sample file name check box.
3. Click in the Array name column of the array you want to rename.

The Rename Notice appears. (Figure 127)

Figure 125   Rename Sample page

Figure 126   Rename Sample File page with notice of changed data files
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4. Click OK and edit the Array Name(s).
5. Click Rename or Save in the Detailed Sample Registration page.

The Rename Arrays page opens with a list of the files that will be renamed.

6. Click Yes to rename the arrays and the data files.
The page displays a list of the files with the new names. (Figure 129)

Figure 127   Rename notice

Figure 128   Rename Arrays page

Figure 129   Rename Arrays page with notice of changed data files
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Copying file data over to new file

To copy file data over to a new Sample (ARR) file:

1. Open file in Detailed Sample Registration page.
2. Click the Save As button by the Sample File Name box.

The Sample File Name becomes editable and the Barcode information for the 
arrays is erased.
Note: The Save As button is not available for GeneTitan System sample files.

3. Enter a name for the new Sample file.
4. Edit the Sample Attribute information if desired.
5. Enter new Array Type and Barcode information.
6. Click the Save button.

The Sample File Saved notice appears. (Figure 130)

Figure 130   Sample 
File Saved notice
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Sample attributes 
conversion

You may see the Sample Attributes Conversion page (Figure 131) when you try to 
open a Sample file for editing.

The Sample Attributes Conversion page appears when there is a discrepancy between 
the properties of an attribute in the Sample file and the properties of the attribute as 
defined in the current template.

Attribute conversion may be necessary if any of the following changes have been made 
in a template:

• The attribute has been deleted from the template.
• The entire template has been deleted from GCC.
• The data type for the attribute in the template is different from the data type in the 

Sample file.
The page displays the attributes with discrepancies and the conversion that will be 
applied to correct the discrepancy. Depending upon the type of discrepancy, the 
attribute will either: 

• Be converted to a user attribute, with Text type.
• Have its attribute type changed to match the template.

To apply the conversions:

1. Review the conversions in the Original Attribute and Converted Attribute lists. 
(Figure 132)
The details are described in:
• ʺDeletion of attribute or templateʺ on page 119
• ʺChange in attribute typeʺ on page 121

Figure 131   Sample Attributes Conversion page
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2. Click Yes in the Sample Attributes Conversion page.
The Detailed Sample Registration page opens with the Sample file displayed. 
The converted attributes will be displayed in the Detailed Sample Registration 
page, but the conversions will not be applied to the Sample file until you:

3. Click Save in the Detailed Sample Registration file.
The changes will be applied to the Sample file. 

The attribute conversion may affect how you search for Sample files using that 
particular attribute in the Advanced search page. The sections below describe this in 
more detail.

For more information about templates and data types, see:

• ʺSample attributesʺ on page 103
• ʺWorking with templatesʺ on page 330

Deletion of attribute or template
If the attribute has been removed from the template, or if the entire template has been 
deleted, the attribute in the Sample file will be converted to a user-defined Sample 
attribute. (Figure 133)

This is indicated by the blank cell in the Template column for the converted attribute. 
The new user attribute name will use the original attribute name with the original 
template name in square brackets to indicate the source, as in the example 
Disease Status [Sept_Template].

Figure 132   Conversion details

Attribute type changed in template

Attribute deleted from template

Attribute added to template

Figure 133   Attribute deleted from template (converted to user 
attribute)
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In case of a name conflict, the new user attribute will have an underscore-number (_1) 
added to the attribute name:

Disease Status_1 [Sept_Template]
The user attribute will be listed in the No_Template attribute list in the Select Template 
drop-down list of the Advanced Search page. (Figure 134)

If other Sample files still have the original template attribute, the template will be listed 
in the Select Templates list. (Figure 135)

When doing an advanced search, if you want to find Sample files having the previous 
attribute type and the current attribute type, you will need to select both attributes in 
the Select attributes section. (Figure 136)

Figure 134   Advanced Search: selecting a user 
attribute from the No Template list

Figure 135   Advanced Search, Unconverted 
attributes in template attribute list

Figure 136   Advanced Search, specifying converted and unconverted attributes
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For more information about performing searches, see ʺAdvanced searchʺ on page 68.

Change in attribute type
Each attribute in a template is assigned to one of the following data types:

• Text: Text string
• Number: Integer or floating point number
• Date: Calendar data
• SingleSelect: Presents a list of items for the user to choose

Beta Versions of GCC included other data types which are no longer available, such as:

• Integer
• Floating Point
• MultiSelect

The data type determines the type of value that can be entered, and the types of 
comparisons that can be performed during an Advanced Search.

In this case, the results of the Attribute conversion depends upon the original attribute 
data type and the new attribute data type in the template. 

• If the data types are compatible, the sample attribute will be converted to the new 
data type.
The Sample Attributes Conversion page shows the old and new attribute data 
types. (Figure 137)

If the data types are not compatible, the existing sample attribute will be added as a 
user attribute with the text data type.

This gives you the option of manually transferring the attribute value to the new 
template attribute and deleting the added user attribute.

The attributes are converted according to the rules in the table below.

Figure 137   Conversion details

Attribute type changed in template

Attribute deleted from template
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If the sample attribute has the data type changed, you will be able to find the attribute 
listed for the template in the Advanced Search screen. (Figure 138)

Table 1   Conversion rules

Old Sample File Data 
Type

New Template Attribute data 
type

Results

Text Number The attribute is converted to user attribute.

Date The attribute is converted to user attribute

SingleSelect Attribute type converted if it matches to one of the 
items in the Selection list; otherwise the attribute 
is converted to user attribute.

Number Text Attribute type converted.

Date Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

Integer and Float (no 
longer supported)

Number Attribute type converted.

Text Attribute type converted.

Date Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

Date Text Attribute type converted.

Number Attribute is converted to user attribute.

SingleSelect Attribute is converted to user attribute.

SingleSelect Text Attribute type converted.

Number Attribute is converted to user attribute

Date Attribute is converted to user attribute

MultiSelect (no longer 
supported)

Text Attribute type converted.

Number Attribute is converted to user attribute

Date Attribute is converted to user attribute

SingleSelect Attribute is converted to user attribute
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If the attribute type is changed, but it remains in the template, the type of comparisons 
you can perform when searching for the attribute may change.

If converted to a user attribute, you will need to select the attribute from the No 
Template list in the Specify Sample Attributes section of the Advanced search 
(Figure 139).

If other Sample files still have the original attribute type, the attribute will be listed 
with both the old and new attribute types. 

• The current attribute type in the template will have (current type) appended to the 
attribute name

• The previous attribute type will have (previous type) appended to the attribute 
name.

When doing an advanced search, if you want to find Sample files with the previous 
attribute type and with the current attribute type, you will need to select both 
attributes in the Select attributes section. (Figure 140)

Figure 138   Advanced search, selecting new 
attribute type

Figure 139   Advanced Search: selecting 
converted attributes from a template
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For more information about performing searches, see ʺAdvanced searchʺ on page 68.

Quick sample registration

The Quick Sample Registration enables you to create a set of Sample (ARR) files 
quickly with the following basic information for the Sample and Array: 

• Probe Array Type
• Sample File Name and Array Name
• Project
• Barcode (optional) 

Barcodes and sample attributes can be added later on using various editing options. 
For more information, see ʺAdding a barcode to a sample fileʺ on page 146 and ʺBatch 
editingʺ on page 148.

Both the Sample (ARR) file and the array name will have the same value when using 
Quick Sample Registration. As an example, Sample1ARR will have a physical array 
entry called Sample1. 

You can create up to 48 Sample (ARR) files (one AutoLoader carousel’s worth) at a 
time.

Note: This function works best for registering arrays that are not part of a set. If your 
array set contains an A and B array then use Register or Batch Register to create sample 
files (ARR). In addition, you cannot use Quick Sample Registration to register arrays 
for GeneTitan MC instrument.

To create a set of Sample files with basic information:

1. From the Samples menu, select Quick Register.
The Quick Sample Registration page opens. (Figure 141)

Figure 140   Advanced Search, specifying converted and unconverted attributes
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2. Select the number of Sample (ARR) files to create. (Figure 142)
You can add up to 48 arrays (an AutoLoader Carousel’s worth) during one quick 
registration operation.

• Select a number from the drop-down list.
Blank array information lines appear in the Array list. (Figure 143)

Figure 141   Quick Sample Registration page

Figure 142   Drop-down list
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3. Set default values for all projects and/or probe array types (optional):

a. Select a project for the Project drop-down list.
b. Select a probe array type from the Probe Array Type drop-down list.

The selected projects and probe arrays appear in the Array list. (Figure 145)
You can change the values for any sample file later on. Selecting these options will 
not erase your previously entered values for probe array type and project.

Figure 143   Add Details section with added rows

Figure 144   Set Defaults

Figure 145   Add Details section with default probe array and project 
selected
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4. (Optional) Enter the barcode using the keyboard; or
a. Click in the Barcode box. 
b. Hold a GeneChip probe array in front of the barcode reader and squeeze the 

trigger for approximately four seconds until you hear a beep. 
Note: You can use custom barcodes to register an array in Quick Sample 
Registration. Also, the array’s lot number and expiration date are displayed 
below the barcode (Thermo Fisher Scientific barcodes only).

5. Enter a name for the Sample (ARR) file and the Array name (used for the DAT, 
CEL, and CHP files).

6. Change the project or probe array type using the individual drop-down lists in 
the list.

7. To delete Sample (ARR) files you do not want:
a. Select the check box in the row.
b. Click Delete.

8. Click Next.
The Confirm page opens. (Figure 147)

The page displays the status of the sample files, indicating any errors that would 
prevent the registration.
These errors can include
• Same Sample (ARR) file name
• Missing file name

Figure 146   Sample names entered

Figure 147   Confirm page
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• Other conflicts with previously registered arrays
If errors appear for certain sample files, but other sample files are correct, you 
can click the Corrections link to return to the Quick Sample Registration page 
and correct the errors.

9. Click Next to register the valid sample (ARR) files.
The Finish page appears. (Figure 148)

Click the Edit link to open the Sample file in the Detailed Sample Registration 
page (see ʺDetailed sample registrationʺ on page 105)
You can use the links in the lower left corner of the screen to open the GCC 
Scan Control or GCC Fluidics Control software for further processing of the 
arrays.

Figure 148   Quick Sample Registration Finish page
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Batch registration

The batch registration features enable you to create multiple Sample (ARR) files with 
different information, entering data using a specially formatted batch registration file. 

Custom barcodes can be used in batch registration.

Batch registration involves three different sets of steps:

1. ʺDownloading an empty batch registration fileʺ
2. Entering values for the arrays into the batch registration file.

See ʺEntering values in the batch registration fileʺ on page 130.
3. Uploading the data in the batch registration file to create the Sample (ARR) files.

See ʺUploading the batch registration fileʺ on page 134.

Downloading an 
empty batch 
registration file

The batch registration file is downloaded as an Excel workbook.

To download a batch registration file:

1. From the Samples menu, select Batch Registration.
The Batch Sample Registration page opens. (Figure 149)

Figure 149   Batch Sample Registration page
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2. Select the templates you want to use by placing a check in the box next to their 
names. (Figure 150)

You can display the attributes in the template by clicking on the template name.
3. Specify the number of samples. The maximum number of samples for which the 

downloaded worksheet works well is 1000.
4. Specify project and array type for the Sample files.
5. Click Download to download the Excel workbook.

When using GCC Portal, the Excel program displays the created workbook, 
which you can edit and save on your computer.

Entering values in 
the batch 
registration file

The Batch Registration file can be used to enter data for several different Sample (ARR) 
files at once.

The downloaded batch registration file is an Excel workbook with three worksheets:

• Samples worksheet, where you enter the data
• General info worksheet (do not edit), where GCC Portal stores information about 

Array types, projects, and file format
• Template Info worksheet (do not edit), where GCC Portal stores information 

about the template attributes.
Note: You cannot create TSV files in GCC 4.3, but you can use TSV files. created 
in previous versions of GCC to perform batch registration. For more in formation, 
see Appendix G, ʺTSV filesʺ on page 375.

Figure 150   Select Templates (with attributes displayed for template)
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The columns in the Samples worksheet have column headers that define the 
information on the Sample files, the physical array, and the attributes:

Note: You must specify either the Path or Project for your files. Specifying both will 
produce an error message.

Path
The path needs to be associated with a data root. You can assign a set of sample files to 
a particular project if you select that projectʹs folder in the Path field. 

Project
Specifying a project for the Sample file will determine the folder the Sample file is 
created in.

You can select the project from a drop-down list. (Figure 152)

Figure 151   Batch Registration Workbook, Samples Worksheet

Sample File Path The path to where the Sample file will be created. Can be used to 
place Sample files in project folders. 

Project The project that the Sample (ARR) file will be assigned to.

Sample File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array Type Part number for the array(s).

Barcode Barcode on the array(s).

Attributes Additional information about the sample and experiment that you 
can use to interpret your results.

Figure 152   List of projects
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Sample file name
Enter the name assigned to the Sample file that will be created.

Array name, array type, and barcode
If you are using Excel, you can select the probe array type from a drop-down list. 
(Figure 153)

You can also enter multiple array information for a single sample file.

To enter multiple arrays:

1. Enter the sample file information (File path, project, and file name) on a separate 
line of the worksheet for each array you want to use.

2. Enter a different array name for each array for the sample.
3. Select the array type from the Probe Array Type list.
4. Enter the array barcodes in the appropriate lines.
5. Make sure that the attributes are the same for all sample entries.

Attributes
Enter the values for the attributes in the appropriate columns. 

You can select the value for a SingleSelect attribute from a drop-down list. (Figure 155)

Figure 153   List of probe 
arrays

Figure 154   Worksheet with multiple arrays entered for samples
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GCC uses two types of attributes for Batch Registration:

• Template Attributes: Attributes that have been defined in a template. When you 
select templates for the downloaded batch registration file, the array attributes in 
those templates will be included as headings in the batch registration file.

• User Attributes: Attributes that you add in the Batch Register file.You create a 
user attribute by entering the attribute name and other characteristics in the 
column header, and then entering attribute values in the appropriate cells.

Attributes need to have the following characteristics defined:

• AttributeName
• TemplateName (if any; not used for User Attributes)
• DataType
• Required status, if any

The column headings are in the format:

• Header format for Template Attribute: 
AttributeName:TemplateName:AttributeType:RequiredStatus

• Header format for User Attribute: AttributeName:*:AttributeType

Figure 155   Selecting 
the value for a 
SingleSelect 
attribute

Figure 156   Template and user attributes in the Batch 
Edit file

Template Attributes User Attribute
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Uploading the batch 
registration file

To upload the Batch Registration File:

1. Enter the file path and name in the text box (Figure 157) or click Browse.

– Clicking Browse opens a Choose File window.
– Select the Batch Registration file and click Open.

The file and its path is displayed in the box.

2. Click the Allow Custom Barcodes check box to use barcodes that are not 
provided by Applied Biosystems.

3. Click Upload.
If there are problems with the workbook, an error notification page appears. 
(Figure 158)

The error messages indicate problems such as bad barcodes, problems with 
registering multiple arrays on a sample, etc.
• Click Cancel to cancel the registration and fix the problems; or

Click Save to register the valid records.

Figure 157   Upload file

Figure 158   Error notification
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If the upload doesn’t have a problem the Folders View page appears with the 
newly created folders.

Sample prep plate registration

Sample Prep Plate Registration provides a convenient way to register samples and 
cartridge arrays for up to two 96-well plates by using an Excel workbook.

To perform Sample Prep Plate Registration for a target prep plate:

1. ʺDownloading the sample prep plate registration fileʺ, below
2. ʺEntering data in the workbookʺ on page 136
3. ʺUploading the data for the filesʺ on page 136

Downloading the 
sample prep plate 
registration file

To download the Sample Prep Plate Registration file:

1. From the Samples menu, select Sample Prep Plate Registration.
The Sample Prep Plate Registration page appears (Figure 159).

2. Click Download to create a blank Sample Prep Plate Registration file.
The Excel program displays the created workbook, which you can edit and save 
on your computer.

Figure 159   Sample Prep Plate Registration page
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Entering data in the 
workbook

To enter data for the Sample Prep Plate Registration file:
• Enter a sample (ARR) file name and GeneChip barcode for each well position you 

are analyzing using Excel or text-editing software. 
The blank Sample Prep Plate Registration file (Figure 160) is an Excel workbook 
with two tabs, to enable use with arrays that require two prep plates. 
The worksheet rows are marked A through H, corresponding to the plate rows. 
The worksheet columns are marked 1 through 12, corresponding to the plate 
columns.

For each well position, enter the Sample name for the Sample (ARR) and the 
barcode for the probe array.

Uploading the data 
for the files

1. From the Samples menu, select Sample Prep Plate Registration.
The Sample Prep Plate Registration page appears.

2. Enter the path or click Browse to select the plate registration file.
3. Select a project for the Sample (ARR) files (optional).
4. Enter plate IDs if registering samples for two plates.

The Array names will be based on the Sample Name entered in the worksheet, 
concatenated with the plate ID, if any, and the Well position as indicated by their 
position in the worksheet. 

5. Click Upload.
The Confirm page appears. (Figure 161)

Figure 160   Excel File for the target prep plate
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The page displays a list of the Sample (ARR) files created for the plate, along with 
Sample name, barcodes, and array names. 
Error messages are displayed if there is a problem. These errors must be corrected 
before finishing the registration.
If there are any errors:
a. Click Cancel
b. Check the plate worksheet.
c. Proceed with the upload again.

6. Click Next.
The Finish page opens. (Figure 162)

Figure 161   Confirm page
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Click Create Summary Spreadsheet for Batch Edit to open the Summary page and 
create a workbook summary of the Sample files that can be used for batch editing the 
Sample (ARR) files.

Figure 162   Finish page
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GeneTitan array plate registration

GeneTitan Array Plate Registration provides a convenient way to register samples and 
plate arrays for an Array Plate by using an Excel workbook.

A 384 or Mini 96 array plate can be used. A 96 array plate  (Figure 163) may contain 16, 
24, or 96 arrays. A Mini 96-array plate contains 96 arrays on a 384 format.

These formats allow for increased automation and processing times for large array 
counts.

The array plate has a barcode for tracking. Each individual array on the plate is 
identified by its row and column. For example, the circled array in the figure below is 
array D05.

Figure 163   384-,96-, and 24-Array Plates and Cartridge Array
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There are three sets of steps:

• ʺDownloading the GeneTitan array plate workbookʺ, below.
• ʺCompleting the workbookʺ on page 142.
• ʺUploading the workbookʺ on page 144.

Downloading the 
GeneTitan array 
plate workbook

To download the Excel Workbook:

1. From the Samples menu, select GeneTitan Array Plate Sample Registration.
The GeneTitan Array Plate Sample Registration page appears (Figure 165).

Figure 164   Arrangement of Arrays on Array Plate

A

B

C

D

E

F

G

H

01 02 03 04 05 06 07 08 09 10 11 12
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2. Select the templates you want to use by placing a check in the box next to their 
names (Figure 166).

You can display the attributes in the template by clicking on the template name.

3. Specify the GeneTitan Array Plate type and the project for the Sample files 
(required).

4. Click Download to download the file.
The Excel program displays the created workbook, which you can edit and save 
on your computer.

Figure 165   GeneTitan Array Plate Registration page

Figure 166   Select Templates
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F

Completing the 
workbook

The Batch Registration file can be used to enter data for all of the plate arrays on an 
array plate in one operation. 

The downloaded workbook has three worksheets:

• Samples worksheet, where you enter the data
• General info worksheet (do not edit), where GCC Portal stores information about 

Array types, projects, and file format
• Template Info worksheet (do not edit), where GCC Portal stores information 

about the template attributes

The Sample worksheet has columns with headers that define the property being 
entered.

Some properties define the sample and data files file and the physical array:

igure 167   Excel file for Batch GeneTitan Array Plate Registration

Sample File Path The path to where the Sample file will be created. Can be used to place Sample 
files in project folders.

Project The project that the Sample (ARR) file will be assigned to.

Plate Type Model of array plate.

Probe Array Type The array type on the plate.
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Path
The path needs to be associated with a data root. You can assign a set of sample files to 
a particular project if you select that projectʹs folder in the Path field. 

Project
Specifying a project for the Sample file will determine the folder the Sample file is 
created in.

If you are using Excel, you can select the project from a drop-down list. (Figure 152)

Plate type, probe array type, probe array position
These items specify the array plate type, the plate array type, and the array plate 
position.

They are automatically filled out when you create the plate batch workbook file. 

File names
Enter the name assigned to the Sample file that will be created.

Barcode
This is the array plate barcode; if you enter a barcode into the A05 probe array position 
barcode cell, the same barcode is copied automatically into all of the other rows.

Sample file and array name
Enter the names to be used for:

• The Sample (ARR) file.
• The Array plate and for all the data files (DAT, CEL, and CHP) for the array on 

the Array Plate.

Probe Array 
Position

Column and row position for the plate array.

Barcode Plate barcode: can be entered when you upload the batch registration file.

Sample File Name Name to be used for the Sample (ARR) file.

Array Name Name to be used for the array plate and for all the data files (DAT, CEL, and 
CHP)

Attributes Additional information about the sample and experiment that you can use to 
interpret your results.

Figure 168   List of projects in Excel 
workbook
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Attributes
Enter the values for the attributes in the appropriate columns. See ̋ Attributesʺ on page 
132 for more information.

Uploading the 
workbook

To upload the workbook:

1. From the Samples menu, select GeneTitan Array Plate Registration.
The GeneTitan Array Plate Sample Registration page appears (Figure 165).

2. Enter the file path and name in the Registration file box (Figure 169); or

3. Click Browse.
The Choose File window appears.

4. Click to select the array plate registration file, then click Open.
The file and its path is displayed in the Registration file box.

Note: If the plate barcode did not auto-populate, enter it now.
5. Click Upload.

If there are problems, the Errors page appears. (Figure 170)

• Click Cancel in order to correct problem(s) before uploading.
IF there are no problems, the Confirm Batch Sample Registration page opens. 
(Figure 171)

Figure 169   Upload file

Figure 170   Error notice
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6. Click Save to register the valid records.
The page displays a message that the Batch Sample Registration is complete. 
(Figure 172)

Figure 171   Confirm Batch Sample Registration

Figure 172   Confirmation page, upload successful
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Adding a barcode to a sample file

You may not have the barcode available when the Sample file is first created; if so, you 
can add it later using the Add Barcode page. 

Note: The Add Barcode page can only be used to add one barcode at a time. The Batch 
Edit workbooks can be used to add barcodes to multiple sample files or multiple 
barcodes to one sample file in a single operation (see ʺBatch editingʺ on page 148). The 
Add Barcode page cannot be used to add a barcode for a Array Plate. Array Plate 
barcodes must be provided at the time of registration

To add a barcode to a Sample file:

1. From the Samples menu, click Add Barcode.
The Add Barcode window opens. (Figure 173)

2. Enter the barcode:
Enter the barcode using the keyboard; or
a. Click in the Barcode field. 
b. Use the barcode reader to scan in the barcode on the array. 

The reader reads and sends the barcode to the Barcode field.
3. Click Search Arrays.

A list of Array names for that type of array that need a barcode appears in the 
Array list. (Figure 174)

Figure 173   Add Barcodes page
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4. Select the check box for the array that corresponds to the array barcode.
Note: You can use the View drop-down box and Customize button to add or 
delete attributes for display in the Array list. For more information, see ̋ Selecting 
attributes for the file listʺ on page 57.

5. Click Assign Barcode.
If it is successful, the result page is displayed. (Figure 175)
If the assignment was unsuccessful, the Add Barcode page is displayed with an 
error message.

Figure 174   Sample files displayed
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Batch editing

Batch Edit enables you to make edits to a set of previously created Sample (ARR) files.

Note: Batch edit cannot be used to create new Sample (ARR) files. Use the various 
Sample Registration functions described in this chapter to create new files. Also, Batch 
edit cannot be used to change file or array names. Use the editing functions of the 
Detailed Sample Registration page to do this. See ̋ Editing files and copying attributesʺ 
on page 111 for more information.

Using Batch Edit involves three sets of steps:

1. Create a batch edit file listing the files you want to edit, using the Project view, 
Folder, Search Results view, or use a previously created batch registration Excel 
file.

2. Edit the batch edit file, adding and changing attributes as needed.
3. Upload the batch edit file using the Batch Edit Upload function.

Figure 175   Results page
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Creating the batch 
edit file

You can create a batch edit file for:

• The Sample (ARR) files in a project or folder (see ʺGenerating a project summaryʺ 
on page 88).

• Selected Sample (ARR) files (see below)

To generate a Batch Edit File for selected Sample files:

1. Select the Sample files from the:
• Folder view page
• Project view page
• Search Results page

2. From the Command to Select drop-down, select the Create Batch Edit Files from 
Selected Arr files link.
The Summary page opens (Figure 176).

A list of Sample (ARR) files that will be in the summary appears.
3. Select a template to be used in editing (optional).
4. Click Create.

The Excel program displays the created workbook (Figure 177), which you can 
edit and save on your computer.

Figure 176   Summary page
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You can also edit a previously created Batch Registration file, adding attributes as 
needed. See ʺEntering values in the batch registration fileʺ on page 130 for more 
information about editing Batch Registration files.

Editing the batch 
edit file

The downloaded Excel workbook has three worksheets:

• Samples worksheet
• General info worksheet (do not edit)
• Template Info worksheet (do not edit)

The header row of the Samples worksheet includes special properties that define the 
file and the physical array:

The General Information Worksheet and the Template Info Worksheet (both marked 
Do Not Edit) contain information used by GCC in processing the data in the 
workbook.

Make the changes in the summary file to edit the files. You can:

• Enter attribute values
• Add user attributes with values
• Delete attributes from the Sample (ARR) file

Note: You can not make changes to file names or array names using this feature. 
Do not make changes to file names in the downloaded file.

The following items in the workbook must not be edited.

Figure 177   Batch Edit Excel Workbook, Samples worksheet

Sample File Path The path to where the Sample file is located. 

Sample File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array Type Part number for the array(s).

Barcode Barcode on the array(s)

Attributes Additional information about the sample and experiment that you can use to 
interpret your results.

Sample File Path The Path and Sample (ARR) file name.

Array Name Array name assigned to the files.
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Note: If you delete a the entire column for a template attribute, including the header, 
then an error will be generated. In order to remove attribute values from a sample file, 
users need to leave the header intact and remove the attribute values from the column

The first row of the workbook defines the data to be edited. Each additional row 
contains the information for one Sample (ARR) file. 

Multiple arrays for a single sample (ARR) file
If you have multiple arrays assigned to a single sample file, each array is on a separate 
line of the worksheet.

You cannot enter different attributes values for the same attributes for arrays 
associated with the same Sample (ARR) file.

Editing the barcode
You can only add a barcode to a Sample (ARR) file that does not already have one. You 
cannot edit a barcode that is already assigned to the Sample (ARR) file.

• If you assign a barcode to a Sample file, a warning message appears if the probe 
array type specified in the barcode does not match the probe array type 
previously assigned to the array.

• You can assign a custom barcode to a Sample file.

Editing attributes
Enter the values for the attributes in the appropriate columns. See ̋ Attributesʺ on page 
132 for more information.

Uploading the 
edited file

After editing the batch edit file, you need to upload the data into GCC. 

To upload the data:

1. From the Samples menu, select Batch Edit Upload.
The Batch Edit Attribute page opens. (Figure 179)

Figure 178   Multiple arrays
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2. Enter the file path and name in the box; or
a. Click Browse to open the Choose File window.
b. Select the Batch Registration or Batch Edit file and click Open.

The file and its path is displayed in the box.
3. In the Upload Spreadsheet section, click on Upload.

If there is a problem with the workbook, the Confirm Batch Edit Sample Files 
produces a warning, as shown in Figure 180.

Figure 179   Batch Edit Attribute page

Figure 180   Error notice
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If there are no issues, the Confirm Batch Edit page opens. (Figure 181)

4. Click Save to edit the valid records.
A batch edit is complete message appears.

Figure 181   Confirm Batch Edit
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Hybridizing and processing the array is the next step after sample registration in the 
recommended array processing workflow. (Figure 182)

The Fluidics Station 450 is used to hybridize, wash, and stain the GeneChip probe 
arrays (called arrays in this manual). The FS450 can independently process an array 
using a different fluidics protocol in each of four different modules. 

Figure 182   Recommended Cartridge Array Processing Workflow

GCC Cartridge Array 

Processing Workflow Steps

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Process Probe Array in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Step performed using:

GCC Portal

GCC Fluidics Control and 
Fluidics Station 450

 GCC Viewer

Thermo Fisher Scientific  and/or 
Third Party Data Analysis Software

GCC Scan Control and:
• GeneChip Scanner 3000 (GCS3000)
• GCS3000 With Autoloader

Hybridize Array and Sample
Not performed by GCC for 

Cartridge Arrays
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Instrument care

• Disconnect the power cord of Fluidics Station before replacing fuses.
• Use a surge protector on the power line to the fluidics station.
• The fluidics station should be positioned on a sturdy, level bench away from 

extremes in temperature and away from moving air. 
Note: You must have the required fluidics protocols installed before using the 
FS450. For more information, see ̋ Installing and updating protocolsʺ on page 175.

The GCC Fluidics Control software is used to control the FS450 Fluidics Station. A 
workstation with GCC Fluidics Control software and a Sealevel card installed can 
control up to eight different fluidics stations.

Note: Before you use the fluidics station, check the fluidics station configuration and 
prime the fluidics station with appropriate buffer. For more information, read this 
chapter.

This chapter describes how to use the GCC Fluidics Control software in the following 
sections:

• ʺGCC fluidics control softwareʺ
• ʺRunning protocolsʺ on page 159
• ʺFiltering the sample file listʺ on page 169
• ʺAdding a label to a station and modulesʺ on page 174
• ʺInstalling and updating protocolsʺ on page 175
• ʺEditing protocolsʺ on page 178

Refer to the GeneChip Fluidics Station User’s Guide for a description of the instrument 
itself.

You can set things up to provide email notification when protocols are complete or 
problems develop. See Appendix E, ʺNotification e-mailsʺ on page 370 for more 
information.

GCC fluidics control software

The GCC Fluidics Control software is used to control the FS450 Fluidics Station. The 
software is introduced in the following sections:

• ʺStartingʺ, below
• ʺMaster controlsʺ on page 157
• ʺStation controlsʺ on page 157
• ʺStatus windowʺ on page 158

Starting To start the GCC Fluidics control software:
• In the GCC Launcher, click the GCC Fluidics Control Icon; or

Click Start → Thermo Fisher Scientific → GCC Fluidics Control...
The GCC Fluidics Control window opens (Figure 183).
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Components of the GCC Fluidics Control window:

• Menu bar: Provides access to Fluidics Control functions.

• Tool bar: Provides quick access to frequently used functions.

• Master/Station controls: Click the tabs to switch between:
– ʺMaster controlsʺ (see below): Use to select a single protocol to run on multiple 

stations and/or modules. 
– ʺStation controlsʺ: Use to select different protocols to run on different modules 

in a station.
• Status window: Displays list of arrays in process with information on their status. 

See ʺStatus windowʺ on page 158.

• Status bar: Displays information about the status of the Fluidics station and the 
fluidics run in progress.

To hide or display the toolbar:
• From the View menu, select Toolbar → Standard Toolbar.

To add text labels to the toolbar buttons:
• From the View menu, select Toolbar → Text Labels.

To hide or display the Status Bar:
• From the View menu, select Status Bar.

Figure 183   GCC Fluidics Control window, Master controls

Menu bar

Tool bar

Master/Station
controls

Status bar

Status window
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Master controls The Master controls (Figure 184) enable you to select a single protocol to run on any or 
all stations and modules attached controlled by the workstation.

The Master controls are used for:

• ʺRunning a priming or maintenance protocol on multiple stations and modulesʺ 
on page 159.

• ʺRunning a fluidics protocol on multiple stationsʺ on page 161

Station controls The Station controls enable you to select arrays and protocols for each module of a 
selected station (Figure 185). The controls enable you to:

• Select a particular array for processing using the following parameters:
– Sample File Name
– Array Name
– Probe Array type

• Select a specific protocol for the array.

Figure 184   GCC Fluidics Control window, Master controls

Protocol Selection Station and Module Selection

Figure 185   GCC Fluidics Control window, Station controls
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Each module has its own set of controls. (Figure 186)

The use of the module controls is described in ̋ Running fluidics on individual stationsʺ 
on page 164.

Status window

The Status Window (Figure 187) displays:

• Station: Fluidics station in operation.
• Module: Module in operation.
• Array Name: Name assigned to the array.
• Probe Array Type

– Barcode ID: The last five digits of the probe array barcode.
– User: Person who created the Sample file.
– Protocol: Protocol used for the fluidics run.
– Date Time: Current data and time when a protocol is running, or data and time 

when it was complete.
– Current Stage: Fluidics protocol stage currently running.
– Time/Cycle: Amount of time left for current stage or wash cycle number (e.g. 

2 of 4).
– Temp: Temperature used for current stage.

Figure 186   Module controls

Figure 187   Status window
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– Time Remaining: Total time remaining for protocol.

Running protocols

You have several different options for selecting and running protocols with GCC 
Fluidics Control, depending upon:

• The type of protocol you want to run.
• Whether you want to run it on multiple stations.
• Whether you want to select different protocols for different modules in a station.

This section describes how to select and run protocols using GCC Fluidics Control:

• ʺRunning a priming or maintenance protocol on multiple stations and modulesʺ 
on page 159

• ʺRunning a fluidics protocol on multiple stationsʺ on page 161
• ʺRunning fluidics on individual stationsʺ on page 164
• ʺResuming a fluidics protocolʺ on page 167
• ʺBypassing steps in a fluidics protocolʺ on page 168

Running a priming 
or maintenance 
protocol on multiple 
stations and 
modules 

Priming fills the fluidics station lines with wash buffers and deionized water. The 
GeneChip Fluidics Station must be primed before it can be used to run assay protocols. 
Prime the fluidics station when:

• The fluidics station is first turned on.
• A wash solution is changed.
• The fluidics station is to be used again after a shutdown has been performed.
• A module LCD window informs you that the module is not primed.

This section explains how to run priming or maintenance protocols on multiple 
stations and modules.

To prime the fluidics station:

1. Start the GCC Fluidics Control Software.
See ʺGCC fluidics control softwareʺ on page 155.
The software opens with the Master controls displayed.

2. In the Select Protocols section of the Master controls, select List Maintenance 
Protocols Only.
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3. Select Prime_450 from the Protocol drop-down list; or
Select the maintenance protocol you want to run.

4. Select the modules to be primed (Figure 189).

You can:
• Select individual check boxes for each module.
• Click the Station ID check box to select all modules for a particular station.
• Click Check/Uncheck all Stations and Modules to select/deselect every 

station and module.
5. Click Copy to Selected Modules.
6. The selected protocol (Prime_450) is applied to the selected stations and modules.

Figure 188   Selecting the Prime protocol

Select to list
maintenance protocols

Then select Prime_450 
from the list

Figure 189   Selecting the stations and modules for priming
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7. Fill the intake buffer reservoirs A and B with the appropriate priming buffer. 
(Refer to the appropriate GeneChip probe array package insert). 

8. Empty the waste bottle and fill the water reservoir with deionized water. 
9. Load an empty, standard 1.5 mL microcentrifuge tube in the sample holder of 

each module to be primed.

10. Click the Run All button ; or

Select Start → Run All Modules Selected on Master Page.
11. Follow the prompts in the Status window (also shown in the module LCD 

window).
The Status window and the module LCD window display the status of the 
procedure. The fluidics station is ready to use when priming is completed and 
Priming done, Ready appears in the module LCD window. 

Running a fluidics 
protocol on multiple 
stations

You can run a selected protocol on any or all modules in the Fluidics stations attached 
to the workstation using the Master controls.

To select and run a fluidics protocol for a set of probe arrays:

1. Start the GCC Fluidics Control Software.
See ʺGCC fluidics control softwareʺ on page 155.
The software opens with the Master controls displayed (Figure 190).

2. Select the array type from the Probe Array Type list. (Figure 191)

Figure 190   Master controls
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3. Limit the protocols listed by selecting from the different options (Figure 192).

To limit the protocols listed:
c. Select one of the following buttons:

• List All Protocols
• List Compatible Protocols Only (displays only protocols that can be used 

with the selected labeling kit):
Select the appropriate check box:

–GeneChip IVT Labeling Kit
–GeneChip HWS Labeling Kit

• List Custom Protocols Only (displays only protocols that have been edited 
or provided by the user)

• List Maintenance Protocols Only (displays only maintenance protocols)
Only the protocols that meet the selected requirements are displayed in the 
Protocol drop-down list.

4. Select the protocol from the Protocol drop-down list (Figure 193).

Figure 191   Selecting probe array type

IMPORTANT!  The protocol that is displayed in the Protocol drop-down box after selecting 
the probe array type may or may not be the correct protocol for the array, depending upon the 
type of analysis being performed. To make sure the correct protocol is selected, follow the 
steps below.

Figure 192   Selecting options to filter the list of protocols

Select the options for 
filtering protocols
GeneChip™ Command Console™ (GCC) User Guide 162



Chapter 6 Controlling the fluidics station
Running protocols 6
5. Select the modules to be run by:
• Selecting individual check boxes for each module.
• Clicking the Station ID check box to select all modules for a particular station.
• Clicking Check/Uncheck all Stations and Modules to select/deselect every 

station and module.

6. Click Copy to Selected Modules.
The selected protocol is applied to the selected stations and modules.

7. Fill the intake buffer reservoirs A and B with the appropriate solutions (Refer to 
the appropriate GeneChip probe array package insert).

8. Empty the waste bottle and fill the water reservoir with deionized water. 

9. Click the Run All button ; or

Figure 193   Selecting protocols from the list

Select the protocol from 
the drop-down list

IMPORTANT!  The protocol that is displayed in the Protocol drop-down box after selecting 
the probe array type may or may not be the correct protocol for the array, depending upon the 
type of analysis being performed. To make sure the correct protocol is selected, select the 
correct options for filtering the protocol list as described above.

Figure 194   Selecting stations and Modules
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Select Start → Run All Modules Selected on Master Page.
The Status window and the module LCD window display the status of the 
procedure.

10. After the protocol is finished, remove the probe array and inspect the probe array 
window for air bubbles. 
If air bubbles are present, reinsert the probe array into the fluidics station to 
automatically drain and refill the probe array with the last wash buffer used. 
(Refer to the appropriate GeneChip probe array package insert.) If no bubbles are 
present, the probe array is ready to be scanned.

Running fluidics on 
individual stations

You can also select a particular fluidics protocol on an individual station and module.

To select and run a fluidics protocol on an individual station and module:

1. Start the GCC Fluidics Control Software.
See ʺGCC fluidics control softwareʺ on page 155.
The software opens with the Master controls displayed.

2. Click the tab for the station you want to use (Figure 195).

The Station controls displays the module controls for the selected station. 
Each module control has the same functions (Figure 196).

Figure 195   Tabs for Master and Station controls

Figure 196   Module control
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3. Click the Refresh button to refresh the list of Sample files.
4. Click in the Barcode box and enter the barcode using the keyboard; or 

Scan the barcode with an external barcode reader.
5. Press the Tab key.

The following items are selected automatically if the barcode is valid:
– Sample File name: Sample File with which the barcode is associated.
– Array Name: Array name with which the barcode is associated.
– Probe Array Type: Probe array type with which the barcode is associated.

If you enter a valid barcode or specify the array name by other means, the fluidics 
protocol information is kept with the Audit file for the array.
You can also:
• Select a Sample file without entering the barcode. In this case, if the Sample file 

has more than one array associated with it, you will need to select the proper 
array from the Array Name list.

• Specify a protocol without specifying a Sample file or array. In this case, the 
fluidics protocol information is kept in an audit file that does not link to a 
particular Sample file.

Note: You can use the Filter dialog box to limit the Sample (ARR) files displayed 
by various properties. SeeʺFiltering the sample file listʺ on page 169.

Figure 197   Barcode entered, 
Sample File name, Array Name, 
and Probe Array type automatically 
selected
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6. Set the options to filter the fluidics protocol selections.

To limit the protocols listed select one of the following buttons:
• All (lists all protocols available on your computer)
• Compatible (displays only protocols that can be used with the selected 

labeling kit):
Select the appropriate check box:
• GeneChip IVT Labeling Kit
• GeneChip HWS Labeling Kit

• Custom (displays only protocols that have been edited or provided by the 
user)

• Maintenance (displays only maintenance protocols)
Only the protocols that meet the selected requirements are displayed.

7. Select the fluidics protocol from the Protocol list.

8. Click Run to start the protocol on the selected module; or
From the Start menu, select Run All Modules on Current Station; or

Click the Run All Modules on Current Station button .

IMPORTANT!  The protocol that is displayed in the Protocol drop-down box after entering a 
barcode or selecting a sample name or probe array type may or may not be the correct 
protocol for the array, depending upon the type of analysis being performed. To make sure the 
correct protocol is selected, follow the steps below.

Figure 198   Selecting options for protocol selection

Figure 199   Selecting the protocol

Select the options for 
filtering protocols

Select the protocol from the list

IMPORTANT!  The protocol that is displayed in the Protocol drop-down box after entering a 
barcode or selecting a sample name or probe array type may or may not be the correct 
protocol for the array, depending upon the type of analysis being performed. To make sure the 
correct protocol is selected, select the correct options for filtering the protocol list as 
described above.
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9. Load the probe array and sample vial holder containing the appropriate solution 
in each active module. 
Sensors in the fluidics station detect when the probe array and sample vial holder 
have been loaded. The process will proceed automatically from this point, 
although some protocols may require removal and substitution of the sample vial 
and solution. The Fluidics Status window displays the status of the procedure (see 
ʺStatus windowʺ on page 158).

10. Repeat as necessary for other modules in the fluidics station(s).
11. After the protocol is finished, remove the probe array and inspect the probe array 

window for air bubbles. 
If air bubbles are present, reinsert the probe array into the fluidics station to 
automatically drain and refill the probe array with the last wash buffer used. 
(Refer to the appropriate GeneChip probe array package insert.) If no bubbles are 
present, the probe array is ready to be scanned.

Resuming a fluidics 
protocol

GCC tracks the progress of a fluidics protocol run. If the protocol stops before 
completion, it can be resumed at the point where it was interrupted. 

Note: The resume feature is only available for fluidics protocols that display multiple 
steps in the Step drop-down list of the Fluidics Station dialog box and that have failed. 
If you exit GCC Fluidics Control while a fluidics protocol is running, the resume 
feature will be unavailable upon startup of the software.

To resume a fluidics protocol:
• Click Resume in the Modules controls.

The selected protocol is started in modules one through four of the fluidics 
station.

Figure 200   Fluidics Control window, protocol running
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Bypassing steps in a 
fluidics protocol 

Some multi-step fluidics protocols can be started at any step, so that part of a protocol 
can be bypassed. 

Note: The bypass function is only available for fluidics protocols that display multiple 
steps in the Step drop-down list of the Fluidics Station dialog box.

To bypass steps:

1. Select an array and protocol as described in ʺRunning a fluidics protocol on 
multiple stationsʺ on page 161.

2. Select the desired beginning step from the Step drop-down list (Figure 201).

3. Click Run to start the fluidics protocol at the selected step.

Figure 201    Bypassing protocol 
steps 1, 2, and 3
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Filtering the sample file list

When first opened, the Sample file list in the module control displays all the Sample 
files available in GCC. (Figure 202)

You can use the Filter dialog box to limit the types of files displayed in the Sample File 
list.

Note: The Filter dialog box can also be used in the GCC Scan Control in Manual mode.

To use the Filter dialog box:

1. Click the Filters button ; or
From the Edit menu, select Filters....
The Filters dialog box opens. (Figure 203)

Figure 202   Station controls with 
unfiltered Sample File list
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The Filters dialog box enables you to filter the displayed Sample files by:

• Date: Files created on a date or range of dates.
• Selected Project Names: Files associated with a particular project.
• Selected Probe Array Types: Files for a specific probe array model.
• Template attributes and values: Files associated with a particular attribute value.
• Array Scan status: Files for arrays that have already been scanned.
• Array Name wildcard: Array names with a specified text string in their file name.

2. Select a date or range of dates for file creation:
a. Select the From check box.
b. Click the arrow at the date (displays the current date).

A calendar for the current month appears. (Figure 204)

Figure 203   Filters dialog box
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c. Select a date for the start of the range. You can move from month to month by 
clicking the < and > buttons.
If you only select one date, the filter will display only the files created on that 
date.

To select a range of dates:
d. Select the To check box.
e. Select a date for the end of the range.

3. Select projects from the Project Name drop-down list:
a. Click the down button in the Project Name list.

A list of the projects available in GCC on this computer is displayed. 
(Figure 205)

b. Select the check boxes next to the projects you want displayed in the filtered 
list. 
Note: For more information about creating and using projects, see ʺProjectsʺ 
on page 32.

4. Select Probe Array Types:
a. Click on the down arrow in the Selected Probe Array Types list.

A list of the available probe array types is displayed. (Figure 206)

Figure 204   From Calendar

Figure 205   Displaying Project List
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In some cases there may be multiple array models under the same header. in 
these cases you can click the + button to display the additional probe arrays.

b. Select the check boxes next to the probe array types you want displayed in the 
filtered list.

5. Select template attributes and enter values:
a. Locate the attribute you want to filter by.

Attributes are listed in the format: |Template Name|: Attribute Name.
User attributes are listed as: |USER|: Attribute Name. See ̋ User attributesʺ on 
page 23 for more information about user attributes.

b. Click in the check box next to the attribute name.  (Figure 207)

c. Click in the User Value column next to the attribute and enter a value 
(Figure 208).
You can use the * symbol as a wildcard in the User Value column.

Figure 206   Displaying array types

Figure 207   Selecting an attribute
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Note: The Sample Attribute Conversion function may impact your selection of 
templates and attributes. For more information, see ̋ ʺSample attributes conversionʺ on 
page 118.

6. Deselect the Include Scanned arrays check box to exclude arrays that have 
already been scanned; or
Select the check box to display all arrays, including scanned arrays.

7. Enter a text string (used in different array names) in the Array Name wildcard 
text box, using the * symbol as a wild card.
For example, if you have used the barcode as an array name, entering “@*” will 
display all array with filenames using a barcode.

8. Click OK.
The filtered Sample file list is displayed in the module controls. (Figure 209)
A Filters Applied notice appears above the list.

Figure 208   Entering an attribute value

Figure 209   Filtered Sample file list

Filters Applied notice
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Adding a label to a station and modules

You can add a label to a station or module in the GCC Fluidics Control software. The 
labels can be useful when you are using more than one Fluidics station. The labels 
appear in the Fluidics Control software and will be used in status e-mails and in the 
Audit file (see Appendix E, ʺNotification e-mailsʺ on page 370).

To add a label to a station and/or modules:

1. Click the Settings button ; or
From the Edit menu, select Station Settings...
The Fluidics Options dialog box opens (Figure 210).

2. Set the number of Fluidics stations installed in the Fluidics Stations Installed box.
3. Select the number of the station you want to label from the Station Number list.
4. Enter a label for the station in the Station ID box.
5. Enter labels for the modules in the Module ID boxes.
6. Click OK.
7. The Restart Notice appears (Figure 211).

8. Click OK to close the Restart Notice.
9. Shut down and restart GCC Fluidics Control.

The labels are used in the station controls. (Figure 212)

Figure 210   Fluidics Options dialog box

Figure 211   Restart Notice
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Installing and updating protocols

The fluidics protocols are files that list the steps used to process different types of probe 
arrays. After installing the GCC Fluidics Control software, you must install the fluidics 
protocols.

Installing protocols To install protocols:

1. From the Files menu, select Install Protocols...
The Fluidics Scripts Installer opens.

2. Click Next.
The Select Software screen appears.

3. Select the software you want to install scripts for and click Next.
The Select Source screen appears.

The screen enables you to: 
• Install the protocols from a directory on the file system.
• Install the protocols from the thermofisher.com web site. Note: You must be a 

registered user before using this feature.

To install from a directory:
a. Select the option.

Figure 212   Station Controls with labels
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b. Enter the path to the directory or click Browse and use the Select Directory 
dialog box to locate the directory with the scripts.

To install from thermofisher.com:
a. Select the option.
b. Enter user name and password.

4. Click Next.
The Select Package screen appears.

The screen displays a list of the fluidics scripts packages available from the 
selected source.

5. Select the package you want to install and click Next.
The Select Protocols screen appears. (Figure 213)

The screen displays a list of the protocols in the selected package with the following 
information:

• Protocol Name: With check box to select protocol for installation.
• New Version: Version of protocol in selected installation package.
• Version of installed Script: Version of protocol installed on your computer.

6. Select the check boxes for the protocols you want to install and click Next.
The Summary Screen appears. (Figure 214)

Figure 213   Select Protocols
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The Summary screen displays information about:
• Selected fluidics scripts
• Source Path
• GCC Target Directory
• GCC Log Path: Location of the log file for this installation.

7. Review the information and click Next.
A progress bar displays the progress of the install. (Figure 215)

When the install is completed, the Finish screen appears. (Figure 216)

Figure 214   Summary Screen

Figure 215   Progress screen
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8. Click Close.

Editing protocols

You can edit some hybridization and wash (Hybwash) protocols.

Note: Modifications to a Hybwash protocol must be completed before it is run. 
Protocol changes made during a run do not affect the run in progress.

To edit the protocol:

1. From the Edit menu, select Edit Protocol; or

Click the Edit button .
The Fluidics Protocol Editor dialog box appears. (Figure 217)

Figure 216   Finish screen
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2. Choose the fluidics protocol you want to edit from the Protocol Name drop-down 
list. The listed protocols are the same ones displayed when you select Custom in 
the Master and Station controls.
Note: Only the protocols in this list may be edited. All others are defined for 
specific applications and cannot be customized.

3. Highlight the parameter value you want to change and enter the new value 
(Parameters values must be within the ranges shown in Table 2 on page 180). 
Enter a Hybridization Time of zero if only a wash is desired. To omit Wash A or 
B, enter zero for the Number of Wash A or Wash B cycles.

Figure 217   Fluidics Protocol Editor
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The FS450Dx instrument specifications

Fluidics Station Dimensions
(height, depth, width)
40.2 x 41.0 x 71.1 cm or 15 13/16 x 16 1/8 x 28 inches

Product Weight
Approximately 80 pounds or 36.3 kg

Power Input
100 to 240 V~, 3 A
300 watts or less
Main supply voltage fluctuations not to exceed 10% of the nominal supply 
voltage.

Temperature
Operating: 15° to 30° C
Storage (non-operating):-10° to 60° C

Humidity
Operating: 10-90% RH, non-condensing
Storage (non-operating):10% to 95% RH

Other
Pollution degree, 2
Installation category, II

Electrical Supply
The electrical supply shall meet the input specified on the instrument label. 
Voltage fluctuations shall not exceed 10% nominal supply voltage.

Altitude
<2000m

4. Save the edited protocol:
• To save the parameters under the same protocol name (overwrites the old 

protocol), click Save. 

Table 2   Valid ranges for hybridization or stain protocol parameters

Parameter Valid Range

Hybridization or stain time 0 - 86,399 seconds

Temperature 15 - 50° C

Number of Wash cycles 0 - 99

Mixes per Wash cycle 1 - 99
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• To save the parameters under a new protocol name, enter a new name in the 
Protocol Name field, then click Save. 
This adds the new protocol name to the drop-down list.

5. Click Defaults to return the parameter settings to the default values.
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After processing in the Fluidics Station, the arrays need to be scanned. (Figure 218)

Scanning can be done with the following scanners:

• The GeneChip Scanner 3000 (GCS3000) can be loaded with one chip at a time for 
scanning.

• The GCS3000 with AutoLoader (Autoloader) has a carousel that can be loaded 
with up to 48 chips. The chips can then be scanned in sequence without operator 
attention.

The scanners are controlled by with the GCC Scan Control software.

Figure 218   Workflow for the Cartridge Arrays

GCC Cartridge Array 

Processing Workflow Steps

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Process Probe Array in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Step performed using:

GCC Portal

GCC Fluidics Control and 
Fluidics Station 450

 GCC Viewer

Thermo Fisher Scientific  and/or 
Third Party Data Analysis Software

GCC Scan Control and:
• GeneChip Scanner 3000 (GCS3000)
• GCS3000 With Autoloader

Hybridize Array and Sample
Not performed by GCC for 

Cartridge Arrays
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This chapter contains the following sections:

• ʺGCC scan control softwareʺ on page 183
• ʺApplying Tough-Spots to prevent leaksʺ on page 188
• ʺUsing GeneChip Scanner 3000ʺ on page 189

You can set things up to provide email notification when scans are complete or 
problems develop. See Appendix E, ʺNotification e-mailsʺ on page 370 for more 
information.

GCC scan control software

The GCC Scan Control software is introduced in the following sections:

• ʺStarting the softwareʺ
• ʺStatus window informationʺ on page 185
• ʺThe Status window (Figure 220) displays the following information:ʺ on page 185
• ʺSetting Up the Scanner IDʺ on page 187

Starting the 
software

To start the GCC Scan control software:

• Click the GCC Scan Control icon  in the Launcher; or 
Click the Start → Thermo Fisher Scientific → Command Console GCC Scan 
Control.
The GCC Scan Control window opens (Figure 219).

IMPORTANT!  Read all the material in this chapter before running the scanner.

IMPORTANT!  Please make sure that the data roots used in GCC software on the instrument 
control workstations do not contain files that have non-Thermo Fisher Scientific file extensions 
(example: DLL, TMP, CPP, ASPX, OUT, etc). 
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Components of the GCC Scan Control window:

• Menu bar: Access to functions of the software.
• Tool bar: Quick access to commonly used functions.
• Status Window: Displays list of scanned arrays with information on their status. 
• Status bar: Displays information about the status of the AutoLoader and the scan 

in progress.

To hide or display the toolbar:
• From the View menu, select Toolbar → Standard Toolbar.

To add text labels to the toolbar buttons:
• From the View menu, select Toolbar → Text Labels.

To hide or display the Status Bar:
• Click → View → Status Bar.

The Status window appears. (Figure 220)

Figure 219   GCC Scan Control window

Menu bar

Tool bar

Status Window

Status bar
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Status window 
information

The Status window (Figure 220) displays the following information:

Figure 220   Status window

Position Position occupied by a given cartridge in the AutoLoader carousel.
Completed scans are marked with a green check mark . 
Interrupted or failed scans are marked with a red X . 

Array Name Array name assigned to the array.

Probe Array 
Type

The probe array type for the scan associated with a given cartridge position.

Barcode ID The unique identifier in the barcode for the scan associated with a given cartridge position.

User Name of the user (array owner) for the scan associated with a given cartridge position.

Date & Time Date and time of the scan.

Scan Status The status of the scan. (Autofocus, scanning). This field displays all scanner status strings 
associated with the scan and retrieved from the scanner.
The message strings that may appear in this field are listed below. Note: Not all of the following 
messages will appear during each AutoLoader run.

• Autofocus 
• Scan Status - % of lines scanned
• Scan Complete status
• Autofocus Errors 
• The array XXX has already been scanned
• Chip load failures
• Invalid barcode errors
• Array does not exist errors
• AutoLoader door open errors 

Data File Location and name of data file.
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The Default folder is designated by the user as the automatic location of all files created 
during drop and scan operation, and for DAT and CEL files when the Sample (ARR) 
file is located on network data storage.

For more information on Network Data Storage option, see Appendix A, 
ʺNetworkingʺ on page 340.

For more information about designating the Default folder, see ʺSpecifying a default 
folderʺ on page 92.

For more information about transferring data to network data storage, see ̋ Uploading 
data to network data storageʺ on page 92.

Reviewing scanner 
information

To review scanner information:
• From the Scanner menu, select Information; or

Click the Info button.
The Scanner Information box opens (Figure 221).

The box displays information on:

• Scanner Type
• Scanner ID, if assigned (see ʺSetting Up the Scanner IDʺ on page 187)
• Serial Number
• Hardware Version
• Software Version
• Filters
• Pixel Sizes
• Scans Completed

Figure 221   Scanner Information box
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Setting Up the 
Scanner ID

You can add an ID label to the scanner which enables you to identify it when email 
notification is activated.

To add a label to a scanner:

1. From the Edit menu, select Scanner ID...
The Instrument Configuration dialog box opens. (Figure 222)

2. Enter a label for the Scanner in the Scanner ID box.
3. Click OK.

The label can be seen in the Scanner Information dialog box. (Figure 223)

Figure 222   Instrument Configuration 
dialog box

Figure 223   Scanner Information dialog box

New scanner ID
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Applying Tough-Spots to prevent leaks

Tough-SpotsTM are chemically inert polyvinyl labels that adhere to all plastics. Applied 
Biosystems recommends using 3/8-inch circle diameter Tough-Spots to prevent 
leakage from the array septa.

Before loading the probe array, follow this procedure to prevent the leaking of fluids 
from the array during scanning.

Even if you have already applied Tough-Spots to the array prior to hybridization or 
after washing, you must remove the old Tough-Spots and apply new ones before you 
load them into the AutoLoader.

Thermo Fisher Scientific recommends the use of Tough-Spots P/N 64-0158
or from
USA Scientific, Inc. P.O. Box 3565 Ocala, FL 34478 (800)LAB-TIPS P/N 9185-0000

To use Tough-Spots:

1. On the back of the probe array, clean excess fluid from around septa (Figure 224).

2. Carefully apply one Tough-Spot over each of the two septa. Press to ensure that 
the spots remain flat. If a Tough-Spot does not apply smoothly; that is, if you 
observe bumps, bubbles, tears or curled edges, do not attempt to smooth them 
out. Remove the spot and apply a new one. (Figure 225)

WARNING!  To reduce the risk of leakage, do not use excessively large pipette tips to pierce the 
septa. 

Figure 224   The GeneChip probe array
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Using GeneChip Scanner 3000

The GeneChip Scanner 3000 (GCS3000) is used to scan GeneChip probe arrays. It 
enables you to load and scan one array at a time.

Figure 225   Applying Tough-Spots to array septa

Figure 226   The GeneChip Scanner 3000

WARNING!  ONLY authorized personnel may service this equipment. The GCS3000 Scanner 
contains an incorporated Class 3B laser. Use of controls or adjustments or performance of 
procedures other than those specified herein may result in hazardous radiation exposure.
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This section contains the following material:

• ʺIntroduction to the GCS3000ʺ, below
• ʺScanning a probe array with GeneChip Scanner 3000ʺ on page 193
• ʺScan Optionsʺ on page 197
• ʺTroubleshootingʺ on page 198

Laser safety The laser is equipped with an automatic shutter that inhibits its output beam and 
ensures safe operation under conditions encountered in normal operation. The 
instrument covers, the array access port, and protective shutters ensure that during 
instrument operation no directed or stray laser light leaves the instrument.

The green laser is a 532nm solid-state laser. This is a Class 3B laser and has visible 

WARNING!  The GCS3000 Scanner contains an incorporated Class 3B laser with the following 
specifications: Wavelength = 532nm +/- 1 nm; Beam Divergence (full angle) = <8mrad; Output 
Duration = Continuous Wave; Maximum Power Output = 500mW.

Do not remove the cover of the scanner. Use the scanner only as instructed in this User Guide. Do 
not attempt to service the instrument.

WARNING!   Laser in use during scanning. 

IMPORTANT!  Read all material in this section before running the GCS3000.

IMPORTANT!  The scanner is a Class 1 laser product when the laser is enclosed in scanner case. 
The laser itself is a Class 3B laser product.

DANGER
Laser radiation when open. 

Avoid direct exposure to laser 
beam.

The lasers can cause serious injury if
the instrument is not operated in
accordance with instructions in this
user guide.

CAUTION
Use laser safety glasses when 

servicing
DO NOT STARE INTO LASER 

BEAM.

Class 1 Laser Product
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outputs greater than 5mw but not more than 500mw. It must never be operated in an 
exposed manner. Any object in the direct path of the laser beam may be damaged. Eyes 
and skin can be seriously damaged by direct exposure to, specular reflections from, or 
diffuse reflections from this laser. If improperly used, a laser of this type can cause 
fires. When used according to the instructions in this manual and when all covers are 
in place, the GeneChip Scanner is classified as a Class 1 Laser Product per IEC 60825-
1:2007. 

Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser 
Notice No. 50, dated June 24, 2007.

Always take note of laser safety labels; they indicate areas where exposure to laser 
beams may be hazardous.

Electrical safety The scanner will automatically handle any input voltage from 100 to 240 VAC nominal, 
50 to 60 Hz. 

Note: The scanner’s power supply will auto-detect the input voltage source and 
configure itself.

The power supply cord is used as the main disconnect device. Ensure that the socket 
outlet is located and installed near the equipment and is easily accessible.

 

CAUTION

CAUTION!  If you use the scanner in a manner not specified in this user guide, you may impair the 
protection provided by the equipment.

CAUTION!  Do not confuse your company’s network connections with the dedicated Ethernet port 
of the scanner-workstation. The proper scanner connection is located near the top of the 
workstation.

CAUTION!  This 10/100 Base T Ethernet communications port is dedicated to the scanner-
workstation interface. You cannot connect the scanner to your company’s Ethernet communications 
network. 

IMPORTANT!  The reset button is the scanner’s circuit breaker. The breaker switch will be 
tripped whenever the scanner experiences an electrical fault condition. Press to reset. If you 
cannot reset this switch, contact technical support. 
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Introduction to the 
GCS3000

This section contains:

• ʺTheory of Operationʺ, below
• ʺStarting the scannerʺ on page 193
• ʺShutting down the scannerʺ on page 193

Theory of Operation
The GeneChip Scanner 3000 is a wide-field, epifluorescent, near-confocal microscope. 
The scanner uses a 532 nm solid-state laser to excite probe array fluorophores. This in 
turn produces an emission wavelength appropriate for the probe array being scanned, 
which is automatically specified in the scan parameters for the selected probe array. As 
the surface of the probe array is scanned, a photomultiplier tube collects and converts 
the fluorescent emissions into an electrical signal. An analog-digital converter in the 
scanner converts this signal into corresponding numeric values representative of 
fluorescent intensities. These digital intensity values are collected from discrete areas 
on the array surface and are stored on the computer workstation as pixels that 
comprise the image data file (the DAT file). The patented Flying Objective™ technology 
represents a radical departure from conventional laser scanners. The optical system 
comprises a scan arm that rapidly oscillates from side to side scanning the entire width 
of the probe array in a continuous arc while the probe array is advanced in front of the 
objective. The acquired image of the array is returned to the computer software as a set 
of arcs. The software then geometrically corrects these arcs to form a linear image of 
the array (Figure 227). 

Figure 227   Schematic of the scanner design
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The laser source excites the hybridized fluorophores and the photomultiplier system 
simultaneously captures the resulting fluorescent intensities. The optical components 
direct the fluorescent beam back through the objective lens, through a dichroic mirror 
and to the PMT. An analog-digital converter transforms the PMT output into 65536 
levels of intensity. Each level of intensity is stored in the software as a 16 bit number 
(216=65536).

The scanner is equipped with an IEC 320 compliant power entry module located at the 
rear of scanner.

The scanner is equipped with an RJ-45 interface connector compatible with 10/100 Base 
T Ethernet for communications with the host workstation.

The GCC application controls the scanner. After the scanner has completed a scan, 
GCC displays a picture of the image in the image window. The software displays the 
fluorescent intensity values from each pixel within the probe array feature in a 
grayscale or pseudo color mode and superimposes a grid on the image to delineate the 
probe cells.

GCC analyzes the image and derives a single intensity value for each probe cell on an 
array. This data is automatically generated and saved to the cell intensity file.

Starting the scanner

1. Press the on/off (I/O) switch on the front panel. 
The scanner’s onboard computer boots up. The bootup process takes a few 
minutes. During this time both the yellow and green light will be on. The scanner 
enters the laser warm-up state. During this warm-up time, the green light will 
turn off and the yellow light will remain on. You must wait 10 minutes for the 
laser to stabilize.

Shutting down the scanner

1. Close the GCC software. This is the best way to shut off the laser. Alternately, 
press the I/O (on/off) button on the front panel to turn off the instrument.
Note: The laser also has a sleep mode that activates after 1 hour of inactivity.

Scanning a probe 
array with GeneChip 
Scanner 3000

This section shows you how to scan a GeneChip probe array using the GeneChip 
Scanner 3000. 

To scan a probe array:

1. Turn on the Scanner-AutoLoader (see ʺStarting the scannerʺ, above).
2. Start the GCC Scan Control Software (see ʺGCC scan control softwareʺ on page 

183).
3. Click the Start button  in the main tool bar; or

Select Scanner Start Scanner from the menu bar.
The Scanner dialog box opens. (Figure 228)
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At this point, you can choose from these options:
• If your array has a valid barcode, you can scan the barcode on the probe array 

into the barcode field. The software will retrieve the sample file and array 
name associated with the barcode.
If the barcode is not associated with an existing Sample file and array, a sample 
file will be created during scan using Drop and Scan.

• If your array does not have a valid barcode, you can manually select an array 
as described below:

a. Select the Sample file name for the probe array you want to scan from the 
Sample File Name drop-down list.

b. Select the array name of the probe array to be scanned from the Array Name 
drop-down list.
The Probe Array Type field automatically displays the probe array type that 
was entered while creating the Sample file. 

4. Click Start in the Scanner dialog box.
The Start window appears. (Figure 229)

If you want to skip the warm-up period before scanning the first probe array, keep 
the default check-mark in the Array at room temperature check box. If you want 
to allow rescans, click the Allow rescan check box.

Figure 228   Scanner Dialog box

Figure 229   The Start Scanner 
dialog box
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5. Click OK to start the run.
The GeneChip Scanner dialog box appears. (Figure 230)

The scanner door opens and the chip transport mechanism raises to accept a 
probe array.

6. Load the probe array (Figure 231) into the scanner chip transport mechanism. 
Insert the probe array into the chip transport mechanism such that the front of the 
probe array (label side) faces to the rear of the scanner.
Note: The scanner will enter Park mode if it is unattended for 15 minutes and will 
enter standby, or sleep, mode if it is unattended for 60 minutes (45 minutes after 
entering Park mode). The green light will turn off and the yellow light will turn 
on. To reactivate the laser, click Turn Laser On in the scanner dialog box and wait 
10 minutes.

Figure 230   Scanner dialog box

Figure 231   GeneChip probe arrays. Note the location of the flange, as the scanner 
accepts the probe array in only one orientation.

CAUTION!  Do not force the probe array. If the array does not drop easily into the chip 
transport mechanism, eject the array and try again. If this does not remedy the situation, 
seeʺTroubleshootingʺ on page 198 or call technical support. Also, if a probe array becomes 
lodged in the scanner, you can manually remove it. For more information, see ʺTo manually 
removing a lodged/stuck probe array:ʺ on page 200.

In addition, you cannot modify the scanner settings. GCC automatically selects the appropriate 
settings based on the probe array type specified during experiment setup.
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7. Click OK in the GeneChip Scanner dialog box to start scanning the probe array.
During the scan, the green light will flash, and the yellow light will be off.
After the scan starts, the software will start with the auto-focus routine. Data 
collection starts after successful completion of auto-focus. During the pre-scan 
state, when auto-focus is complete, but before data collection has started, the 
software will count downwards. 
Note: When multiple emission filters are used during the scan process, the 
software will display the scan with a letter followed by the percentage of scan 
completed. The letter identifies the scan associated with the emission filter.

After the scan is completed, GCC:
• Saves the image data.
• Aligns a grid on the image to identify the probe cells.
• Computes the probe cell intensity data.
• Ejects the probe array.

Figure 232   Loading the probe array into the 
chip transport mechanism. Note that the 
front of the probe array faces to the rear of 
the scanner.
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Note: If you leave the scanner idle for an additional 15 minutes, the scanner will also 
enter “Park” mode. The yellow light is off and the green is light on. The chip transport 
mechanism will retract and the scanner door will close. You must click the Eject Chip 
button to open the scanner door and raise the chip transport mechanism.

Note: You can track the progress of the grid alignment and cell intensity computation 
in the GCC Viewer. For more information see Chapter 9, ʺUsing the GCC viewerʺ on 
page 271.

Scan Options This section describes various options when using the GCS3000:

• ʺScanning Four-Color Arraysʺ
• ʺStopping a Scanʺ on page 197

Scanning Four-Color Arrays
The four color scans are performed on GeneChip arrays that have been configured for 
use with four emission filters. The four emission filters are specified in the GCC scan 
parameters. when performing a multi-filter scan, GCC scans the array with different 
emission filters, using the order specified for the array. 

A DAT file is created for each of the emission filter scans. To distinguish the different 
scans, GCC appends a suffix of A, B, C, or D to the DAT files. Different file naming 
conventions are used in the case of a rescan of an array, depending upon whether the 
array was manually loaded.

When running multiple scans on an array, the scanner performs autofocus only once, 
prior to the first scan. This is true whether the scans are performed as part of a four-
color scan or as a re-scan. 

To abort a scan with a manually loaded array:
If scanning is aborted on a manually loaded array, the emission filter scan in progress 
continues until it is complete, and the DAT data for the completed scans are saved. 
When the scan is resumed, GCC auto-focuses the scanner and then re-scans and re-
creates a DAT file for each emission filter scan, overwriting the previously created 
DAT files.

Stopping a Scan

1. Click the STOP button  or select Run Stop Scanner from the menu bar.
2. At the prompt, click Yes to stop the scanner or No to cancel stopping (Figure 233).

Figure 233   Stop scanner prompt
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3. After you stop a scan, the scanner will automatically eject the array. 
Note: The scanner dialog box has an eject array button. This is reserved for ejecting an 
array after the scanner goes into sleep mode or when you must manually eject the array 
for any other reason. If the probe array becomes stuck, see ʺTroubleshootingʺ or call 
technical support.

Troubleshooting

For additional troubleshooting information, see:

• ʺIssues relating to the scanner’s operationʺ on page 199
• ʺManually removing a lodged probe arrayʺ on page 222

CAUTION!  If you click Yes, the data from a partial scan will be lost. This is different from using 
earlier software or scanner versions where you could save the data from a partial scan.

If you rescan a probe array that has been partially scanned, the previously scanned area of the 
probe array may experience fluorophore bleaching. This will result in non-uniform fluorescence 
intensity across the probe array.

Table 3   Troubleshooting tips

Problem Possible Cause Corrective Action

No image when scanning Power off or cable loose Check all connections and power.

Loss of laser power Contact technical support.

Intermittent problems scanning Loose cable Check all rear connections.

Scanner fails with probe array inside Power failure Manually extract probe array. Check all connections 
to scanner. Turn scanner on, restart software.
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Issues relating to the scanner’s operation
The table below lists some issues and problems that you may encounter while using 
the GCS3000.

Issue Explanation

If communications are 
interrupted during a scan (by 
a faulty cable connection or 
power being lost at the 
scanner, for example)

GCC will properly note the failure and present a message “Cannot connect to Scanner.” 
However, there are two issues to note. First, GCC will report such a failure only after a 
network time-out of about 30 seconds. Second, rarely, if communications have been 
lost, GCC and the Scanner may not be able to automatically restore communications 
once the problem is rectified, and both may become unresponsive. 

To restore proper operation, verify that the scanner is on, that communication cables 
are properly connected, and close and restart Microsoft® Windows® then restart GCC. 
If the system remains unresponsive, disconnect and reconnect power to the scanner, 
restart the scanner normally, close and restart Microsoft® Windows® and GCC.

Repeated attempts to send 
commands (Start, Turn Laser 
On, etc.) from GCC to the 
Scanner while GCC is 
reporting the scanner 
“Offline” may result in GCC 
becoming unresponsive until 
communications are restored

If communications cannot be re-established, please follow the recommendations of 
item 1

If the Scanner experiences 
multiple auto-focus failures, 
the system may enter an 
unresponsive state. 

Follow the recommendations of item 1 to restore communications and correct 
operation.

Laser warm-up lasts for ten 
minutes, during which time 
the “Turn Laser On” button 
will remain unchanged and 
GCC will display the status 
message “Warm-up”. 

Simply note that this is normal operation.

If no array is inserted and a 
scan started.

The scanner will attempt go through the first parts of the auto-focus routine and then 
report “Failed to find chrome border”.

The scanner should be in the park mode to eject the array.

Auto focus will fail if salt 
deposits accumulate on the 
array.

Use Tough-Spots to prevent leaks in the GeneChip probe array. See the quick reference 
card, p/n 08-0076.

CAUTION!  Heavy object. Two people are required to lift the scanner.
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To manually removing a lodged/stuck probe array:
In the event that a probe array becomes lodged in the array transport mechanism, 
follow the procedure outlined below.

1. Turn off the scanner. 
2. Insert a paper clip or small Allen wrench into the rescue hole on top of the scanner 

and press to partially lift the array loading door.

3. Using your fingers, gently lift the front edge of the door. As you lift the front edge, 
lift the back edge approximately 1/4” to open the door straight up to expose the 
rescue screw in the front.

4. Using a standard (-) screwdriver, turn the rescue screw clockwise to raise the 
array transport mechanism.

5. Continue to turn the screw until the probe array ascends sufficiently to grab it.

Figure 234   Using the rescue hole
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Note that the screw is fine pitched and requires a number of turns. Stop if you 
encounter screw resistance. Do not over torque.

6. When the array has ascended sufficiently, remove it.

Figure 235   Turning the rescue screw
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7. Re-screw the array transport mechanism until it descends completely, or until 
you encounter resistance. Do not over torque.

8. Close the door.

Figure 236   Removing the array
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GCS3000 Specification

GCS3000 Specification table:

Item Parameter Value 

Weight Shipping

Free -standing 

approx 74 pounds (35.4 Kg)

63 pounds (28.6 Kg)

Dimensions Width

Depth

Height 

-13.25 in

-27.5 in

-18.25 in

Power Voltage
Current
Line Frequency 

100 - 240 V –
4 - 2 A
50 - 60 Hz

Working Environment Temperature

Humidity

Clearance 

Pollution Degree

Installation Category 

Altitude 

59°F-85°F (15°C-30°C)

10-90% Non-condensing 

2 in.(5 cm) on side, back and top 

2

II

<2000m

Electrical Supply 

Main Supply Voltage 
Fluctuations 

Provide voltage, frequency 
or power rating per unit 
label

Are not to exceed ±10% of 
the nominal supply voltage 
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Using the GCS3000 with AutoLoader

The GeneChip Scanner 3000 with AutoLoader (AutoLoader) is similar to the GCS3000 
with the addition of a carousel autoloader, designed expressly for scanning multiple 
GeneChip probe arrays. The AutoLoader can scan up to 48 probe arrays automatically 
without operator presence.

Introduction For more information about the scanner, see ʺIntroduction to the GCS3000ʺ on page 
192.

Starting the AutoLoader

To turn on the AutoLoader:
• Turn on the Scanner-AutoLoader by pressing the on/off (I/O) switch on the front 

panel. 
The scanner’s onboard computer boots up. The bootup process takes a few 
minutes. During this time both the yellow and green light will be on. The scanner 
enters the laser warm-up state. During this warm-up time, the green light will 
turn off and the yellow light will remain on. You must wait 10 minutes for the 
laser to stabilize.

WARNING!   Laser in use during scanning. 

Figure 237   The GeneChip Scanner 3000 with 
AutoLoader
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Shutting down the scanner

To shut off the scanner:

1. Close the GCC software. This is the best way to shut off the laser. 
2. Press the I/O button on the front panel to turn off the instrument.

Scanning probe 
arrays with 
GeneChip Scanner 
3000 with 
AutoLoader

This section shows you how to scan a GeneChip probe array using the GeneChip 

Scanner 3000 with AutoLoader.

To scan chips using the AutoLoader:

1. Turn on the AutoLoader by pressing the on/off (I/O) switch on the front panel. 
The scanner’s onboard computer boots up. The bootup process takes a few 
minutes. During this time both the yellow and green light will be on. The scanner 
enters the laser warm-up state. During this warm-up time, the green light will 
turn off and the yellow light will remain on. You must wait 10 minutes for the 
laser to stabilize.

2. Load your cartridges into the carousel (up to 48). Note that only one orientation 
is possible (Figure 238).
Cartridges should be loaded into the carousel starting at position #1. Additional 
cartridges need not be contiguous. A run will stop after 48 cartridges OR when the 
same barcode is read within the same run.
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3. Load the carousel into the AutoLoader by inserting the carousel into the 
AutoLoader and turning the carousel until the alignment pin seats into the 
alignment hole. (Figure 239)

Figure 238   Loading the array into the chip carousel. Each slot is 
numbered, 1 through 48, and each array can fit in only one orientation
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4. Turn the carousel clockwise until the carousel mounting key flat seats gently into 
the AutoLoader alignment key. You may have to turn the carousel several times 
before it will seat into the alignment pin and alignment key. When seated 
properly, the carousel will be flush with the AutoLoader housing.

5. Close the AutoLoader door. (Figure 240)

Figure 239   Loading the array carousel into the AutoLoader

Alignment
Key in the
Autoloader

Alignment
Hole

Alignment
Pin

Carousel
Mounting
Key Flat
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Note: The seating of the key flat is confirmed by a gentle falling of the carousel 
into the key. 
Note: If all probe arrays have valid, associated barcodes, you can run the 
AutoLoader in auto-mode.
Note: If there exists an identical barcode within the database from an earlier 
AutoLoader run, and you want to rescan the current probe array with that same 
barcode, check the Allow Rescans box. This will create additional DAT files. The 
original DAT file WILL NOT BE OVERWRITTEN. A new DAT file is created, and 
the file name for the new file has an underscore and incremental number added 
to it, beginning with _2. If the AutoLoader encounters the same barcode within 
the same run, the run will terminate.

6. Start the GCC Scan Control software (see ʺStarting the softwareʺ on page 183).
7. Set the default settings.

a. Click Edit Options.
b. Clear the Enable Manual Mode check box.
c. Click OK.

Figure 240   Inserting and turning the carousel. the carousel 
must be seated and flush with housing.
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8. Click the Start button  in the main tool bar; or
Select Scanner Start Scanner from the menu bar.
The Start window appears. (Figure 242)

If you want to skip the warm-up period before scanning the first probe array, keep 
the default check in the First four arrays at room temperature box. 

9. Click OK in the Start Scanner dialog box to start the run.
• The AutoLoader blue indicator light will light up signifying that the 

AutoLoader door is now locked.
• The carousel automatically homes itself and performs inventory to determine 

the number and position of cartridges present. 
• The scanning run begins. During the scan, the green light will flash, and the 

yellow light will be off. 
• The AutoLoader completes the autofocus operation before scanning each of 

the probe arrays. This takes approximately two to three minutes. The scanner 
cannot be stopped during this period.

• The run will stop automatically when the last array is scanned.
• At the completion of each scan, the GCC software will attempt grid alignment. 

If it is successful, the scan data will be automatically advanced to the Grid 
Alignment processing state. 
The progress of the scan data can be tracked using the Review Window of the 
GCC Viewer (see Chapter 9, ʺUsing the GCC viewerʺ on page 271).

• The progress of each scan is displayed in the Scan Status window (Figure 243).

Figure 241   Scanner Options 
dialog box with Enable 
Manual Mode check box 
cleared

Figure 242   The Start 
Scanner dialog box in 
automode
GeneChip™ Command Console™ (GCC) User Guide 209



Chapter 7 Scanning cartridge arrays
Using the GCS3000 with AutoLoader 7
• The window displays a list of the arrays as they are being scanned with the 
information displayed in the Status window (see ̋ Status window informationʺ 
on page 185)

After the scan is completed, GCC:
a. Saves the image data to an image file (*DAT).
b. Ejects the probe array.
c. Aligns a grid on the image to identify the probe cells.
d. Automatically computes probe cell intensities and saves the data to the cell 

intensity file (*CEL).
Note: You can track the progress of the grid alignment and cell intensity 
computation in the GCC Viewer. 
Arrays with barcodes that are not associated with a Sample file and array will 
have a sample file created using Drop and Scan.
The AutoLoader will skip probe arrays if the AutoLoader encounters:
• Arrays with unreadable or invalid barcodes or without barcodes.
• Arrays that have been previously scanned if the Allow Rescans check box is 

cleared.
10. Close the GCC Scan Control software. This is the best way to shut off the laser. 
11. Press the I/O button on the front panel to turn off the instrument.

Figure 243   Scan Status window during autoloader run.
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Special scan 
options The following sections describe various options for running the scan: 

• ʺDrop and scanʺ on page 211
• ʺStopping an AutoLoader runʺ on page 211
• ʺAdding cartridges during a runʺ on page 212
• ʺScanning a Probe Array in Manual Modeʺ on page 215
• ʺEjecting a probe arrayʺ on page 217
• ʺUsing GCC with the AutoLoader disabledʺ on page 217
• ʺScanning four-color arraysʺ on page 218
• ʺTerminating a scan runʺ on page 219

Drop and scan
The Drop and Scan feature lets you scan a set of GeneChip probe arrays without first 
creating a Sample (ARR) file for them. A Sample file is created automatically during 
Drop and Scan, with the probe array barcode used as the file name.

To use Drop and Scan:

1. Start the GCC Scan Control software.
2. Start the scanner.
3. Load the arrays in the scanner.
4. Click the Start button.

If the arrays have valid barcodes, they are scanned. The ARR, DAT, and CEL files 
are named using the barcode and placed in the designated Default folder.
For more information about the Default folder, see:
• ʺDefault foldersʺ on page 31
• ʺSpecifying a default folderʺ on page 92
If the scanner cannot read the barcode, or if there are no library files on the system 
for chips with that part number, the chip is ejected and an error notice appears. 

Stopping an AutoLoader run
The Stop button is only available after you have clicked the Start button. Click this 
button if you want to abort a scan or run in progress.

Note: If you stop the scanner while a probe array is in the process, you will lose all scan 
information from that probe array. If you rescan the array, it may be affected due to 
uneven photo-bleaching. This could potentially make the data from the array difficult 
to compare to other array data.

1. Click the STOP tool bar button  or select Scanner Stop Scanner from the 
menu bar.

2. At the prompt, click Yes to stop the scanner or No to elect not to stop the 
AutoLoader run.
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A window displays the message “The scanner will not stop until autofocus has 
finished.” 

3. Click OK.
After you stop a scan, the scanner automatically ejects the array.

Adding cartridges during a run
The software provides you with a button that will enable you to unlock the 
AutoLoader door and add additional probe array cartridges while in the middle of an 
AutoLoader run. You have two choices: 

• To add cartridges immediately even while a scan is in progress (in which case the 
DAT file is discarded and replaced with a newly collected one after the 
AutoLoader run is resumed). 

• To add cartridges after a scan has completed (in which case the DAT file is saved).
Note: The Add Chips button is enabled only after the AutoLoader has started a 
run in automatic mode. 

To interrupt the scan in progress:
Note: If you stop the scanner while a probe array is in the process, you will lose 
all scan information from that probe array. If you rescan the array, it may be 
affected due to uneven photo-bleaching. This could potentially make the data 
from the array difficult to compare to other array data.

1. Click the Add Chips button , or select Run Add Chips from the menu bar.
The Add Chips Options dialog box opens. (Figure 245)

2. Click Add Now.
The blue AutoLoader indicator light will turn off signifying that the AutoLoader 
door is now unlocked. 
If a scan is in progress, the software will continue to record the scan. However, to 
avoid the possibility of generating a corrupt DAT file, it will discard that scan that 
was in progress when the door was opened. 

Figure 244   Stop AutoLoader prompt

Figure 245   The Add Chips Options 
dialog box
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3. Open the door and add probe array cartridges to the carousel.
4. Close the scanner door.

The following window appears. (Figure 246)

5. Click OK. 
6. Click the Resume  button; or select Run Resume.

The Notice dialog box opens. (Figure 247)

7. Select the Allow Rescans option, if desired, then click OK.
The blue AutoLoader indicator light turns on signifying that the door is locked. 
The software homes the carousel and inventories the number of present probe 
arrays. The carousel then moves to that last previously scanned probe array 
(when the door was opened) and continues the scanning run by rescanning that 
probe array.
The array is rescanned and a new DAT file overwrites the previous DAT file.

To add chips without interrupting a scan:

1. Click the Add Chips button , or select Run Add Chips from the menu bar.
The Add Chips Options dialog box opens. (Figure 248)

Figure 246   Resume notice

Figure 247   Notice dialog box

IMPORTANT!  Do not load an array into the same carousel position that was occupied by the 
array that had just been scanned, i.e., do not replace cartridges.

Figure 248   The Add Chips selection 
buttons
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2. Click Add after scan. 
The Interrupt After Scan Complete notice appears. (Figure 249)

3. Click OK.
The AutoLoader will wait until the current probe array has undergone the 
autofocus and scan procedures before unlocking the door.
The blue AutoLoader indicator light turns off when the AutoLoader door is 
unlocked.

4. Open the door and add probe array cartridges.
5. Close the scanner door.

The Resume Notice dialog box opens. (Figure 250)

The GCC status bar displays a “waiting to start” status.
6. Click OK. 
7. Click the Resume  button; or 

Select Run → Resume.
The Run Options dialog box opens. (Figure 251)

8. Select the Allow Rescans option, if desired, and click OK.
The blue AutoLoader indicator light turns on signifying that the door is locked. 
The software homes the carousel and takes inventory of the probe array cartridges 
present. The carousel then proceeds to the next array position following the 
previously scanned probe array. The AutoLoader continues the run from that 
array position.

Figure 249   Complete Scan notice

Figure 250   Resume notice

Figure 251   Run options dialog box
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Note: If you click the Cancel button in the Run Options dialog box, the 
AutoLoader will not resume the scan.

Scanning a Probe Array in Manual Mode
In the AutoLoader Automode, each probe array requires a valid barcode in order to be 
scanned. The manual mode feature enables you to scan one probe array at a time 
without the requirement of a barcode. This is useful if you must scan probe arrays that 
have invalid or absent barcodes.

To scan a probe array in manual mode:

1. Set the scanner options.
a. From the Edit menu, click Options. 

The Scanner Options dialog box opens. (Figure 252)
b. Check Enable Manual Mode.
c. Click OK.

2. Click the Start button ; or
Select Scanner Start Scanner from the menu bar.
The Scanner dialog box opens. (Figure 253)

Figure 252   Scanner Options 
dialog box, Enable Manual 
Mode checked

Figure 253   Scanner Dialog box
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At this point, you can choose from a number of options:
• You can click Start without selecting an array name. If your array has a valid 

barcode, the software will get the barcode from the array in the AutoLoader 
and select the correct Sample file and Array name.

• If your array has a valid barcode, you can scan the barcode on the probe array 
in to the barcode field. The software will retrieve the Sample Attribute File 
associated with the array.

• If your array does not have a valid barcode, you can manually select an array 
as described below:

– Select the Sample file name for the probe array you want to scan from the 
Sample File Name drop-down list.

– Select the array name of the probe array to be scanned from the Array Name 
drop-down list.

The Probe Array Type field automatically displays the probe array type that 
was entered during experiment setup. 

3. Click Start in the Scanner dialog box.
The Start dialog box appears. (Figure 254)

Note: If you want to skip the warm-up period before scanning the first probe 
array, keep the Arrays at room temperature check box marked as checked. 
Note: You can eject or load an array by clicking on the Load/Eject button at any 
time except when the scanner is engaged in the autofocus operation or the 
scanning run.

4. Load the probe array into slot number 1. 
Note: The array slot at position number 1 is the only slot available in Manual 
Mode.

5. Click OK in the Start Scanner box (Figure 254) to start the autofocus routine. This 
takes approximately two to three minutes. The scanner cannot be stopped during 
this period.
During the scan, the green light will flash, and the yellow light will be off.
After the scan is completed, GCC:
a. Saves the image data to an image file (DAT).
b. Aligns a grid on the image to identify the probe cells.
c. Automatically computes probe cell intensities and saves the data to the cell 

intensity (CEL) file.

Figure 254   The Start Scanner 
dialog box
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Note: You can view the status of the cell intensity computation in the GCC 
Viewer.

d. Ejects the probe array.

Ejecting a probe array
The probe array will automatically eject after a run.

Using GCC with the AutoLoader disabled
If you have a working scanner but the AutoLoader is not operating, you can still use 
the scanner, but you must check the Disable AutoLoader option in the Defaults 
window. This will disable the AutoLoader and enable you to use the scanner alone as 
you would in manual mode.

1. From the Edit menu, click Options. 
The Scanner Options dialog box opens. (Figure 255)

2. Check Disable AutoLoader. 
3. Click OK.

A window will appear asking that you reboot the scanner.

 

4. Press the scanner front panel I/O button once to turn off the scanner. Wait a few 
moments, the press the I/O button to turn on the scanner.

5. Open the AutoLoader door.
6. Manually load a probe array into the slot. 
7. Close the AutoLoader door.
8. Scan the probe array in the same manner as the AutoLoader in manual mode. See 

ʺScanning a Probe Array in Manual Modeʺ on page 215.
After scanning the probe array, you must manually remove the probe array from 
the AutoLoader. See Steps 7 though 13 in ʺManually removing a lodged probe 
arrayʺ on page 222.

Figure 255   Disable 
AutoLoader checked

Figure 256   Reboot notice
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Scanning four-color arrays
Four color scans are performed on GeneChip arrays that have been configured for use 
with four emission filters. The four emission filters are specified in the GCC scan 
parameters. when performing a multi-filter scan, GCC scans the array with different 
emission filters, using the order specified for the array. 

A DAT file is created for each of the emission filter scans. To distinguish the different 
scans, GCC appends a suffix of A, B, C, or D to the DAT files. Different file naming 
conventions are used in the case of a rescan of an array, depending upon whether the 
array was manually loaded (see below) or loaded using the autoloader on page 218.

When running multiple scans on an array, the scanner performs autofocus only once, 
prior to the first scan. This is true whether the scans are performed as part of a four-
color scan or as a re-scan. 

To abort a four-color scan with a manually loaded array:
If scanning is aborted on a manually loaded array, the emission filter scan in progress 
continues until it is complete, and the DAT data for the completed scans are saved. 
When the scan is resumed, GCC autofocuses the scanner and then re-scans and re-
creates a DAT file for each emission filter scan, overwriting the previously created 
DAT files.

To aborting a four-color scan when using the autoloader:
If scanning is aborted on an array loaded using the autoloader, the emission filter scan 
in progress continues until it is complete, and the DAT data for the completed emission 
scans are saved. When the scan is resumed, GCC auto focuses the scanner and then re-
scans and re-creates a DAT file for each emission filter scan. GCC does not overwrite 
the previously created DAT data, but creates a new set of DAT files, adding a suffix of 
“_nX” to the DAT file name, where n identifies the rescan number and ʹXʹ is the letter 
assigned for the emission filter. A 4-color array scanned a second time will produce 
DAT files with the following suffixes: _2A, _2B, _2C, _2D. 

Note: When using the “Add Chips Now” function of the autoloader, if the door is 
opened in the middle of a scan acquisition, GCC treats the scan as an abort request. 
After the emission filter scan in progress completes, scanning halts and the DAT and 
CEL files for the completed emission filter scans are saved. Upon resume, the GCC 
auto-focuses the scanner and rescans the array for each emission filter. To avoid the 
rescan of the array, it is recommended that the “Add Chips Later” function be used. 

Autorotation: The AutoLoader is equipped with a heater to warm up the cartridges 
prior to scanning in order to reduce condensation and fogging of the probe array 
window. This autorotation routine is used for temperature stability but only after the 
AutoLoader run is complete or during a power failure as described below.

Autorotation
Autorotation occurs during a power failure only if the uninterrupted power supply 
(UPS) is included as an accessory. The UPS provides power to the scanner/AutoLoader 
during a power failure. If the power fails during the scan of an array, that scan is 
completed and then the system turns off the heater and enters the autorotation mode 
to conserve power and cool the chips in the carousel. The system will also attempt to 
send an e-mail to notify the user of the power failure.

During an AutoLoader run, the carousel is rotating as the chips are processed to 
introduce the next array to the scanner, so autorotation is not needed. After the 
AutoLoader run is complete the heater is turned off and the carousel is rotated to get 
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even cooling of the chips.

Terminating a scan run
The AutoLoader run will terminate under certain normal circumstances. Table 4 
outlines under what conditions a scan run will or will not terminate.
 

Troubleshooting Troubleshooting tips are given in the table below and in the following sections:

• ʺAutoLoader error messagesʺ on page 220
• ʺManually removing a lodged probe arrayʺ on page 222

Table 4   Summary of scan run termination conditions

The scan run will terminate if: The scan run will not terminate if:

You press the Stop button. Caution: If you 
stop the scanner while a probe array is in 
the process, you will lose all scan 
information from that probe array. If you 
rescan the array, it may be affected due to 
uneven photo-bleaching. This could 
potentially make the data from the array 
difficult to compare to other array data.

You check Allow Rescans box. When the AutoLoader encounters a probe 
array that was previously scanned in an earlier run, it will rescan that 
probe array and will create additional DAT files (DAT1, DAT2, etc.). 

The AutoLoader detects a probe array with 
the same barcode in the current run, i.e., in 
the currently loaded carousel. The probe 
array will not be rescanned.

You clear the Allow Rescans box. When the AutoLoader encounters a 
probe array that was previously scanned in an earlier run, it will log the 
probe array but will not rescan it. It will continue the run.

The AutoLoader detects 48 scanned 
cartridges in the same run. 

You click the Add Now button. The AutoLoader door will unlock to accept 
new probe array cartridges. The scan in progress will complete. When you 
close the door and continue, the AutoLoader will home, take inventory and 
move to the same probe array that was in the process of being scanned 
when the door was opened. It will discard the earlier DAT file and rescan 
that probe array. 

Note: this has nothing to do with the Allow Rescans check box.

You click the Add After Scan button. The AutoLoader door will wait until 
the scan in progress is complete then unlock the door. When you close the 
door and continue, the AutoLoader will home, take inventory and move to 
the next probe array from that which was in the process of being scanned 
when the door was opened. 

Problem Possible Cause Corrective Action

No image when scanning • Power off or cable loose Check all connections and power.

• Loss of laser power Contact technical support.

• Image display disabled Enable image display

Intermittent problems 
scanning

• Loose cable Check all rear connections.
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AutoLoader error messages
The following error messages indicate a serious malfunction of the scanner with 
AutoLoader. Your probe arrays, or the data generated from them, may be at risk. You 
should shut down the AutoLoader and remove the carousel. Do not continue to use the 
AutoLoader in Automode and call technical support. However, if the AutoLoader 
appears to be operating normally, you can continue to use the AutoLoader in Manual 
Mode. See ʺScanning a Probe Array in Manual Modeʺ on page 215.

Scanner fails with probe 
array inside

• Power failure Manually extract probe array. Check all 
connections to scanner. Turn scanner on, 
restart software.

Carousel does not 
automatically home

• Check for stuck array
• Carousel not seated on D ring
• Alignment Pin not engaged in 

Carousel
• Door is open or ajar
• Door is open when blue LED is off.

Carousel does not rotate • Door is open or ajar
• System is warming up, array in heater
• Carousel not seated on D ring
• Alignment Pin not engaged in 

Carousel
• Laser in Scanner is warming up. GCC 

has Start grayed out in this case

Carousel misses next array • Array UP sensor not working, call 
technical support.

Stuck array  See "Manually removing a lodged probe array" 
on page 222

AutoLoader freezes up • Door is open or ajar

AutoLoader overheats • Heater Failure
• TE failure
• TE hot fans vent blocked

Call technical support.

Call technical support.

Autofocus routine fails to 
conclude 

• Try to rescan array.   
• Check for salt on chrome border. If still error, 

call technical support.

The array does not descend 
into scanner.

• Carousel not seated correctly
• Door is open or ajar
• Heater is waiting until array is at 

temperature.

Problem Possible Cause Corrective Action
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E-mail messages
If the e-mail system is enabled, the instrument control software sends an e-mail alert 
for conditions that may occur during an AutoLoader run. 

Note: For information on enabling the email system see Appendix E, ʺNotification e-
mailsʺ on page 370

In case of a fatal error:

1. The software sends an e-mail to the specified set of e-mail addresses or to the 
Outlook distribution list.

2. The software provides you with the ability to send an e-mail without your 
intervention.

3. Each e-mail message contains the following information:
a. Date and Time
b. Scanner ID
c. All experiment information displayed in the status window. You select error 

messages to be sent in the e-mail configuration.

HEATER_LOW “Warning: The warming chamber temperature is low. Refer to the 
troubleshooting guide.”

COLD_CHAMBER_LOW “Warning: The cold chamber temperature is low. Refer to the troubleshooting 
guide.” 

COOL_HOTSIDE_HIGH “Warning: The cooler hot-side temperature is high. Refer to the troubleshooting 
guide.” 
Note: Before calling technical support, check around the ventilation vents to 
ensure that nothing is blocking them.

COLD_CHAMBER_HIGH “Warning: The cold chamber temperature is high. Refer to the troubleshooting 
guide.”
Note: Before calling technical support, check the AutoLoader door to ensure 
that it is not open.

HEATER_HIGH “Warning: The warming chamber temperature is high. Refer to the 
troubleshooting guide.”
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Manually removing a lodged probe array

In the event that a probe array becomes lodged in the array transport mechanism, 
follow the procedure outlined below.

1. Turn the AutoLoader off and remove the power cord from the back of the unit.
2. Open the AutoLoader door on top of the unit. 
3. Remove the carousel from the system. (Keep cartridges in carousel at proper 

temperature while recovering the array still in the scanner).
4. Remove the hole plug, which is just in front of the array slot in the base piece of 

insulation. In Figure 257, the screwdriver is inserted into this hole.

5. Using a standard, flat (-) screwdriver, (13-0257) gently slide it down through the 
hole making sure not to damage the shaft and spring that are protruding into the 
hole. When the screwdriver stops, it should be in contact with the scanner Y stage 
screw. Slowly turn the screwdriver until you feel it engaging the slot on the screw 
of the scanner Y stage.

6. Slowly turn the screw clockwise until it hits a hard stop and cannot turn further. 
(Do not try to turn it further or use excessive force because it will break the Y stage 
in the scanner). The Y stage has now ascended to its maximum position.

Figure 257   Locating the rescue hole
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7. Using your fingers, slowly slide the slot pin, which is sticking through the slot in 
the base piece of insulation, to the right until it stops. You should see the little 
pinch rollers near the array slot close a little as you do this. (Figure 258)

8. Insert a 3/16” hex driver (13-0255) into the hole that is located on the front of the 
AutoLoader housing on the left. You should feel it engage a coupling. 
(Figure 259)

Figure 258   Pinch rollers and slot pin
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9. Turn the hex driver counter clock wise until you see the array appear through its 
opening. (The array should stay up if you stop turning the hex driver). If you 
donʹt see the array after turning the hex driver ten seconds go to step 11.

10. Grab and hold the array with your fingers. Using your other hand slowly slide 
the slot pin (Step 7) back to the left. This should open up the pinch rollers. Pull the 
array out. 
If you do not see the array after turning the hex driver for 10 seconds, stop. 

11. Using tool (13-0256) (Figure 260) with the hook down and toward the back, slide 
it vertically down against the front of the array opening, about 1.5 inches. (There 
is a small groove made for this tool in the middle of the front array guide).

Figure 259   Finding the coupling

Figure 260   
Tool
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12. Pull the top finger grip of the tool toward the front of the unit, and then pull it up 
while still putting pressure towards the front. The array should come up with the 
tool. When you see it, grab the array and pull it out of the unit. 
If you cannot get the array out after doing this procedure, call technical support.

13. Put the hole plug back into the hole in the base piece of insulation.
14. Plug the scanner back in and turn it on.
15. Load the carousel after the scanner boots up.

If cartridges continue to become lodged in the AutoLoader, you should call 
technical support
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GCS3000 with AutoLoader specification

GCS3000 with AutoLoader Specification Table

Table 5   Item Table 6   Parameter Table 7   Value

Weight Shipping approx 115 pounds 
(52.2 Kg)

Free-standing approx 100 pounds 
(45.4 Kg)

Dimensions Width ~13.25 in. 

Depth ~21.25 in.

Height ~32 in. 

Power Voltage
Current
Line Frequency.

100 - 240 V ~
4 - 2 A
50 - 60 Hz

Working Environment Temperature 59°F-85°F (15°C-
30°C)

Humidity 10-90% Non-
condensing

Clearance 2 in. (5 cm) on side, 
back 
12.5 in. on top

Pollution Degree 2

Installation Category II

Altitude <2000m

Electrical Supply Provide voltage, frequency or power rating per 
unit label

Main Supply Voltage 
Fluctuations

Are not to exceed ±10% of the nominal supply 
voltage
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Regulatory This device complies with Part 15 of FCC Rules (Table 8). Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and (2) 
This device must accept any interference received, including interference that may 
cause undesired operation.

This device complies with FDA performance standards for laser products except for 
deviations pursuant to Laser Notice No. 50, dated June 24, 2007.

This Class A digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulation.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur 
le matériel broullier du Canada.

Table 8   Regulatory Certifications  

Regulatory Agency Certification

Class 1 Laser Device Complies with EN 60825-1:2007

Complies with FDA performance standards 
for laser products except for deviations 
pursuant to Laser Notice No. 50, dated June 
24, 2007

Hand held barcode 
reader is a Class 2 laser 
device

Complies with EN 60825-1:2007
Complies with FDA performance standards 
for laser products except for deviations 
pursuant to Laser Notice No. 50, dated June 
24, 2007

Compliant with directive 2002/96/EC (WEEE)
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The GeneTitan MC instrument array plates need to be run through the following steps 
(within the array plate processing workflow), as shown in Figure 261.

• Hybridization
• Washing and Staining
• Imaging

Figure 261   Recommended Array Plate Processing Workflow for GeneTitan System

GeneTitan Array Plate 

Processing Workflow Steps

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Fluidics on 
array plate

Image arrays on array plate and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Step performed using:

GCC Portal

 GCC Viewer

Thermo Fisher Scientific 
and/or Third Party 
DataAnalysis Software

 GCC GeneTitan MC Control

Hybridize Array Plate 
and Sample
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GeneTitan array plates are processed using the GeneTitan Multi-Channel (MC) 
instrument, for genotyping and expression array plates.

There are differences in the workflows for genotyping array plates and expression 
array plates. This chapter describes the functions of GeneTitan Instrument Control that 
are common to both genotyping and expression array plates:

• ʺGCC GeneTitan instrument control softwareʺ
• ʺGCC GeneTitan scannerʺ
• ʺThe GeneTitan MC instrumentʺ
• ʺOverview of the GeneTitan workflowʺ
• ʺTracking the array plate through the workflowʺ
• ʺAborting a runʺ
• ʺUnload platesʺ
• ʺUsing the wash-scan-resume workflowʺ
• ʺUsing the wash only workflowʺ
• ʺDrop and scan with array platesʺ
• ʺInsufficient disk space noticeʺ
• ʺResetting the lamp life clockʺ
• ʺComputer practices, maintenance and troubleshootingʺ

Information specific to Expression Arrays is given in the Expression Assay Manuals.

Information specific to genotyping array plates is given in Axiom Genotyping Assay 
User Guide (P/N 702830).

See the GeneTitan Multi-Channel Instrument User’s Guide (PN 08-0308) for a a 
detailed description of the instrument itself.
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GCC GeneTitan instrument control software

The GCC GeneTitan Instrument Control software is used to control the GeneTitan 
Instruments.

Note: A computer used as a GeneTitan workstation requires a user account with 
specific privilege settings. In addition, some of the other features of Windows 10 
Enterprise 2016 LTSB must be set up in particular ways or disabled to avoid causing 
problems when running GeneTitan IC software. The workstation is initially set up for 
use with GeneTitan has a default user account with these privileges and features 
already set.

To start the GCC GeneTitan Instrument Control software:

1. Click the GCC GeneTitan Instrument Control icon  in the GCC Launcher. 
or 
Click the Start → Thermo Fisher Scientific → Command Console GCC 
GeneTitan Control.
The GCC GeneTitan Instrument Control window opens. 
See Figure 262 for 96 array plate GCC GeneTitan Instrument Control window 
example.

IMPORTANT!  If the GeneTitan workstation becomes unstable during a workflow the cost of an 
aborted workflow and replacement plates is substantial. To avoid this, it is recommended you
Rebooting the instrument control computer weekly and follow the procedures described in 
"Computer practices, maintenance and troubleshooting".
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The software goes through the initialization process and starts the GeneTitan 
instrument.
You can track the initialization process in the Hybridization Oven Status pane 
(Figure 263). 
After the initialization is completed, System Ready is displayed in the log, 
and you can display the Setup tab.

Figure 262   System Status window tab
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The following notices may appear:

• Lamp Life setting (see ʺResetting the lamp life clockʺ)
• Insufficient Disk Space (See ʺInsufficient disk space noticeʺ)

Software components
• Menu bar: Provides access to IC functions.

• Tool bar: Provides buttons to access frequently used functions.

• System Setup/System Status tabs: 

– ʺSystem status window tabʺ: Use to track the progress of array plates through 
the workflow.

– ʺSystem setup window tabʺ: Use to set up the GeneTitan Instrument for 
different workflows.

• Status bar and Progress bar: Displays information about the status of the 
GeneTitan Instrument and the workflow in progress.

Figure 263   Hyb Oven log with System Ready 
notice
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Tool bar buttons
The Stop button is used to abort the array process. If there are two or more plates 
running in the instrument, the software will prompt you to select which process is to 
be aborted. See ʺAborting a runʺ.

The Email button opens the GCC Email Configuration File Editor, which enables you 
to send email messages about the instrument status. See Appendix E, ʺNotification e-
mailsʺ for more information.

The Help button opens the GCC Online help file. 

System status window tab
The System Status window tab (Figure 264) displays the progress of any currently 
loaded array plate(s) and features the following sections:

• Workflow
• Hybridization Oven Status
• Fluidics Status
• Imaging Device Status

The System Status tab is described in more detail in ʺTracking the array plate through 
the workflowʺ.

Figure 264   System Status window tab
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System setup window tab
The System Setup tab is used to:

• Specify the type of workflow you want to perform.
• Enter a barcode for the array plate being processed.
• Unload and load trays and plates.
• Select arrays on the array plate for imaging.
• Upload data results to the Thermo Fisher Cloud.

The System Setup window tab features four panes/sections:

• System Setup: Use to enter essential information and track progress of the setup 
and loading of the array plate and trays.

• System Layout: Indicates the drawers where different trays and array plates 
should be loaded. Note: The system layout changes based on whether 
Genotyping or Expression arrays are being processed.

• Array Selection: Enables you to select individual arrays on the array plate for 
imaging.

• Thermo Fisher Cloud Settings: Upload data results to the Thermo Fisher Cloud.

Figure 265   System Setup window tab for genotyping array plates
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System setup

The Setup Option pane (Figure 266) has the following controls and displays:

Figure 266   Setup Option pane
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System layout
The System Layout pane (Figure 267) displays:

• Schematic view of the drawers to be loaded
• Indication of plate/tray position in drawer

Note: Different reagent trays are loaded when processing genotyping array plates 
and expression array plates. The correct trays are selected for display when the 
array barcode is entered, as shown in the figure below.

Setup Options 
[drop-down meu]

Select from the following workflow options:
• Hyb-Wash-Scan
• Hyb-Wash
• Wash-Scan
• Wash-Scan-Resume
• Wash Only
• Scan
• Unload Plates
See "Running a series of array plates" for more information.

Plate Information

 Barcode Barcode of the array plate.

 Plate Type Array Plate type.

 Protocol Name Name of protocol used for array plate processing.

 Location Side of drawer to load consumables.

Workflow Steps Lists the steps to be performed during the operation.

Status Displays information on the specific step to be performed, with 
• The plates and trays that need to be removed or placed.
• The drawer position the plates and trays should be place in.

Cancel Cancels the setup.

Next Proceeds to the next step (not displayed when performing a step that 
requires you to press the Confirmation button on the front of the 
instrument.
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Figure 267   System Layout pane for genotyping (96 and 384) and expression arrays (96 only)

For genotyping arrays (96) For expression arrays (96)For genotyping arrays (384)

IMPORTANT!  When running a series of array plates through the instrument, you must be 
careful to remove and load the proper array plate and trays and pay careful attention to the 
software prompts that tell you which side of the open drawer to remove or place a plate or tray.
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Array selection

The Array Selection pane (Figure 268) displays the arrays to be scanned on the array 
plate:

• Manual array selection check box
• Plate Layout indicator, where you can:

– Review the arrays available on the array plate.
– Determine which are to be scanned.
– Manually select arrays to be scanned on the plate. Note: By default, all arrays 

are selected for imaging.

The array selection process is described in the instructions for loading array plates in:

• Expression Assay Manuals
• Axiom Genotyping Assay User Guide (P/N 702830)

Figure 268   Array Selection (96- and 384-Array Plate layouts shown)
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GCC GeneTitan scanner

1. Click Start →Thermo Fisher Scientific → GCC Launcher or double-click the 
GCC Launcher shortcut on the desktop.
The Launcher window appears. (Figure 269)

Command Console
• GCC Portal (See ʺGCC portal home pageʺ)
• GCC Viewer (See Chapter 9, ʺUsing the GCC viewerʺ)
• GCC GeneTitan Scanner (See ʺLaunching the scannerʺ)

Tools
• Thermo Fisher Cloud Administration (See ʺMonitoring an instrument 

remotelyʺ)
• GeneTitan Library File Installer (See Appendix D, ʺInstalling library files and 

scriptsʺ)
• Email Configuration Editor (See Appendix E, ʺNotification e-mailsʺ)
• Data Uploader (See ʺScheduling auto-uploadsʺ)

Figure 269   GCC Launcher menu - 
GCC Standalone Scanner Control
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Resources
• thermofisher.com (Home page)
• Support at thermofisher.com (Services and support page)
• NetAffx (Home page)

Launching the 
scanner

1. Click GCC GeneTitan Scanner.
The following window appears. (Figure 270)

GeneTitan Scanner window options

• Menu bar: Provides access to the scanner functions.
• Tool bar: Provides the following buttons:

–  = Start: Starts the scan process.

–  = Load: Loads the plate into the scanner.

–  = Stop: Aborts a scan in process.

–  = Email: Opens the GCC Email Configuration File Editor. See Appendix E, 
ʺNotification e-mailsʺ for more information.

–  = Help: Opens on-line help.

• Barcode: Displays the barcode of the plate.
• Lamp Life Remaining: Remaining lamp life hours. 
• Time Remaining: Time remaining until the plate is fully processed and complete.

Figure 270   GeneTitan Scanner - Main window
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• Status and Progress bars: Displays status of the GeneTitan instrument and the 
workflow in progress.

Using the scanner 1. Click the Start button.
After a few moments, its side door opens and a drawer slides out. (Figure 271)

A message appears (lower right) prompting you to place the plate onto the 
drawer.

2. Place the plate on the drawer making sure its orientation is correct (Figure 272) 
and the drawer’s pegs match up correctly with the plate’s bottom peg holes.

3. After placing the array plate onto the drawer (Figure 273), click the Load button.

Figure 271   Scanner drawer

Figure 272   Plate to drawer orientation
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The drawer retracts back into the scanner and the side door closes. After a few 
moments the barcode is detected and array pane populates, as shown in 
Figure 274.

Figure 273   Scanner drawer

Figure 274   Populated System Setup pane
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Note: The following notices may appear:

– Lamp Life setting (refer toʺResetting the lamp life clockʺ)
– Insufficient Disk Space (refer to ʺInsufficient disk space noticeʺ)

4. Click to select the wells you want to scan, as the Manual Array Selection check 
box is checked by default. 

5. Optional: If you want to have your scanned data uploaded to the Thermo Fisher 
Cloud, click the Connect To Cloud check box now.

6. Click the Start button.
A message appears confirming if you want to continue.

7. Click OK to acknowledge the message.
After several minutes, the GeneTitan Scanner window populates, as shown 
Figure 275. 

IMPORTANT!  You cannot add a user(s) from the GCC Launcher → Thermo Fisher Cloud 
Administration window (page 36) while the scanner application is open. 

Figure 275   GeneTitan Scanner - populated example
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Thermo Fisher cloud settings (optional)

Do the following to upload your completed data to your Thermo Fisher Cloud account:

1. Click to check the Connect To Cloud check box.
2. From the drop-down list, select a Thermo Fisher Cloud User.
3. Select a Cloud upload option.

– Move - Uploads your files to the cloud. CEL and JPG files are removed from 
your local drive, while copies of ARR, DAT, and AUDIT files are retained. 
(Recommended)

– Copy - ARR, JPG, CEL, and AUDIT files are copied and uploaded to the cloud. 
The original files remain on your local drive.

4. Enter a name for your Cloud folder.
5. Click Next.

Your newly uploaded folder and data now resides on your cloud account’s Data 
Connect web page (left pane/folder view), as shown in ʺUsing the cloud to share 
data resultsʺ.

IMPORTANT!  To use this option, you must have a Thermo Fisher Cloud account. To register, see 
"Creating a cloud account".

Make sure you have added the appropriate user account(s), as detailed in "Adding users".

Thermo Fisher Cloud Settings are not applicable for the data registered on network data roots.

Figure 276   Thermo Fisher Cloud Settings pane
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The GeneTitan MC instrument

Overview The GeneTitan MC instrument is designed to serve medium to high throughput 
customers. This system supports 16, 24, and 96-format high throughput array plates 
and will support future array plate formats. The system integrates a hybridization 
oven, a fluidics station, and an imaging device.

Refer to the GeneTitan Instrument User Guide (P/N 08-0296) for more information.

GeneTitan Multi-
Channel (MC) 
instrument

The GeneTitan MC Instrument can process both Expression Arrays and Axiom Assay. 
The instrument uses an external 300W Xenon lamp and has multiple filters to provide 
stable, efficient, well-collimated, uniform illumination to the array, optimizing 
exposure time to minimize photo-bleaching effects and maximize throughput. 

GeneTitan MC 
instrument controls 
and indicator lights

The figure below shows the location of the wash bottles, loading drawers, and other 
controls for the GeneTitan MC instrument. 

Figure 277   GeneTitan MC Instrument
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igure 278   GeneTitan Instrument

1. Input/Output Drawer #1
2. Input/Output Drawer #2
3. Input/Output Drawer #3
4. Input/Output Drawer #4
5. Input/Output Drawer #5
6. Input/Output Drawer #6

13. Trash Bin Door for 
       Waste Chute

. Waste Bottle

9. Wash A Bottle

10. Wash B Bottle
11. Rinse Bottle (DI Water)

12. Fluidics Station

1

2

5

4

3

6

 Imaging Device14.

7. Confirmation Button (to open/close drawers)

WARNING!  The bottles are pressurized in normal operation. Wait until you see the prompt 
that the buffer bottles have been de-pressurized before opening and refilling or emptying the 
bottles.
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The GeneTitan Instrument uses the indicator lights and button below (Figure 279).

Confirmation button: Press after completing certain steps for instrument setup, like 
adding fluids or adding trays and plates.

The button flashes blue when a step is pending.

Instrument Status lights:

• Solid yellow - initialing/homing system
• Solid Green - processing/available to process
• Blinking green - normal operation message box is displayed and requires user 

input
• Blinking yellow - abnormal event informational message box requires user 

response
All power to the instrument is turned on when the GCC GeneTitan Control software 
is started and turned off when the software is shut down. The I/O switch on the front 
of the instrument is inoperative when the instrument is being controlled using the 
software.

Refer to the GeneTitan MultiChannel Instrument User Guide (P/N 08-0305) for more 
information.

Figure 279   GeneTitan Instrument controls and lights.

I/O Button

Imaging Device
Status Light (Yellow)

Imaging Device
Status Light (Green)

3.

4.

5.

Status (Green)
2. Instrument

GeneTitan™Plate
Confirmation Button
(to open/close drawers)

1.

IMPORTANT!  Do not make use of I/O switch on instrument panel to start/stop instrument. Use 
the menu item in the software.
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Overview of the GeneTitan workflow

Running an array plate through the GeneTitan workflow involves the following sets of 
steps:

1. Set up the Instrument:
a. Prepare plates and trays with samples and solutions, including buffer 

solutions.
b. Select type of workflow to be performed.
c. Select the Protocol, if required.
d. Refill Bottles.

e. Remove used trays, plates and covers from the instrument.
2. Load new trays, plates and covers.

There are different procedures for the different array and workflow types:
• Expression Assay manuals
• Axiom Genome Wide Human Assay User Manual (P/N 702830)

3. Begin Array processing and track the array plate through the workflow.
4. Empty the instrument.

You can:

• Select only part of the overall processing workflow to run (see ʺWorkflow 
optionsʺ)

• Run a series of array plates through the workflow for high-throughput operation 
(see ʺRunning a series of array platesʺ)

Workflow options There are three sets of steps performed by the GeneTitan Instrument for array plate 
processing:

• Hybridization
• Wash and Stain
• Imaging (Scan)

The software enables you to perform all of these steps, or to select an option that runs 
only some of the steps, as described below.

You can choose from:

• Hyb-Wash-Scan
This workflow performs all the steps on the array being processed.
– Hybridization
– Wash and Stain
– Scan

• Hyb-Wash
The Hyb-Wash workflow enables you to bypass the Scan step, performing only:
– Hybridization
– Wash and Stain

• Wash-Scan

IMPORTANT!  Once bottles are refilled, ensure that bottle caps are on tight.
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The Wash-Scan workflow enables you to bypass the Hybridization step, 
performing only:
– Wash and Stain
– Scan

• Wash-Scan-Resume
This enables you to resume an interrupted workflow at any point in the Wash 
stage. See ʺUsing the wash-scan-resume workflowʺ.

• Scan
The Scan workflow performs the scan only.

Selecting different workflows

Selecting the different workflows may require loading the array plate on a different 
tray (array plate cover, hybridization tray, or scan tray). In addition, there are 
differences in how the workflows are performed on genotyping arrays and expression 
arrays.

These differences are detailed in:

• Expression Assay manuals
• Axiom Genotyping Assay User Guide (P/N 702830)

Differences in 
processing for 
genotyping and 
expression arrays

There are two types of Array Plates that can be processed using the GeneTitan 
instruments

• Genotyping array plates
• Expression array plates

Genotyping array plates
Genotyping Array Plates can be processed only on GeneTitan MC instruments, since 
they need to be scanned at two different wavelengths.

For genotyping arrays, the reagents trays need to be loaded twenty-four hours after the 
array plate and hybridization tray have been loaded, after hybridization has 
completed.

Needed reagents trays are:

• 2 each Stain1 trays with covers
• Ligation tray with cover
• Stain 2 tray with cover

Figure 280   Selecting workflow
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• Stabilizing tray with cover
• Scan tray with holding buffer and cover

See the Axiom Genotyping Assay User Guide (P/N 702830), for more information on 
running genotyping array plates.

Expression array plates
Expression Array plates can be processed on a GeneTitan MC instrument.

Needed trays/reagents are:

• SAPE 1 Stain tray with cover
• AB Stain Tray with cover
• SAPE 2 Stain tray with cover
• Scan tray with holding buffer and cover

See the Expression Assay manuals for more information.

Running a series of 
array plates

The GeneTitan Instrument can run two different workflows for the same probe array 
type at the same time. This enables you:

• To load a series of array plates with hyb trays and consumables for the Hyb-
Wash-Scan workflow to process arrays more quickly.

• To run an array plate that was processed using a different system through the 
scan workflow while another array plate is going through earlier stages of the 
Hyb-Wash-Scan workflow.

Only certain types of workflows can be run at the same time, and delays may be 
necessary before starting the second workflow. These restrictions exist because an 
array plate should be scanned immediately after the wash and stain processing is 
finished, and GeneTitan scans one array plate at a time. In addition, there are 
restrictions caused by the differences in workflows for Axiom arrays and Expression 
arrays, and by differences in the number of arrays on the plates. For more information, 
see:

• Expression Assay manuals
• Axiom Genotyping Assay User Guide (P/N 702830)
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Tracking the array plate through the workflow

You can review the progress of the Workflow in the System Status tab. (Figure 281)

It has the following sections:

• ʺWorkflow statusʺ
• ʺHybridization statusʺ
• ʺFluidics statusʺ
• ʺImaging device statusʺ

Figure 281   GCC GeneTitan Control software, System Status Tab
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Workflow status The Workflow pane provides an overview of the array processing. (Figure 282)

The Work Flow table lists the array plates and their status in the workflow, with the 
following information:

• Barcode of array plates being processed
• Plate Type
• Location
• Hyb. Status
• Fluidics Status
• Scan Status
• Estimated Completion Time

Note: If more than three arrays are loaded at a time, a scroll bar appears at the 
right side of the table.

The Estimated Time Window information on when the next hyb-wash-scan workflow 
can be run

• Array Type
Note: You cannot select a different array type for the next array to be run.

]

• Time when you can load the next array plate and other consumables.
Note: When processing genotyping Arrays, once processing begins you have a 
specified period of time during which you can load another Array Plate and hyb 
tray. You cannot load another array plate before or after this period of time.

Figure 282   Workflow pane
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Hybridization status The Hybridization Status pane displays details of the hybridization operations that 
have been run. The pane can display information for two array plates that are being 
processed at the same time.

The pane displays the following information:

• Position 1
– Barcode of the array plate(s) being processed
– Time Remaining

• Position 2
– Barcode
– Time Remaining

• Oven Temperature
– Current. 
– Yellow: Out of range
– Green: In range
– Target

• Log 
– Displays history of the operations performed in the Hybridization stage.

Figure 283   Hyb Oven Status
GeneChip™ Command Console™ (GCC) User Guide 253



Chapter 8 Controlling the instruments
Tracking the array plate through the workflow 8
Fluidics status The Fluidics Status window (Figure 284) displays information on the wash and stain 
operations that have been run or are currently being run.

The Fluidics Status window displays the following information:

• Barcode of the array plate being processed
• Protocol Name
• Time Remaining
• Temperature for the protocol step

– Current
– Yellow: Out of range
– Green: In range
– Target

• Protocol tab:
Displays list of steps in the protocol with:
– Step
– Task: short description of the task
– Time
– Status: Task pending, in process, or completed?

• Log tab 
– Displays history of the operations performed in the Fluidics stage.

Figure 284   Fluidics Status
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Imaging device 
status

The Imaging Device Status pane (Figure 285) displays the progress of the scan.

The Imaging Device Status window displays:

• Barcode of the array plate currently being scanned
• Time Remaining for scan
• Lamp Life/Imaging Device Status (see ̋ Lamp Life/Imaging device status noticesʺ, 

below, for details)
• Plate Status tab with:

– Array Plate Layout
Each square represents an array with the following options:

• Log: displays history of the operations performed in the Fluidics stage.

Figure 285   Imaging Device Status

 (Dark blue) To be scanned

 (Light blue) Now imaging

 (White) Not to be scanned

 (Green Scan completed

 (Red) Scan failed
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Lamp Life/Imaging device status notices
The Imaging Status pane displays lamp life and Imaging Device status notices for the 
GeneTitan MC.

In normal operation, the pane displays the hours of life left in the lamp:

It displays a red or yellow notice when the lamp life is getting short:

It also displays a red notice when the Imaging Device is offline:

Note: The 300 Watt Xenon lamp in the GeneTitan MC instrument is warranted for 
500 hours. To replace the lamp refer to the instructions in the GeneTitan 
instrument manual. After changing the lamp, it is necessary to reset the lamp life 
clock manually. For more information about the clock, see ̋ Resetting the lamp life 
clockʺ.

Figure 286   Lamp Life above tolerance

Figure 287   Lamp Life above tolerance

Figure 288   Imaging Device Offline
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Aborting a run

If necessary, you can abort a run in progress.

For information on aborting a run because of facility power loss, see ʺFacility power 
lossʺ on page 258.

To abort a run:

1. Click the Stop  button in the tool bar.
The Abort dialog box opens. (Figure 289)

The Abort DB has the following components:
• Plates Being Processed List with the following columns:

• Select check box
• Barcode
• Plate Type
• Location

• Current Step: explains the next step in the procedure.
• Abort and Cancel buttons.

2. Click the Select check box for the plate whose run you want to abort.
3. Click Abort.

The software asks for confirmation.

IMPORTANT!  If you want to abort a run while loading reagents for a genotyping array plate, you 
must use the Cancel button in the tool bar. During reagent load the abort function will not be 
available for the plate for which reagent trays are being loaded.

Figure 289   Abort dialog box
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Click Yes to continue with the Abort process.
Note: The abort process may take some time to complete. Wait until it is finished 
before trying to perform any other operations.

When abort is completed, you can see the notice in the Status tab (Figure 291).

If the array plate is in the Hyb Oven, it is placed in Drawer Number 1
If the array plate is in Fluidics when the abort is ordered, it is placed in the Scan 
tray.
You will need to unload the loaded plates and trays in a second step, using the 
Unload function or the unload steps during a setup.

Facility power loss If facility power is lost and the UPS backup power battery percent remaining drops 
below 75%, the software will automatically abort all running plates. This automatic 
abort is intended to protect the plates by bringing all running plates out to the drawers 
for removal. However, if the user is in the setup tab performing setup steps (loading 
the machine) the software is prevented from performing the required abort sequence. 

If facility power is lost and the user is notified that the UPS power percent remaining 
drops below 75%, the user should cancel the loading operation to initiate the abort 
sequence. 

To cancel the loading operation and setup:
• Select Cancel in the system setup tab.

Figure 290   Abort 
Confirmation

Figure 291   Abort notice in Workflow pane
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Unload plates

The Unload Plates function can be used to empty the GeneTitan drawers after 
performing an abort operation.

To unload loaded plates:

1. Select Unload Plates from the Setup Option drop-down list. (Figure 292)

The application prompts you to empty the cover trash bin.

2. Perform the following steps:
a. Open the trash bin door.
b. Remove and empty the trash bin.
c. Return the trash bin and close the door.

3. Press the Confirmation button to proceed.
The application prompts you to unload previously loaded plates and trays. 
For each loaded plate or tray:
• The appropriate drawer opens (Figure 293).

Figure 292   Selecting workflow
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• The status box prompts you to remove the tray or plate and the system layout 
indicates the array or tray to remove. (Figure 294)

Figure 293   Unloading solution trays from Drawer #5

IMPORTANT!  When running a series of array plates through the GeneTitan Instrument, you 
must be careful to remove and load the proper array plate and trays and pay careful attention to 
the software prompts that tell you which side of the open drawer to remove or place a plate or tray.
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Remove any plate, plate receptacle, or tray from the drawer (Figure 294), then 
press the Confirmation button on the front of the instrument.

When you have finished emptying the old plates and trays, the software prompts 
you to proceed to the next step.

Figure 294   Unload tray(s)

Plate/tray position and status indicators
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Using the wash-scan-resume workflow

The Wash-Scan-Resume can be used to resume an interrupted workflow on an array 
plate.

The Abort process places the Array Plate on the Scan Tray. Note: You must manually 
place the array on a blue tray before resuming the workflow.

Applied Biosystems recommends using a new scan tray for the resumed workflow.

To resume an interrupted workflow:

1. Select Wash-Scan-Resume in the setup process.

2. Enter the barcode for the interrupted array.
The Resume Plate dialog box appears.

The

The Resume Plate dialog box lists:
• Plate barcode
• Protocol that had been selected to run the array.
• Step where the process needs to be resumed.

3. Click Yes to proceed with the resume.
The ResumeStep dialog box opens.

Figure 295   Select Option--Wash-Scan-Resume

Figure 296   Resume Plate dialog box
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The Steps drop-down list displays the uncompleted steps. 

The list of unfinished steps are different for:
• Expression arrays versus Genotyping Arrays
• Arrays interrupted in different parts of the workflow

4. Select the step in the workflow where you want to resume.
Note: If you have performed certain steps off-line, you need to skip these steps in 
the workflow.

5. Enter the time you want to run the first step in the Time to Process box.
You cannot change the processing time for certain steps, and cannot set the time 
to longer than the protocol specifies.

6. Click OK to resume the workflow.
7. Follow the instructions in the software steps for loading the array and trays.

You must load the array plate on a blue array base.

Figure 297   ResumeStep dialog box

Figure 298   List of unfinished steps
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Thermo Fisher Scientific recommends using a new scan tray for the resumed 
workflow.
You must load all the trays for the original workflow; if you know you are going 
to skip a particular step, you can load an empty tray in the designated location for 
that step.

Using the wash only workflow

1. From the Setup Option drop-down menu, select Wash.

2. Click Next (bottom left).
The Barcode text field is enabled.

3. Enter a barcode.
4. Click Next.

The Workflow Steps pane populates, as shown in Figure 301.

Figure 299   Array Plate with blue base

Figure 300   Select Option- Wash
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5. From the Protocol Name drop-down, select an appropriate protocol.
6. Click Next. 

After a few moments, a Start Processing confirmation window appears. 
(Figure 302)

7. Click OK.
The Wash workflow begins. 
Note: Monitor the Status pane as it continually updates the workflow’s progress. 
Click Next when prompted. Completed workflow steps are highlighted in blue.

Drop and scan with array plates

While you can register an array plate and its arrays using the GCC Portal GeneTitan 
Array Plate Registration before processing, you can also process an array plate that has 
not been registered by using the Drop and Scan feature for array plates. When using 
Drop and Scan, the ARR, DAT, and CEL files for each array are named using the 
barcode and array position.

See ʺGeneTitan array plate registrationʺ on page 139 for more information about 
registering an array plate.

To use Drop and Scan:

1. Set up and load the GeneTitan Instrument as required for the workflow you are 
performing.

2. Process the array plate.

Figure 301   Workflow Steps

Figure 302   Start Processing confirmation
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If the array plate has a valid barcode, it is processed and scanned. The ARR, DAT, 
and CEL files for each array are named using the barcode and array position and 
placed in the designated Default folder.
For more information about the Default folder, see:
• ʺDefault foldersʺ
• ʺSpecifying a default folderʺ
If the instrument cannot read the barcode, or if there are no library files on the 
system for array plates with that part number, the array plate is ejected and an 
error notice appears. 

Insufficient disk space notice

If there is not enough memory on the computer’s drives to save the data from an array 
plate, a notice appears when:

• You first initialize the software and instrument
• You select arrays for imaging.

If you see this notice, you will need to free up sufficient disk space before imaging 
starts.

Figure 303   Insufficient Disk Space Notice
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Resetting the lamp life clock

Note: The following resetting instructions can be used for either the GeneTitan or 
GeneTitan Scanner instrument.

The GeneTitan uses a xenon arc lamp system to provide illumination for imaging the 
array at two wavelengths. The xenon lamp has a limited lifetime and needs to be 
replaced at regular intervals.

The GeneTitan Instrument Control software provides a timer that indicates the 
remaining useful light of the bulb and notifies you when it requires replacement. 

The replacement procedure is described in the GeneTitan Instrument User Guide 
(P/N 08-0296). After replacing the bulb, you will need to reset the time, as described 
below.

If life of bulb is under a specified limit, the following notice appears  (Figure 304) when 
you launch the software:

If you click OK, the confirmation notice appears. (Figure 305)

Click Yes to reset the lamp life timer to the specified time.

Click No to cancel.

Figure 304   Lamp Life Management notice

Figure 305   Reset dialog box
GeneChip™ Command Console™ (GCC) User Guide 267



Chapter 8 Controlling the instruments
Computer practices, maintenance and troubleshooting 8
Computer practices, maintenance and troubleshooting

If the GeneTitan workstation becomes unstable during a workflow the cost of an 
aborted workflow and replacement plates is substantial. To avoid this Applied 
Biosystems recommends following certain computer operation practices and 
preventative maintenance routines.

These are described in:

• ʺComputer operation practicesʺ
• ʺPreventative maintenanceʺ
• ʺTroubleshootingʺ
• ʺTroubleshootingʺ

Computer operation 
practices

The following computer operation practices are recommended to help prevent 
problems.

Hard drive 
For the instrument control system, it is recommended to keep all drives at a maximum 
of 50% full. If there is more data on the workstation, the system tends to slow down. If 
keeping data on the hard drives is absolutely necessary, the drives need to be 
defragmented regularly (ie: depending on the amount of data, every two weeks or 
monthly defragmentation is recommended).  

USB memory drives/memory stick
When USB drives or memory stick(s) are connected to the workstation, please properly 
disconnect them (safely remove hardware) before physically pulling them off.

Scanning plates
If the GeneTitan system is scanning a plate or running fluidics, try not to run any other 
applications while the instrument workstation is running.

Moving data (DAT, CEL, etc.)
When archiving data or moving data off the workstation, it is highly recommended to 
do this process when scanning or running fluidics is not in process. The scanning 
process is very slow if data is being moved at the same time.

Preventative 
maintenance

Optimizing your disk drive
The drive(s) on the GeneTitan workstation need to be optimized regularly (ie: 
depending on the amount of data, every two weeks or monthly optimization is 
recommended).

1. Click the Search/magnifying glass icon (lower right).
2. In the Search Window text box, type defrag.
3. Click on Defragment and Optimize Drives selection.

The Optimize Drives window appears.
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The window displays a list of drives with information about capacity and free 
space.

4. Select the disk you want to optimize.
5. Click Analyze.

The Analyze process runs.
When the analyzing process is complete, the status of your analyzed drive is 
displayed in the Current Status column.
Repeat steps 4-5 for each drive you want to optimize.

6. Close the Optimize Drives window.

Figure 306   Optimize Drives window
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Troubleshooting If the GeneTitan IC window and taskbar icon disappear
The GeneTitan IC window may disappear from the computer screen while, at the same 
time, the Taskbar icon for GeneTitan IC disappears. If this happens, restore the 
window and icon by doing one of the following.

Solution 1

1. Simultaneously press Ctrl/Alt/Delete keys.
The Windows Security dialog box appears.

2. Click Start Task Manager.
The Windows Task Manager window appears.

3. Click New Task...
The Create New Task dialog box appears. (Figure 307)

4. Enter explorer.exe and click OK.
The Task Bar should be displayed

5. Press the icon for GeneTitan in the task bar to display the GeneTitan window.
Note: The explorer.exe application must be running properly to display the 
Taskbar at the bottom of the screen. The above procedure will launch explorer.exe 
to re-display the Taskbar.

Solution 2

1. Simultaneously press the Alt and Tab keys
A list of icons for active applications appears.

2. Keep pressing the Alt key while tapping on the Tab key to select the window 
displaying GeneTitan.

3. When selected, release the Alt key.
The GeneTitan window re-appears.

Note: For more troubleshooting information, see the GeneTitan Instrument User 
Guide (P/N 08-0296) or GeneTitan Multi-Channel Instrument User Guide (P/N 08-
0305)

Figure 307   Create New Task dialog box
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After the array has been scanned, GCC:  (Figure 308)

• Aligns a grid on the Image (DAT) file to identify the probe cells.
• Computes the probe cell intensity data for the array and creates a CEL file.

The GCC Viewer displays DAT, CEL, and JPG files and enables you to:

• Track the progress of the data through grid alignment and cell intensity 
generation.

• View the files for quality control purposes, such as detecting scratches and 
bubbles.

• Check the grid alignment and realign the grid, if necessary.
See ʺChecking the grid alignmentʺ on page 313.

Figure 308   Array Processing Workflow

GCC  Array Processing 

Workflow

Register Sample(s) and Assign 
Arrays in Sample (ARR) files

Perform Wash and Stain operations on 
array(s) in Fluidics Station

Scan Probe Array and 
Save Image Data in DAT files

Review grid alignment and perform 
manual gridding if necessary

Analyze Cell Intensity Data and 
Generate Analysis Data in CHP files

Hybridize Array(s) and Sample (not 
performed by GCC for Cartridge Arrays)
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Note: Realigning the grids will update DAT headers and break the parent-child 
relationship between DAT files and existing CEL files until the CEL files are 
regenerated.

• Create a JPG version of a DAT file for archiving.
See ʺExporting images in other formatsʺ on page 324.

This chapter describes the operation of the GCC Viewer in the following sections:

• ʺArray and grid typesʺ, below
• ʺIntroduction to the viewerʺ on page 279
• ʺUsing the review windowʺ on page 286
• ʺOpening image filesʺ on page 292
• ʺUsing the review windowʺ on page 286
• ʺLearning about the image fileʺ on page 310
• ʺChecking the grid alignmentʺ on page 313
• ʺExporting images in other formatsʺ on page 324
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Array and grid types

The Alignment algorithm uses the checkerboard image of the control probes, located 
at the corners of the probe array, to superimpose a grid on the scan image. The 
algorithm aligns the grid so that each square in the grid delineates a probe cell.

The alignment of the grid and sub-grids usually takes place automatically after 
imaging the array. The status of the alignment can be tracked in the Review window. 
If the alignment algorithm fails you can perform a manual alignment of the main grid 
and/or sub-grids. 

Different types of arrays use different grid types, as described in:

• ʺCartridge arraysʺ
• ʺGeneTitan array platesʺ on page 275

Cartridge arrays Cartridge Arrays can use:

• Main Grid Only (Figure 309)

• Main Grid with multiple sub-grids (Figure 310)
The position of each sub-grid can be adjusted independent of the other sub-grids.

Figure 309   Array with a single grid
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Each sub-grid is identified by its row and column in the main grid. The corners of 
each sub-grid are marked on the array by specific alignment patterns; the anchors 
of the sub-grid are aligned to these patterns. (Figure 311)

Figure 310   Main grid with sub-grids
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The software uses the corner patterns at the four corners of the array to align the 
initial main grid. The main grid is then divided into smaller sub-grids. Each sub-
grid is aligned on the corner grid patterns in the final steps of the gridding 
algorithm and in manual alignment.

GeneTitan array 
plates

Plate Arrays use: 

• Sub-grids only without a main grid (Figure 312)
There are two different types of Genetitan array plates:

• ʺGeneTitan expression array platesʺ on page 276
• ʺGeneTitan genotyping array platesʺ on page 279

Figure 311   Corner pattern of a sub-grid
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GeneTitan expression array plates

An array plate can have up to 96 arrays (see ʺGeneTitan array plate registrationʺ 
on page 139 for more information).
Each plate array on the array plate has multiple sub-grids. Some arrays use a 7 x 
7 grid, for a total of 49 sub-grids, while other array types use a 7 x 6 grid, for a total 
of 42 sub-grids.
These sub-grids are similar to the sub-grids used for some cartridge arrays, but on 
a plate array the sub-grids are not aligned to a main grid.
In addition, the data for all the mini-DAT files is consolidated into a single DAT 
file. This DAT file can be viewed in the Image Viewer; the file has all the image 
and gridding data for each sub-grid and each exposure, and enables you to check 
the gridding independently for each exposure

Figure 312   GeneTitan Array DAT file
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The mini-CEL files for each exposure are merged into a single merged CEL file (.mgcel) 
(Figure 314), resulting in two merged CEL files per plate array.

The data in these two merged CEL files is then consolidated in a single CEL file, which 
is used for further analysis and can be viewed in the Image Viewer for QC purposes.

igure 313   Mini-DAT and mini-CEL files

Plate Array with subgrids

Relationship between plate arrays, Mini-DAT files, Mini-CEL files, and DAT files

 A plate array does not have a main grid, but 
has up to 49 independent subgrids.

The array is scanned twice with different exposure times. Each scan produces 
a mini-DAT file for each subgrid, for a total of up to 98 different mini-DAT files

The data from each exposure is used to determine the cell intensity data for 
each subgrid. This data is kept in a mini-CEL file. In this example, there would be 
98 mini-CEL files for an array, with two mini-CEL files for each subgrid.

The data for all the mini-DAT files is 
consolidated into a single DAT file. 
You can use the DAT file to view the 
individual subgrids for each exposure 
and to correct problems with 
Gridding

Mini-DAT files

Mini-CEL files
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The mini-DAT files, mini-CEL files and merged CEL files will be deleted during 
normal processing. If something goes wrong, you may find these file types in the target 
folder during a scan.

igure 314   Mini-CEL merge and consolidation.

Relationship between Mini-CEL, merged CEL, and CEL files

The data from each exposure is used to 
determine the cell intensity data for each 
subgrid. This data is kept in a mini-CEL file. In 
this example, there would be 98 mini-CEL files 
for an array, with two mini-CEL files for each 
subgrid.

The data for the two merged CEL files is 
consolidated into a single CEL file. The CEL file 
is used for further analysis, and can be viewed 
in the Image Viewer for QC purposes. 

Mini-CEL files

The mini-DAT, mini-CEL, and merged 
CEL files are deleted after the DAT and 
CEL files have been created.

CEL file

Merged CEL files

 First exposure

 First exposure

Second exposure

Second exposure

The mini-CEL data for each 
exposure is merged into a 
single merged CEL file, 
resulting in two merged CEL 
files for each plate array.
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GeneTitan genotyping array plates
GeneTitan genotyping array plates are handled similarly to the GeneTitan Expression 
arrays except that the arrays are scanned at two different wavelengths to support the 
two color assay. At each wavelength genotyping arrays are scanned at two different 
exposure times where signals from all four DAT files are integrated into a single DAT 
file to provide an expanded dynamic range.

Introduction to the viewer

You can learn more about the basic functions of the GCC Viewer in:

• ʺOpening the viewerʺ
• ʺFile display differencesʺ on page 280
• ʺMoving the components out of the viewerʺ on page 282
• ʺMoving the component borders in the GCC viewerʺ on page 285

Opening the viewer To start the GCC Viewer:
• In the GCC Launcher, click the GCC Viewer icon ; or

Click the Start → Thermo Fisher Scientific → GCC Viewer.
The viewer opens. (Figure 315)

Figure 315   GCC Viewer with no image displayed

Viewer tool bar

Viewer menu

Review window

Status bar
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The viewer has the following components when it first opens:

• Viewer menu
• Viewer tool bar
• Review window (optional) (see ʺUsing the review windowʺ on page 286)
• Status bar: displays cursor position and intensity of selected pixel/cell

Additional components are visible when a DAT or CEL file is displayed (Figure 316)

To learn about the Image window tool bar, see ʺChanging the display of the imageʺ on 
page 302.

To learn about the Properties box, see ʺLearning about the image fileʺ on page 310.

To learn about the Grid box, see ʺChecking the grid alignmentʺ on page 313.

File display 
differences

The GCC Viewer has different types of functions and options for the different image 
file types that it displays:

DAT files
DAT files are the image data files, the product of the initial scan.They are used to 
generate the cell intensity data file after the grid has been aligned.

The DAT file must be opened to perform manual gridding or to run the grid alignment 
algorithm in the GCC Viewer.

Figure 316   Parts of the GCC Viewer with DAT file displayed

Properties box

Grid box

Image window

Image window tool bar
Viewer tool bar

Viewer menu

Cursor position

Review window
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If the cell intensity data (CEL) file has been generated, you can click the Cell Intensity 
button  and view the cell intensity data in the DAT Image window.

GeneTitan expression array plate DAT file exposures
Each array is scanned twice, with different exposure times. The image data from both 
exposures are in the GeneTitan Array Plate DAT file. You can switch between the 
different exposures for checking the gridding, etc., by using the Exposure button (see 
ʺDisplaying different exposures (GeneTitan expression array plate DAT files only)ʺ on 
page 306).

GeneTitan MC Genotyping Array Plate DAT File Exposures
In GeneTitan MC each array is scanned twice, with different colors. The image data 
from both exposures are in the GeneTitan MC Array Plate DAT file. You can switch 
between the different exposures for checking the gridding, etc., by using the Exposure 
button (see ʺDisplaying different exposures (GeneTitan expression array plate DAT 
files only)ʺ on page 306).

CEL files
CEL files are cell intensity data files, produced using the DAT file data after gridding 
and feature extraction.

You cannot perform grid alignment or cell generation on a CEL file.

For certain types of probe arrays, failed control features in the array will be masked 
when viewing the cell intensity data (see ʺViewing failed control featuresʺ, below).

JPG files
JPG files are a copy of the DAT image in a standard image file format; they provide an 
image file with a reduced file size for QC inspection, archiving, and publication.

Viewing failed control features
For certain types of probe arrays, the cell intensity analysis also generates a Cell 
Summary Report. The report has information on the control features on the array that 
failed certain quality checks.

The failed control features are masked when viewing the cell intensity data in these 
cases (Figure 317).
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See ʺChanging the grid and intensity displayʺ on page 305 for more information about 
controlling the grid and intensity display.

See Appendix C, ʺCell summary reportʺ on page 355 for more information about the 
cell summary report.

Moving the 
components out of 
the viewer

You can move the following components to a different location on your screen by 
clicking in the title bar and dragging the box to the new location (Figure 318).

• Properties box
• Grid box
• Review window

Figure 317   Cell intensity data with failed control features masked
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You can move the Image window outside of the Viewer by clicking on the file name 
tab and dragging the window out of the viewer.

To dock the boxes back in the GCC Viewer:
• Double-click on the box title bar or the file name tab in the Image window.

To choose a new location for the box:

1. Click on the title bar and drag the box back into the GCC Viewer.
The docking hints buttons appear in the Viewer. (Figure 319)

Figure 318   Dragging boxes outside of the GCC Viewer
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2. Move the Cursor to the docking hint button. 
A gray box appears, showing where the box will dock.

3.  Release the mouse button. 
The box is docked in the selected location. The title bar contains two options for 
the Properties and Grid boxes, Close and AutoHide. (Figure 320)

To close a box:
• Click the Close  button

To use the Autohide feature:
• Click the AutoHide button  in the box.

The box is closed, but a tab is displayed on the left side of the window 
(Figure 321).

Figure 319   Using the Docking Hints buttons

Figure 320   Box title bars

Docking Hint buttons
Indicator box
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To display a hidden box temporarily:
• Place your cursor on the tab.

To restore a hidden box:
• Display the box and click on the AutoHide button .

Moving the 
component borders 
in the GCC viewer

You can change the relative size of a component in the Viewer by moving the borders 
of that component.

To change the size of the component:

1. Move the cursor over the border until it changes to a double arrow .

2. Click and drag the cursor to change the size of the area (Figure 323).

Figure 321   Hidden Grid Box and tab

Hidden Grid
Box tab

Figure 322   Placing cursor on boundary between two 
components

Cursor on 
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Using the review window

The Review window, at the bottom of the viewer (Figure 324), displays a list of 
DAT files for scanned arrays. The window includes various information on the 
DAT files, including the grid alignment and cell generation status.

The Toolbar provides access to different functions of the window.

The Review window displays a list of the scans performed along with the following 
information:

Figure 323   Grid box enlarged.

igure 324   Review window

Toolbar
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Status Icon  In progress.

 Finished

 Failed

Date Scanned Date and time the array was scanned.

Barcode Array Barcode.

Well Position Well Position for Array Plate.

Array Name Name of the array file created.

Array Type Probe array model scanned.

Scan Status Status of scan.

Grid Alignment Status of grid alignment.

CEL Generation Status of cell file (CEL) generation.

Date Reviewed Data and time the DAT file was last viewed in the Viewer.

Error Message Short message describing the error found [do we need list of codes?].

Mouse over the error message to see a popup of the entire message.

DAT File Name Name of the DAT file(s) generated.

Mouse over the DAT file name to see the full path.

CEL File Name Name of the CEL file(s) generated.

Mouse over the CEL file name to see the full path.

Last Updated Date the workflow last ran.
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To enable or disable the Review window:
• From the View menu, select Review Window.

The Review window displays a list of the scanned arrays with their DAT files and 
their grid alignment and cell generation status. 

To display a listed DAT file:
• Double-click on the file in the list.

If the workflow is associated with more than one DAT file, the Choose File to 
Open dialog box opens  (Figure 325).

• Select the DAT file to open and click the OK button in the Choose File to Open 
dialog box. 
The image file is displayed in the viewer. (Figure 326)

Figure 325   Choose File to Open dialog 
box

Figure 326   GCC Viewer with DAT file opened
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For information on aligning a misaligned grid, see ʺChecking the grid alignmentʺ on 
page 313.

To update the list:
• Click the Refresh button  in the Toolbar.

To sort the list for a particular parameter value:
Click in the column header for that parameter.

To select columns for display:

1. Right-click in any column header.
A menu of the column headers appears (Figure 327).

2. Select or deselect the desired parameters to conceal and display them.

Changing the filter 
settings

The window enables you to filter the workflows to display only the workflows of 
interest. 

You can filter the displayed workflows by:

• Date since workflow ran
• Error Status
• Any of the values in the columns.

It also indicates the number of displayed records in the Workflow Review window.

To filter by Date since workflow ran:
• Enter a value for the number of days for which you want to display records and 

click Apply  (Figure 328).

Figure 327   Column Header menu

Figure 328   Filter by Date controls
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To display errors only:
• Select the Show Errors Only check box  (Figure 329)

To filter by other parameters displayed in the Review window:

1. Select the parameter type from the Filter by drop-down list  (Figure 330).

2. Enter a value in the Filter by text box.
Note: The Filter by function will filter on parameters that are not being displayed 
in the Review Window. In addition, Only the workflows with parameters 
matching the entered value will be displayed.

Figure 329   Show 
Errors Only check 
box

Figure 330   Filter by controls

Select parameter then enter value
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Changing the other 
settings of the 
workflow review 
window

To change settings for the Review window:

1. From the View menu, select Options...
The Options dialog box opens (Figure 331).

2. Select or deselect the following feature:
• Enable Review Window on startup: turns the Review window on whenever 

the GCC Viewer is opened.
Note: This change will not take effect until you have stopped and restarted the 
GCC Viewer.

3. Change the value for the Refresh interval to control the frequency of the Review 
Window updates.

4. Click OK to close the dialog box and enable the changes.

Figure 331   Options dialog box
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Opening image files

You can display DAT, CEL, and JPG image files in the GCC Viewer. The Viewer has 
different functions when viewing different types of files (see ʺFile display differencesʺ 
on page 280).

You have several options for opening files in the Viewer:

• ʺUsing the search and open dialog boxʺ, below
• ʺUsing the open dialog boxʺ on page 299
• ʺDisplaying multiple filesʺ on page 300

Using the search 
and open dialog box

The Search and Open dialog box enables you to search through the files on the GCC 
system to find the ones of interest.

The Search and Open dialog box enables you to filter the displayed Sample files by:

• Projects
• File Type
• File Creation Date
• Probe Array Type
• Array Name
• Attribute Value

To use the Search and Open dialog box:

1. Click the Search and Open button in the Viewer tool bar; or
From the File menu, select Search and Open....
The GCC File Open dialog box opens (Figure 332).

Figure 332   File Open dialog box

List of Projects List of 
available 
files

File types

Filters controls

Filter Details

Buttons
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The dialog box displays a list of the files that meet the criteria in the upper right 
corner (Figure 333). You select the files to display from this list.

The upper left corner displays a list of the projects in GCC. The lower left corner 
displays a set of additional filters you can apply to the file list.
The Filter Details in the lower right corner displays information about the filter 
criteria that have been applied to the list.
The buttons (Figure 334) allow you to:

2. Select the project(s) with files you want to list in the Projects list (Figure 335).

Figure 333   Unfiltered file list

Figure 334   Buttons

Apply Filters Apply selected Quick Filter and Attribute Value Filter criteria

Clear Filters Clear all applied filters

File Attributes Select attributes to be displayed in File list.

Open Selected Open selected files in File list
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3. Select File Types from the drop-down list.
You can choose from:
• DAT
• CEL
Changes made in the Projects and Files filters are reflected instantly in the Filter 
Details part of the dialog box.
Changes to the Quick Filters and Attribute Value Filters have to be applied by 
clicking the Apply Filters button after selecting.
The Quick Filters (Figure 336) enable you to filter by:
• Date of file creation
• Probe Array Types
• Array Name
• Attribute Value

4. Select a date or range of dates for file creation:
a. Select the From check box.
b. Click the arrow at the date (displays the current date).

A calendar for the current month appears (Figure 337).

Figure 335   Displaying Project List

Figure 336   Quick Filters
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c. Select a date for the start of the range. You can move from month to month by 
clicking the < and > buttons.
If you only select one date, the filter will display only the files created on that 
date.

To select a range of dates:
d. Select the To check box.
e. Select a date for the end of the range.

5. Select Probe Array Types:
a. Click on the down arrow in the Selected Probe Array Types list.

A list of the available probe array types is displayed (Figure 338).
In some cases there may be multiple array models under the same header. in 
these cases you can click the + button to display the additional probe arrays.

b. Select the check boxes next to the probe array types you want displayed in the 
filtered list.

6. Enter text strings for Array Name and Attribute Value (Figure 339).

Figure 337   From Calendar

Figure 338   Displaying array types
GeneChip™ Command Console™ (GCC) User Guide 295



Chapter 9 Using the GCC viewer
Opening image files 9
You can use the “*” symbol as a wildcard in the Array Name and Attribute.

The Attribute Value filters (Figure 340) enable you to enter values for specific 
sample attributes.

7. To enter values for specific attributes:
a. Click the Attribute Value Filters tab (Figure 340).
b. Select a template with the attribute you want to search on from the Select 

Template list (Figure 341).

The list displays only the templates with attributes that are being used in the 
data. |User| attributes are the attributes created specifically for a particular 
Sample (ARR) file and are not included in any template list.
The attributes in that template appear in the Name list (Figure 342).

Figure 339   Selecting an attribute

Figure 340   Attribute Value Filters

Figure 341   Select Template
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c. Select the attribute and enter a value for it in the Attribute box.

You can perform special searches by using the “*” and “,” symbols.
“*” Serves as a wild card function. Using searchstring* will return all arrays 
that contain an attribute that starts with the search string. Using *searchstring 
will return all arrays that contain an attribute that ends with the search string.
If you select a numerical attribute, you can select from the following limits:
• Equal to
• Less than
• Less than or equal to
• Greater than
• Between (use comma-separated values to set the ends of the range).

Figure 342   Selecting attribute and 
entering value

Figure 343   Selecting Limits
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Whenever you change a setting in these filter boxes, you need to apply the 
changes. A notice appears to that effect in the Filter Details area (Figure 344).

8. Click Apply Filters after making changes.
9. The changes are displayed in the Filter Details section (Figure 345).

The filtered file list is displayed in the File List (Figure 346).

Figure 344   Filter details 
with Status notice

Figure 345   Filter Details with attributes 
displayed

Figure 346   Filtered file list
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10. Select the file(s) you want to open from the File list and click the Open Selected 
button.
The selected file is displayed in the Viewer.

To display different file attributes in the File list:

1. Click the File Attributes button.
The Choose Column Details dialog box appears (Figure 347).

The dialog box displays a lit of the different characteristics that can be selected for 
display, with a check box next to each characteristic.

2. Select the check box for the characteristics you want to display.
3. Click OK.

The selected characteristics are displayed in the File list.

Using the open 
dialog box

The Open dialog box displays a list of all the available image files in the system.

To open a file using the Open dialog box:

1. From the File menu, select Open File; or
Click the Open File button in the GCC Viewer tool bar.
The Open dialog box opens (Figure 348).

Figure 347   Choose 
Column Details dialog box
GeneChip™ Command Console™ (GCC) User Guide 299



Chapter 9 Using the GCC viewer
Opening image files 9
2. If necessary, use the dialog box tool bar to navigate to the directory with the file.
3. Select the file you want to view.
4. Click Open.

The selected image file is displayed in the GCC Viewer.

Displaying multiple 
files

You can open more than one file in the GCC Viewer (Figure 349).

To display a particular image when you have more than one open:
• Click the tab at the top of the Image Window.

Use the < and > scroll buttons in the Image title bar to scroll through the tabs if 
necessary (Figure 350).

Figure 348   Open dialog box

Figure 349   Displaying multiple image files

Image Window
title bar
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Different icons are used for DAT and CEL files.

To display the full path to a displayed file:
• Place your cursor on the file’s title bar tab.

The full path is displayed below the title bar (Figure 351).

Figure 350   Image window title bar

Scroll buttons

click to close 
image

Different icons for
DAT and CEL files

Figure 351   Displaying the path to a file
GeneChip™ Command Console™ (GCC) User Guide 301



Chapter 9 Using the GCC viewer
Changing the display of the image 9
Changing the display of the image

This section explains how to use the Image tool bar controls (Figure 352) for:

• ʺExamining different parts of the imageʺ on page 303
• ʺAdjusting the colors and contrastʺ on page 304
• ʺChanging the grid and intensity displayʺ on page 305

Part of the tool bar may be hidden if the GCC Viewer is too small.

To display the hidden controls:
• Click on the Hidden Tool Bar button  at the right of the toolbar (Figure 353).

The hidden controls are displayed below the tool bar (Figure 353). 

Figure 352   Image window tool bar for DAT and CEL file

Zoom Color/Contrast Contrast/Brightness Grid and 
Intensity 
Display

Autoscale

Copy

DAT File tool bar

CEL File tool bar

Zoom Color/Contrast Contrast/Brightness

Select file types

Copy

Exposure

Figure 353   Displaying hidden controls

Click here to display 
hidden controls
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Examining different 
parts of the image

These functions work on DAT, CEL, and JPG files.

The Zoom controls are at the left end of the tool bar.

To zoom in on a selected area of the image:

1. Click on the Zoom Select button .
2. Click and drag around the area you want to examine in more detail (Figure 355).

3. Release the mouse button.
4. The selected area is displayed in the GCC Viewer (Figure 355).

Figure 354   Zoom controls

Figure 355   Click and drag

Zoom buttons

Select Out ResetIn
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To zoom in or out on the whole image:
• Click on the Zoom In button  or the Zoom Out button .

To view a different area in magnified zoom:
• Click and drag the image to view the area of interest. 

To zoom out:
• Click the Zoom Reset button . 

Note: You can also use the Grid box controls to select a particular corner or sub-
grid for examination (see ʺChecking the grid alignmentʺ on page 313).

Adjusting the colors 
and contrast

These functions work on DAT, CEL, and JPG files.

To switch between Gray Scale or Pseudo Color display:
• Click the Gray Scale  or Pseudo Color  buttons.

Figure 356   Zoomed-in view (with grid 
displayed)

Figure 357   Color and Contrast controls

Gray 
Scale

Contrast Slide Bars
Set 

Contrast
Pseudo 
Color

Auto Contrast
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To adjust the contrast range for the image:

1. Click the Set Contrast button .
The Set Contrast dialog box opens (Figure 358).

2. Set the minimum and maximum contrast range.
3. Click OK to use the settings; or

Click Default to return to the default settings; or
Click Cancel to close the dialog box without changing the settings.

You can also use the slide bars in the tool bar (Figure 357) to set the contrast without 
opening the Set Contrast dialog box.

Using the Autoscale Function
The autoscale function takes the image area you are currently viewing and calculates 
the intensity to find a better minimum and maximum contrast.

To use the Autoscale function:
• Click the Autoscale button .

The contrast and brightness are automatically adjusted.

Changing the grid 
and intensity 
display

These functions only work when DAT files are displayed (Figure 359).

Displaying cell intensity data
If you have a DAT file open with the associated cell intensity data (CEL) file available, 
you can view the intensity data in the DAT file Image window.

To display or hide the cell intensity data:
• Click the Cell Intensity button .

Figure 358   Set contrast 
dialog box

Figure 359   Image window tool bar, grid and intensity controls (for DAT files only)
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The cell intensity data for the array is displayed.
Note: When displaying cell intensity data for certain types of probe arrays, 
control feature cells that failed the cell summary analysis may be masked. See 
ʺViewing failed control featuresʺ on page 281.

Displaying different exposures (GeneTitan expression array plate DAT files 
only)
Each GeneTitan array is scanned twice, with different exposure times. The image data 
from both exposures are in the GeneTitan DAT file. You can switch between the 
different exposures for checking the gridding, etc., by using the Exposure button. 

The Exposure button displays the currently displayed exposure time.

To switch between views of the different exposures:
• Click the Exposure button.

The other DAT Exposure is displayed.

Displaying different wavelengths (Axiom array plate DAT files only)
Each genotyping array is scanned twice, at different wavelengths. The image data from 
both exposures are in the genotyping DAT file. You can switch between the different 
exposures for checking the gridding, etc., by using the Wavelength button. 

The Exposure button displays the currently displayed exposure time.

To switch between views of the different exposures:
• Click the Color button.

The other genotyping DAT Exposure is displayed.

Figure 360   Exposure button

Figure 361   Wavelength button
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Displaying cell centers
The center of each cell on the array can be displayed for certain array types. The centers 
are visible only when viewing DAT files for probe arrays with sub-grids at a 
sufficiently zoomed-in level. The cell center display can be used in evaluating gridding 
problems.

To display cell centers:
• Click the Cell Centers button .

The cell centers are displayed. (Figure 362)

Displaying the grid corners
The grid can be displayed to evaluate gridding problems and perform manual 
gridding.

To display the grid:
• Click the Grid Corners button .

The outline of the grid is displayed on the image.

Figure 362   Cell centers displayed for a sub-
grid
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The grid cells are not displayed until you have magnified the DAT file so that they 
are visible. (Figure 364)

See ʺChecking the grid alignmentʺ on page 313 of this manual for more information 
about manual gridding.

Figure 363   Outside edges of main grid displayed

Figure 364   Corner grid displayed for a sub-grid
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Changing settings for the grid display

To change settings for the grid display:

1. From the View menu, select Options...
The Options dialog box opens (Figure 365).

2. Select a new color for the grids from the Grid line color drop-down box.
3. Click OK to close the dialog box and enable the changes.

Saving image 
display options

You can change the save options for the image display settings. These allow you to 
apply the same contrast and other settings to different image files.

To change the Save Options for the image display options:

1. From the View menu, select Options...
The Options dialog box opens. (Figure 365)

Figure 365   Options dialog box.
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2. Select an option from the Saving Image Display options drop-down box:
• Do Not Save
• Save: Save settings from one program session to the next.
• During the program session: Save settings only until the Viewer is shut down.

3. Click OK to close the dialog box and enable the changes.

Learning about the image file

The Properties box displays information about the image file displayed in the window. 
The information can be displayed in alphabetical order, or ordered by different 
categories, depending upon the type of file displayed:

For a DAT file:

• Array Information
• Fluidics
• Grid Alignment
• Image
• Scanner

For a CEL file:

• Array Information
• Cel
• CEL Summary Report (only for files with CEL Summary Reports)

– You can click on the Report row first, and then click on the button that appears 
to open a text display of the CEL Summary report (Figure 367).

Figure 366   Options dialog box.
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See Appendix C, ʺCell summary reportʺ on page 355 for more information.
• Fluidics
• Scanner

To expand or collapse a component: 
• Click on the +/- button to the left of the component.

To sort the data in a different way:
• Click the Category Sort  or the Alphabetical Sort  button.

Figure 367   Cel Summary Report Section

Figure 368   Properties box

Click to open the Cell Summary Report

Properties tool bar
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Grid information The Grid information category displays information about the main grid and sub-
grids:

• Global Grid: Displays the pixel coordinates for the corners of the main grid.
• sub-grids (when available): Displays the pixel coordinates for the corners of each 

sub-grid. (Figure 369)

Figure 369   sub-grids 
displayed
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Checking the grid alignment

This chapter describes the use of the GCC Viewer for aligning failed grids:

• ʺAligning the main gridʺ on page 313
• ʺAligning sub-gridsʺ on page 317
• ʺAligning sub-grids on GeneTitan arraysʺ on page 322
• ʺRegenerating intensity valuesʺ on page 324

For general information about grid alignment, see ʺArray and grid typesʺ on page 273.

Aligning the main 
grid

If the array has sub-grids, the main grid has to be aligned before aligning the sub-grids.

If the main grid is misaligned, you will see a notice in the Review list (Figure 370).

To view the main grid:
• Click the Full Image button  in the Grids tool bar (Figure 371). 

The main grid is displayed for single-grid and multi-grid files.
You have two options for fixing an alignment problem:

• You can run the gridding algorithm again.
• You can align the grid manually. 

Note: Realigning the grids will update DAT headers and break the parent-child 
relationship between DAT files and existing CEL files until the CEL files are 
regenerated.

Running the gridding algorithm
In some cases you can realign the grid by running the alignment algorithm again.

Figure 370   Notice of failed grid alignment

Figure 371   Grid box tool bar
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To run the alignment algorithm on an array that uses a single grid:

1. In the Grids tool bar, click on the Image Processing button  and 
select Realign All Grids from the shortcut menu. (Figure 371)
A notice informs you that a new cell intensity data file (CEL) will be generated.

2. Click Yes to proceed with the alignment.
Progress bars display the progress of the alignment and cell generation.

When the process is finished, a notice appears. (Figure 374)

New gridding information and a new CEL file are generated.

Aligning the grid manually
If the algorithm alignment fails, an error message appears. (Figure 375)

If you see the error message, you can manually adjust the main grid by using the 
following procedure:

1. Click on the failed DAT file in the Review window.
The main grid is displayed in the Image window. (Figure 376)

Figure 372   Notice of regridding

Figure 373   Progress bar

Figure 374   Notice

Figure 375   Notice of main grid misalignment
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2. Align the grid at each corner of the image:

a. Click a Corner button in the Grid box toolbar (Figure 377) to choose a corner.
The selected corner is displayed in the Image window. (Figure 378) 
The software displays a box around each feature of the corner grid.

Figure 376   Misaligned main grid

Figure 377   Grid box toolbar

Corner buttons Image Processing Options
GeneChip™ Command Console™ (GCC) User Guide 315



Chapter 9 Using the GCC viewer
Checking the grid alignment 9
b. Place the mouse arrow over the grid perimeter (the arrow becomes a double 
arrow, ).
The diagonal orientation of the double arrow along the perimeter of a corner 
probe cell indicates horizontal and vertical adjustments can be made 
simultaneously using the click-and-drag method or by using the keyboard 
arrow keys.

c. Use the click-and-drag method or the keyboard arrow keys to adjust the 
horizontal or vertical position of the grid so that it is aligned over the corner 
of the outermost corner checkerboard.

d. Repeat the above steps for the other corners of the main grid.
3. After you align the grid, click the Save button  or select File → Save from 

the menu bar.
A notice opens, informing you that a new cell intensity data file will be generated 
automatically. (Figure 379)

4. Click Yes to save the DAT file and generate a new CEL file.
The cell intensity data file will be generated automatically.
For arrays with a single grid, you can now proceed to generate the CEL file (see 
ʺRegenerating intensity valuesʺ on page 324).

Figure 378   Lower right corner displayed in the 
image window

Figure 379   Notice
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For arrays with sub-grids, you can now check the alignment of the sub-grids (see 
ʺRegenerating intensity valuesʺ, below).

Aligning sub-grids Sometimes one or more sub-grids may require alignment. The failed sub-grids are 
marked with an X in the Grids box (Figure 380).

If the sub-grid alignment fails you can: 

• Run the sub-grid alignment algorithm.
• Perform a manual alignment on the failed sub-grids. 

Note: Realigning the grids will update DAT headers and break the parent-child 
relationship between DAT files and existing CEL files until the CEL files are 
regenerated.

Running the sub-grid alignment algorithm
You can run the sub-grid alignment algorithm if some of the sub-grids are misaligned 
or if you have manually aligned the main grid.

To run the alignment algorithm again on an array that uses sub-grids:

1. In the Grids toolbar, click on the Image Processing button  and 
select Realign All Grids from the shortcut menu. (Figure 381)

A notice informs you that a new cell intensity data file (CEL) will be generated. 
(Figure 382)

Figure 380   Grid box

Figure 381   Grids tool bar for array with sub-grids

Misaligne
d sub-
grids are 
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2. Click Yes to proceed with the alignment.
Progress bars display the progress of the alignment and cell generation. 
(Figure 383)

When the process is finished, new gridding information and a new CEL file are 
generated and will align the main grid and all sub-grids.

To run the sub-grid alignment algorithm only:

1. In the Grids toolbar, click on the Image Processing button  and 
select Realign sub-grids Only from the menu. (Figure 381)

A notice informs you that a new cell intensity data file (CEL) will be generated. 
(Figure 384)

2. Click Yes to proceed with the alignment.
Progress bars display the progress of the alignment and cell generation. 
(Figure 385)

When the process is finished, new gridding information and a new CEL file are 
generated.

Figure 382   Regridding notice

Figure 383   Progress bars

Figure 384   CEL generation notice

Figure 385   Progress bars
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Manually aligning the sub-grids
The boundaries of a sub-grid are indicated by the alignment patterns at the four 
corners of the sub-grid. A small checkerboard may mark the corner of two or more sub-
grids, depending upon its position in the main grid. (Figure 386)

If the sub-grids are not aligned correctly, the following error message appears after 
imaging an array or opening a DAT file: (Figure 387)

Navigating from sub-grid to sub-grid
The failed sub-grids are marked with an X in the Grids box. (Figure 388)

Figure 386   sub-grid borders

Figure 387   Notice of sub-grid misalignment(s)
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Highlighting
• Selected sub-grids are highlighted in blue
• Selected misaligned sub-grids are highlighted in yellow
• Modified sub-grids are highlighted in green.

You can step through sub-grids using the right and left buttons. (Figure 389)

To step through all sub-grids:

1. Toggle the Step button  to the all position
2. Click the left  and right  buttons to step through the sub-grids.

To step only through the misaligned grids

1. Toggle the Step button to the misaligned position.
2. Click the left  and right  buttons to step through the sub-grids

To manually align a failed sub-grid:

1. Click OK in the sub-grid Alignment Failure dialog box. (Figure 387)
2. Click on the sub-grid you want to align in the Grid box.
3. A zoomed-in view of the sub-grid appears in the Image window. (Figure 390)

Figure 388   Misaligned sub-grids in the 
Grids box

Figure 389   Grid box toolbar, sub-grid step 
buttons

Misaligned 
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4. Align the sub-grid at each corner:
a. Click the Go To Corner button for the corner you want to align.

A zoomed-in view of the corner of the sub-grid appears. (Figure 391)

b. Place the mouse arrow over the grid perimeter (the arrow becomes a double 
arrow, ).
The diagonal orientation of the double arrow along the perimeter of a corner 
probe cell indicates horizontal and vertical adjustments can be made 
simultaneously using the click-and-drag method or by using the keyboard 
arrow keys.

Figure 390   Selected sub-grid

Figure 391   The upper right sub-grid corner
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c. Use the click-and-drag method or the keyboard arrow keys to adjust the 
horizontal or vertical position of the sub-grid so that it is aligned over the 
outside corner of the small checkerboard pattern. (Figure 392)

d. Repeat steps A through C for the other corners of the sub-grid.
5. Continue manually aligning all misaligned sub-grids.
6. After you align the grid, click the Save button  or select File → Save from 

the menu bar.
The Save Notice appears. (Figure 393)

7. Click Yes to save the file.
The file is saved and CEL file generation is done. 

Aligning sub-grids 
on GeneTitan arrays

You use the same controls and steps to align sub-grids for GeneTitan arrays as you do 
for cartridge arrays, with the following exceptions:

• You do not need to perform a main grid alignment
• You may have to check the grid alignment for both exposures (see ʺDisplaying 

different exposures (GeneTitan expression array plate DAT files only)ʺ on page 
306) or both wavelengths (see ʺDisplaying different wavelengths (Axiom array 
plate DAT files only)ʺ on page 306.

• You can select an option to apply adjusted coordinates to all channels and 
exposures (see ʺChanging the manual grid adjustment settingʺ on page 323

Figure 392   Dragging the sub-grid boundary

Figure 393   Save notice
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Changing the manual grid adjustment setting
You can apply the coordinate adjustments made to one exposure time or channel to the 
other exposure time or channel.

To change settings for the manual grid adjustment:

1. From the View menu, select Options...
The Options dialog box opens. (Figure 395)

Figure 394   GeneTitan Array DAT file, grid selected

Figure 395   Options dialog box.
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2. Select or deselect the Manual Grid Adjustment check box.
3. Click OK to close the dialog box and enable the changes.

Regenerating 
intensity values

Cell intensity values are generated automatically after:

• Running any grid alignment algorithm.
• Saving a DAT file after manual gridding.

You can also regenerate the intensity values without performing one of these other 
steps.

To regenerate the intensity values:

1. In the Grids toolbar, click the Image Processing button .
2. Select Regenerate CEL Intensity from the list.

A new CEL intensity data file will be generated. It will automatically have an 
underscore and number appended to the name to distinguish it from a previously 
generated file.

Exporting images in other formats

You have two options for exporting a copy of the image:

• ʺCopying images to the computer clipboardʺ
• ʺCreating a JPG fileʺ on page 325

Copying images to 
the computer 
clipboard

To copy an image to the computer clipboard:

1. Display the image you want to copy in the Image window. 
Note: You can zoom in on a specific region of the image if you desire before 
copying.

2. Click the Copy button in the image window tool bar (Figure 396) or press Ctrl c.

The image is now copied to the clipboard.
You can then paste the image into a graphics program such as MS Paint, then save 
the file as you normally would.

Figure 396   Copy button

Copy button
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Creating a JPG file You can create a JPG copy of a DAT file for archive purposes. 

To create a JPG copy of a DAT file:

1. From the File menu, select Create JPG from DAT....
The Open dialog box opens. (Figure 397)

2. Select the DAT file you want to copy.
3. Click Open. 

The JPG file is created. 

Viewing the JPG file

1. Click File → Open File.
An Open window appears.

2. Navigate to the file’s location as you normally would.
3. Click to highlight it, then click Open.

The selected image file is now displayed in the Viewer.

To open the JPG in the Windows Picture and Fax Viewer:
• In the Folder View, click the Explore link next to the JPG file.

The selected JPG file is displayed in the Windows Picture and Fax Viewer.

Figure 397   Open dialog box for JPG creation
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Changing settings for the JPG conversion

To change settings for the JPG conversion:

1. From the View menu, select Options...
The Options window appears. (Figure 398)

2. Change the values for Compression Ratio and Sampling Ratio.
Increasing either of these values increases the resolution of the JPG image, but 
also increases the size of the JPG file.

3. Click OK to close the dialog box and enable the changes.

Figure 398   Options window.
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Changing probe array types

GCC enables you to change the probe array type for any or all of a group of files. 

The Change Probe Array Type function enables you to:

• Change the probe array type for the selected Sample and data files, regrid the 
associated DAT files, and regenerate the associated CEL files

• Change the probe array type field for selected CEL files
You might want to use this function:

• If you are working with probe arrays that can be used for more than one type of 
analysis.

• If you have analyzed a set of prototype arrays using a preliminary set of library 
files, and you now have the correct library file set.
Note: The Change Probe Array Type function cannot be used for GeneTitan 
Array Plates.

To change the probe array type for a group of files:

1. Select the files for which you which to change the probe array type.
You can select files to change from:
• The Folder View (see ʺSelecting filesʺ on page 56).
• The Project View (see ʺSelecting filesʺ on page 66).
• The Search Results page (see ʺSelecting filesʺ on page 76).

2. Select Change Probe Array Type from the Command to Run drop-down list.
The Change Probe Array Type page opens. (Figure 399)

Figure 399   Change Probe Array Type page
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3. Select the option you want to use:
• Realign the grids of DAT files and regenerate CEL files, overwriting existing 

files.

This option will:
• Change the probe array type for the selected Sample and data files
• Re-grid the associated DAT files
• Regenerate the associated CEL files and the cell summary report file

• Change only the probe array type of a selected CEL file.
This option will only change the probe array type information in the selected 
CEL file(s). It does not modify the Sample probe array type information in the 
Sample file or the DAT file. 
This option is for use when using a CEL file that belongs to a multi-use array. 
These arrays that can be analyzed in multiple ways, as an Expression array or 
a Genotyping array.

4. Click Next.
The page displays the data files. (Figure 400)

5. Select the files to be changed by selecting the check boxes in the left-hand column.
You can use the Select All and Deselect All buttons to select all or deselect all 
files.

6. Select the probe array type you want to change the selected files to from the drop-
down list. (Figure 401)

IMPORTANT!  Realigning the grids will break the parent-child relationships between DAT 
files and CEL files and between CEL files and CHP files until the CEL files are regenerated 
(Any CHP files are not automatically regenerated; you must regenerate them manually). 
Choosing this action will not delete any vital information because you can change the probe 
array type back to its original value if you change your mind.

Figure 400   Change Probe Array Type page, step 2
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7. Click Next.
The page displays the progress of the transformations. (Figure 402)

Figure 401   File Type list

Figure 402   Progress of probe array type changes
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The Administration functions provide additional options for organizing and tracking 
your data:

• ʺWorking with templatesʺ
• ʺTracking the workflowʺ on page 338 

Working with templates

Templates are used to organize a set of attributes that you can use to create a new 
Sample file.

Attributes are properties used to describe a sample and its associated array(s). 
Attributes include:

• Sample Name
• Gender
• Date
• Array Type
• Array Barcode

When you create a template, you specify:

• the attributes included in the template 
• the data type for each attribute:

– Text: text string
– Number: Floating point or Integer
– Date: Calendar data
– SingleSelect: enables the user to select a single item from a controlled 

vocabulary list
• whether the attribute is required
• value options for SingleSelect attributes

Templates allow you to organize attributes and collect consistent data for your 
experiments and samples.

The following templates are included in the GCC install:

• MIAME sample information
• Pedigree template

This section describes the following functions:

• ʺCreating a templateʺ, below
• ʺEditing a templateʺ on page 333
• ʺDeleting templatesʺ on page 335
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• ʺManaging default templatesʺ on page 337

Creating a template To create an attribute template:

1. From the Templates menu, select New Template.
The Create Template File page appears. (Figure 403)

2. Enter a name for the template and click Next.
The Add Attributes page opens. (Figure 404)

Figure 403   Create Template File page
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The page displays a list of the attributes for the template.

To add a field to the list:

1. Click Add.
A new row appears in the list, with the following boxes for entering information 
or links:

.

Figure 404   Edit Templates page

Sample 
Attribute 
Name

Enter a name for the attribute.

Required Click if the attribute is required.

Type Select from drop-down list:
•Text: Text string
•Number: Integer or floating point number
•Date: Calendar data
•SingleSelect: Presents a list of items for 

the user to choose

Control 
Vocabulary

Enter values for the controlled vocabulary, placing multiple 
values on separate lines.

Default Value Enter a default value to be displayed for the field in a new Sample 
file.
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2. Enter or select values for the field characteristics.
3. Repeat Step 1 and Step 2 for the other attribute fields you want to add.
4. After creating the attribute fields, click Save to save the template.

The Results Page displays the name of the created template (Figure 405).

Editing a template You can edit an existing template. 

Note: Deleting an attribute from a template or changing data type will cause attribute 
discrepancies if you have already used the template to create Sample files. For more 
information, see ʺSample attributes conversionʺ on page 118.

To edit a template:

1. From the Templates menu, select Edit.
The Edit Template File page appears. (Figure 406)

Figure 405   Result page
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2. Select the template you want to edit and click Next.
The Add Attributes page opens. (Figure 407)

You can add, edit, or delete fields with the same functions used to create a new 
template. For more information see ʺCreating a templateʺ on page 331.

Figure 406   Edit Template File

Figure 407   Add Attributes page
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3. After editing the attribute fields, click Save to save the template.
The Results Page displays the name of the created template.

Deleting templates You can delete a template from the list. 

Note: Deleting a template will cause attribute discrepancies if you have already used 
the template to create Sample files.

To delete a template:

1. From the Administration menu, select Templates → Delete.
The Delete Template File page appears. (Figure 409)

Figure 408   Results page
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2. Select the template to be deleted from the drop-down list.
3. Click Delete.

The template is deleted. (Figure 410)

Figure 409   Delete Template File page

Figure 410   Notice of template deletion
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Managing default 
templates

The default template attributes are displayed when the Detailed Sample Registration 
function is used and are displayed in the Default view in Folder view.

To change the default templates:

1. From the Administration menu, select Templates → Default.
The Default Template File page appears. (Figure 411)

Click on a template name to see a list of the attributes in that template. 
(Figure 412)

2. Select the template(s) to be defined as default templates from the Available 
Templates list.

3. Click Add.
The template is moved to the Default Templates list.
You can also click the Remove button to remove templates in the Default 
Templates list.

Figure 411   Manage Default Templates page

Figure 412   Template Details
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The template attributes will be available in the Detailed Sample Registration page. 
(Figure 413)

Tracking the workflow

The Workflow Monitor page enables users to view a list of the arrays in the workflow 
and see what their status is. 

To view the Workflow Monitor page:
• Click Administration → Workflow. 
• The Workflow Monitor page opens (Figure 414).

Figure 413   Detailed Sample Registration page with default Template attributes
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The Workflow Monitor page displays a list of the files waiting to finish workflow steps. 
It displays an item for each file and each unfinished step in the workflow; a file may 
have multiple entries, depending upon what step in the workflow has been completed. 

For each file, the following information becomes available:

To sort the file list by any column:
• Click on the column’s header.

Figure 414   Workflow Monitor page

Barcode Barcode of array.

Array Name Name assigned to the array by the user.

Probe Array 
Type

Model of probe array.

Sample file Name of Sample file.

Workflow Step The uncompleted step in the workflow.

Project Project folder the Sample file is assigned to.

Status • Running.
• Not Ready.
• Error.
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A computer running, GCC can be connected to a Windows network to provide the 
following functions:

• Using network data storage
If the Windows network has a network data root, you can consolidate data from 
multiple computers running GCC Instrument Control in a single location. GCC 
Portal provides convenient ways to keep Sample (ARR) files and data files (DAT 
and CEL) in the same folder on the network data storage. 

• Running different parts of the workflow on different IC workstations
In some cases the Fluidics Station and Scanner used to process an array are 
controlled by different workstations. GCC software enables you to perform 
different workflow tasks on different workstations while consolidating the 
Sample (ARR), Data (DAT and CEL) and Audit files at a single storage location 
(during processing the files may be on different machines).

Examples of different configurations for GCC with Windows network are given in 
ʺSample configurations for GCC with network functionalityʺ on page 341. Contact 
your IT/CIS support for help with configuring network functionality.

After installing the GCC components, to use the network functionality you need to:

1. Connect the computer to a Windows network with necessary permissions and 
have permissions set for using network data storage.
See ʺSetting up Windows networkingʺ on page 345 for more information.

2. Configure GCC Services with the proper domain and user account with 
password to access the network assets.
See ʺConfiguring GCC servicesʺ on page 346 for more information.

3. Add network data storage as a data root in GCC Portal
ʺAdding the network data storage as a data rootʺ on page 349.
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Sample configurations for GCC with network functionality

This section describes some sample configurations using GCC network functionality: 
• ʺLinked instrument control systemsʺ
• ʺNetwork storageʺ on page 343

The sample configurations show some of the ways you can connect computers with 
different roles in order to consolidate data, perform different parts of the workflow, 
and provide data access to other users.

Linked instrument 
control systems

This configuration (Figure 415) enables you to perform different instrument control 
tasks on different workstations while consolidating the data files on the Scanner 
workstation.

In the linked IC Workstation configuration, the Scanner Workstation and the GCC 
Fluidics Workstation are linked with Windows Network.

Computer roles in 
linked control 
systems

Scanner system
The scanner workstation can be considered the ‘main’ system, in that the Sample files 
will be generated and stored there and all related DAT, CEL, and CHP files can be 
consolidated at the same location.
The dataroot of the scanner workstation is shared so that the fluidics workstation can 
access the Sample files and log AUDIT information for the arrays that are run through 
the fluidics station, without needing to copy the files locally. 
Requirements for the scanner system:

• Has the following software installed
– Windows 10 Enterprise 2016 LTSB
– GCC Portal with GCC Portal Web Server
– GCC Viewer
– GCC Scanner Control

Figure 415   Linked instrument control system

GCC Scanner Workstations

Windows 
Network

GCC Fluidics Workstations
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Tasks that can be performed using the IC Scanner Workstation:
• Create and edit Sample (ARR) file and Register Array 
• Run Scan on array to create DAT file
• Grid and get CEL Data (and perform manual grid alignment check if necessary)
• Index and search the workstation data.

Fluidics system
In the linked system, the fluidics workstation does not store any Sample files, or 
generate DAT, CEL or CHP files. It uses the Sample files on the scanner system, and 
writes back AUDIT information about the fluidics processing. If necessary, the fluidics 
workstation can also register arrays/samples that will be stored on the scanner 
workstation.
The IC workstation has GCC Portal and GCC Instrument Control installed. A Fluidics 
workstation can control up to eight fluidics stations.
Requirements:

• Has the following software installed
– Windows 10 Enterprise 2016 LTSB
– GCC Portal with GCC Portal Web Server.
– GCC Fluidics Control

• Connected through Windows Network to the Scanner System.
• Have necessary Domain and User Permissions settings to enable Read/write to 

the Scanner System.
• GCC Services configured to work with Scanner System.
• Have Scanner System set up as a data root for GCC Portal

Tasks that can be performed using the IC Fluidics Workstation:
• Run Fluidics station and update the Audit file for the array.
• Index and search the Fluidics workstation data and the Scanner workstation data.
• Edit Sample (ARR) files on the Scanner and Fluidics workstation data.

The Fluidics system can also move data to and from Scanner System using Windows 
Explorer.
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Network storage This configuration (Figure 416) provides storage and tools to consolidate the data 
produced by a set of IC workstations. It also enables other users linked through the 
Windows Network system to access the data. 

Computer roles for 
network storage

The network data storage configuration supports the following computer roles:
• ʺNetwork data storageʺ
• ʺGCC IC workstationsʺ
• ʺLocal analysis workstationʺ
• ʺLocal lab computerʺ

Network data storage
Network data storage serves as the central data repository for the networked 
computers. Sample (ARR) files are created on it and the DAT and CEL data are pushed 
out to it from the IC workstations. The network data storage computer does not need 
to have any GCC software installed.

Figure 416   Network Data Storage configuration

Local GCC Analysis 
Workstation

GCC Instrument Control 
Workstations

Local Lab Computer

Windows 
Network

Windows 
Network

Windows 
Network

Windows 
Network

Windows 
Network

Network Data 
Storage
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GCC IC workstations
The IC workstation has GCC Portal and GCC Instrument Control installed. An IC 
workstation can control one scanner and up to eight fluidics stations.
GCC IC Workstations have the following requirements:

• Has the following software installed
– Windows 10 Enterprise 2016 LTSB
– GCC Portal with GCC Portal Web Server
– GCC Viewer
– GCC Instrument Control

• Connected through Windows Network to the network data storage.
• Have necessary Domain and User Permissions settings to enable Read/Write 

access to the network data storage.
• GCC Services configured to work with network data storage.
• Have network data storage set up as a data root for GCC Portal.

Tasks that can be performed using the IC Workstation:
• Create Sample (ARR) file and Register Array on network data storage and the 

workstation.
• Run Fluidics and Scan array to create DAT file.
• Grid DAT files, perform manual grid alignment check if necessary, and generate 

CEL file data.
• Use GCC Portal data management functions to upload DAT and CEL files to 

network data storage in same folder as Sample (ARR) file.
• Index and search the network data storage and the workstation data.
• Edit Sample (ARR) files on the network data storage and the workstation.

Note: The local IC workstation can also move data to and from network data 
storage using Windows Explorer.

Local analysis workstation
The IC workstation has GCC Portal and GCC Viewer installed.
A local Analysis Workstation has the following requirements:

• Windows 10 Enterprise 2016 LTSB
• GCC Portal with GCC Portal Web Server.
• GCC Viewer 
• Connected through Windows Network to the network data storage
• Have necessary Domain and User Permissions settings to enable Read/Write 

access to the network data storage.
• GCC Services configured to work with network data storage.
• Have network data storage set up as a data root for the GCC Portal

It can perform the following tasks:
• Create and edit Sample (ARR) files on the network data storage and the 

workstation.
• Index and search the network data storage and the workstation data.
• Manual Gridding of DAT files on the workstation.
• Re-calculating CEL file data after gridding.

The local Analysis Workstation can also move data to and from network data storage 
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using Windows Explorer.

Local lab computer
Lab Computers do not have any GCC software installed. Lab Computers are 
commonly used to perform higher-level analysis on the data. 
Requirements:

• Connected through Windows Network
• Have necessary Domain and User Permissions settings to enable Read/Write 

access to the network data storage.
The local Lab computer can move data to and from network data storage using 
Windows Explorer.

Setting up Windows networking

A computer running GCC can be connected to a Windows network to provide 
different options for data consolidation and sharing.
Computers connected to the network are organized into domains. A domain is a group 
of computers that share common security and user account information. 
Each user is assigned to a domain and given a user account with a name and password. 
Any computer on the proper domain with necessary user permissions can get on the 
system using Windows Explorer and move data files on and off the network data 
storage.
If on a Windows domain these need to be domain accounts. If not on a Windows 
domain the share and the machine need matching account names and passwords.
Work with your IT department for help in setting up the necessary domain and user 
accounts.
If the domain, user account, and permissions are correct, when the computer running 
GCC is connected to the network you should be able to see the network data storage 
using Windows Explorer. You will not be able to add network data storage as an GCC 
data root or use GCC Portal to search the network data storage until you have 
configured the GCC Services with the proper domain and account information.

Sharing and 
security

You can use the Windows Sharing and Security settings to control access to your data 
when using network functionality. GCC supports setting permissions at the folder 
level, not the file level, even though the Windows settings can be set at the file level. 
You can change the settings for Sharing, permissions, and security for a selected file, 
but you need to be very careful about setting permissions when using GCC; you could 
lock yourself out of your own data or deny access to other people if the permissions are 
set incorrectly. 
Work with your IT department for help in setting the permissions. 

Examples
Letʹs take two different examples of how you might configure your file permissions for 
a network folder. 
In the first example, you have a folder that is shared by your department. This folder 
enables read and write access to a Windows domain group called “Liver Cancer 
Group”, and grants no other permissions to anyone else. In order for GCC to be able to 
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access this network folder, you must change your GCC Services to run as one of the 
users who is a member of the Liver Cancer Group.
In the second example, you have a folder on a computer in a lab that you want access 
to, but you donʹt want anyone else to access that folder. If you create a local user 
account on that computer called LocalUser, with the password “LocalPassword”, then, 
you can share that folder on the network, but grant access only to LocalUser. If you 
have a computer outside of that lab that has GCC installed, then you can also create 
LocalUser as a local user on this second computer, with the same password, and then 
change the GCC services on that second computer to run as LocalUser. Now, if you 
add your network folder as a Data Root, then you should be able to have complete 
access to that network folder in GCC.

Configuring GCC services

GCC services are tools that perform the functions of the software. To add a network 
data share as a data root, these services need to be configured as a domain user 
account, instead of a local system account. 
The GCC services that need configuring include:

• GCCAuditLogger
• GCCIndexer
• GCCTaskManager
• GCCWebServer
• GCC96FS_WorkflowSvc

If on a Windows domain these need to be domain accounts. If not on a Windows 
domain the share and the machine need matching account names and passwords.
Note: You can use matching local accounts on a domain, but you need to be logged in 
using an account with Administrator privileges to perform this configuration.

Configuring the GCC 
portal services 

1. From the Start menu, click Control Panel → Administrator Tools.
The Control panel opens.

2. Double-click the Services icon.
The Services window opens.

There are five GCC Services: 
• GCCAuditLogger
• GCCIndexer
• GCCTaskManager
• GCCWebServer
• GCC96FS_WorkflowSvc
You will need to perform steps 3 through 6 for all services.

3. Right click GCCAuditLogger (or another service you are configuring) and select 
Properties. 
The Properties dialog box opens.

4. Click the Log On tab.
GeneChip™ Command Console™ (GCC) User Guide 346



Appendix A Networking
Configuring GCC services A
5. Change the log on information for the service.
a. Change the service to Log on as ʺThis accountʺ. 

• Supply a domain user and password if on a domain.
• Supply a local account with matching username and password as the 

network storage device if not.
b. Click OK.

6. Stop and start the service from the services dialog.

7. Repeat steps 3 through 6 for the other GCC services.

Configuring the GCC 
portal services

1. From the Windows Start menu, click Windows System → Control Panel.
The All Control Panel Items window opens.

2. Make sure the View by (upper right) is set to Small icons, then click on 
Administrative Tools. 
The Administrative Tools window appears.

3. Locate, then double-click Services.
The Services window opens  (Figure 417).

GCC Services: 

• GCCAuditLogger
• GCCIndexer.
• GCCTaskManager

Figure 417   Services window
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• GCCWebServer
• GCC WorkflowBroadcastService: This service enables the instrument to notify 

analysis applications that data is available for analysis.
• GCC DeepLaserService: This service enables the instrument to send notifications 

and upload data to the Thermo Fisher Scientific Cloud.

4. Right-click GCC Audit Logger (or another service you are configuring) and 
select Properties. 
The Properties dialog box appears. (Figure 418)

5. Click the Log On tab.

6. Change the log on information for the service.
a. Change the service to Log on as ʺThis accountʺ. 
b. Supply a domain user and password if on a domain.
c. Supply a local account with matching username and password as the network 

storage device if not.
7. Click OK.

A message window appears stating you have been granted Log On As privileges.
8. Click OK.

A message window appears stating you must stop and restart the service to 
initiate your new login appears.

9. Click OK.
The Services window appears.

10. Click to highlight the service you just modified. then Stop and Start the service 
from the services dialog. 

11. Repeat steps 4 through 10 for each remaining GCC service.

Figure 418   GCC AuditLogger 
Properties dialog box, Log On tab
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Adding the network data storage as a data root

To add the network data storage as a data root in GCC Portal:

1. Start GCC Portal.
2. Navigate to Data → Data Roots → Add.
3. Paste the UNC path to the share into the dialog box. UNC paths follow this 

format: \\servername\share. Mapped network drives should not be used 
(mapped network drives are network folders that a user has mapped to a drive 
letter, for example, “H:”.)

4. Click Add. 
Note: If you have not configured the GCC Services correctly, you will see a 
warning message in the Add Data Root window. For more information on, see 
ʺConfiguring GCC servicesʺ on page 346

If you configured this correctly you should be able to view the share in the Folder 
Viewer.

Figure 419   Adding network data root

Figure 420   Network data root
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issues
You can use the Windows Sharing and Security settings to control access to your data 
when using network functionality. GCC supports setting permissions at the folder 
level, not the file level, even though the Windows settings can be set at the file level. 
You can change the settings for Sharing, permissions, and security for a selected file, 
but you need to be very careful about setting permissions when using GCC; you could 
lock yourself out of your own data or deny access to other people if the permissions are 
set incorrectly. 
Note: Contact your IT/CIS support for help in setting the permissions for folders and 
files.

The Windows file sharing and security issues are described in further detail in:
• ʺGeneral principles of security in the Command Console softwareʺ, below
• ʺHow do files get permissions that do not match the folder?ʺ on page 351
• ʺHow does Command Console show this error?ʺ on page 351
• ʺHow to avoid this issueʺ on page 351
• ʺHow to adjust permissions for files in a folderʺ on page 352

General principles of security in the Command Console software

Security within Command Console can be separated into two different functional 
areas:

• Viewing file lists in the web UI, either from folders or from search results.
• File operations, such as editing or creating. 

Security for viewing file lists is implemented at the folder level. If a user has read 
permissions on a particular folder, Command Console will not display files within that 
folder if the user does not have read permissions for those files. In addition, if the user 
tries to perform various operations on those files, the operating system will not allow 
it. Conversely, if the user has read permissions to several files in a folder, but does not 
have read permissions on the parent folder, the files will not be displayed in the 
Command Console software. In order to maintain consistent permissions on files 
within the system, individual files should not have permissions set differently from 
their parent folder. If this occurs due to other applications or operating system 
functions, the permissions on all the files in a folder can be reset by an administrator.
When performing file operations, including editing the Sample (ARR) file, re-gridding 
the Image (DAT) file, or regenerating an Intensity (CEL) file, a user may be prohibited 
by the operating system if the user does not have appropriate permissions for that file. 
The Command Console UI attempts to indicate when an operation fails due to 
permissions, but there are times when the operating system does not indicate why an 
operation failed. If the user e10ects to be able to modify a file but cannot, and can 
modify other files within the same folder, it is possible that individual files have 
permissions that limit access. If this occurs, the file permissions should be checked by 
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an administrator and reset as necessary.

How do files get 
permissions that do 
not match the 
folder?

Under most operating conditions, the files in a folder will have the same permissions 
as the folder in which they reside. However, there are particular cases when a file is 
moved that may cause the file to retain certain permissions that were applied to the file 
in its previous location. In this case, the file will not have the same permissions as the 
new folder or the other files in the folder. 
This happens to files that are moved to a new folder on the same NTFS partition on a 
local hard disk. It is important to note - this is a function of the Operating System, not 
Command Console. 
As an example, a data folder has two subfolders, Project1 and Project2, and the Project1 
and Project2 folders have different permissions. If a user with appropriate permissions 
moves a file from Project1 to Project2, the files moved to the Project2 folder may retain 
some of the permissions applied in the Project1 folder. If another user who has 
permissions to the Project2 folder but not to the Project1 folder tries to perform 
operations on these moved files, the operations may fail.
There are many conditions where this does not occur:

• Moving a file from a local hard disk to network storage (C:\data to 
\\storage\data)

• Moving a file from one folder to another on network storage (\\storage\data to 
\\storage\backup)

• Moving a file from one local hard disk to another local hard disk (C:\data to 
D:\data)

• Copying files from one location to another

How does 
Command Console 
show this error?

The files or folders to which the user does not have access are not visible in the GCC 
Portal pages. For example, if the user has read permission for a folder, but is denied 
access to specific files in the folder, then the following files are not displayed on the 
following pages:

• Folder View
• Search Results
• Project View

How to avoid this 
issue

There are ways to avoid this issue that will not impact normal operations. These 
include:

• Not setting overly restrictive permissions on shared systems, especially 
Instrument Control Workstations

• Using network storage for the bulk of data, and applying permissions on the 
network folders

• Only applying permissions on the network folders that are truly necessary
• Access data through UNC paths whenever possible
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Simple security 
recommendations

• Set permissions for groups, as opposed to individuals, for greater simplicity.
• Only restrict permissions to the degree needed, again for greater simplicity.
• Set permissions at the folder level when creating data roots and projects.
• Don’t use Deny permissions unless absolutely necessary, as these are more likely. 

to cause a situation with conflicting entries.
• Don’t restrict (deny) the “Read permissions” permission. This is needed in order 

for the software to properly determine the rights the user has for a given object.
• Take care when moving files that the consistency is not broken. If possible, move 

files by using the WebUI Copy Project and Upload Data functions.
• When permissions do get out of sync, they can be easily restored by an admin, 

who can remove the conflicting ACL entries and allow the file to get its 
permissions by pure inheritance.

How to adjust 
permissions for 
files in a folder

To reset the permissions for all files and sub-folders in a folder:

1. Right-click on the folder in question and select Properties.
The folder’s Properties dialog box appears.

2. Click the Security tab. (Figure 421)

3. Click the Advanced button.
The Advanced Security Settings dialog box opens. (Figure 422)

Figure 421   Data Properties dialog box
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4. Verify that the security settings are appropriate. 
5. Click to select (highlight) the permission entry you want to modify, then click 

Change permissions. 
The following permission options appear. (Figure 423)

Figure 422   Advanced Settings tab

Figure 423   Advanced Settings tab
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6. Click the appropriate button and click the Replace all child object permission 
entries... check box (if applicable), then click OK.
The following notice may appear. (Figure 424)

To replace the permission you just modified, click Yes. 
Note: This will reset the permissions for all files and sub-folders of the selected 
folder.

Figure 424   Security notice box
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Report description

The Cell Summary Report is a tool for monitoring the performance of the hybridization 
and grid alignment of arrays. The report enables you to detect problems in these steps 
and compare the performance of different chips.
The Cell Summary Report uses the control features on the array. Control features are 
cells with special probes; the corresponding targets are spiked into the sample cocktail. 
The resulting patterns of bright and dark cells are used in grid alignment and other 
processes.
In GCC the Cell Summary Report is automatically generated when CEL files are 
generated for certain types of arrays. These arrays require a GRC file in the library file 
set. If you generate a CEL file for one of these arrays and the GRC file is not available, 
you will see an error notice.
You can learn more about the Cell Summary reports in the following sections:

• ʺReport descriptionʺ
• ʺUsing the cell summary reportʺ on page 360
• ʺCell summary report algorithmʺ on page 361

The cells that failed the analysis can be seen in the GCC Viewer when looking at the 
DAT or CEL file (see ʺFile display differencesʺ on page 280).
The reports are placed in the data root and subfolder with the CEL file.
The cell summary report components are described in ʺCell summary report 
Components for non-resequencing chipsʺ.

Cell summary 
report Components 
for non-
resequencing chips

The Cell Summary Reports for all types of chips except Resequencing (Expression, 
Mapping, and others) provides information on the following features:

• Non-synthesized features
• OligoB1 features
• OligoB2 features

Refer to the relevant manual for the GeneChip array for more information about these 
features.

To open the Cell Summary Report:

1. Open the CEL file in the GCC Viewer.
2. In the Properties box, click on the Report row.

A button appears in the Report Row. (Figure 425)
3. Click on the button to open a text display of the CELL Summary report.
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The Text Editor opens with the Cell Summary Report displayed. (Figure 426)

Figure 425   Cel Summary Report Section

Figure 426   Cell Summary report for Non-resequencing array

Report Header

Metrics

Report Summary
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This report contains the following sections:
• ʺReport headerʺ
• ʺSummaryʺ on page 357
• ʺMetricsʺ on page 358

Report header

The report header (Figure 427) lists basic information about the Cell Summary report:

Summary

The Summary (Figure 428) displays information:

Figure 427   Expression Cell Summary report: header

Report Type Used to distinguish types of reports (Cell Summary Report, Algorithm Report, etc.).

Date Time and date report was generated.

Filename Input CEL data file name that was used to generate the report.

GRC Filename Name of the GRC file used to generate the report.

Probe Array Type Array type used for the CEL file.

Figure 428   Expression Cell Summary report: Summary

For the following types of features:

Non-synthesized features

Bright control probes

Dim control probes
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Metrics

The metrics section (Figure 429) displays additional data about the B1 and B2 oligos.

Total control features

The summary lists the following values:

Failures The number of features in the category that failed.

Total The total number of features in the category.

Failure Rate The percentage of features in the category that failed.

Figure 429   Expression Cell Summary report: metrics
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Failed cell locations

Note: To view these probes on a DAT file, view the cell intensity display. For more 
information about this option, see ʺViewing failed control featuresʺ on page 281.

Figure 430   Cell intensity data with failed control features masked
GeneChip™ Command Console™ (GCC) User Guide 359



Appendix C Cell summary report
Using the cell summary report C
Using the cell summary report

The Cell Summary report provides clues to problems in the fluidics, grid alignment, 
and other issues with the cell file.
It can be used to establish a baseline for performance, which can then be used for 
quality control for subsequent experiments.
Features can fail the evaluation due to sample and system issues such as: 

• Incorrect gridding 
• Incorrect concentration of control oligo in sample (too high or too low) 
• Incorrect scanner arc correction 
• Incorrect recording of the scanner pixel size 
• Incorrect parameters for cell file generation 
• Debris in the sample or on the array glass 
• Array defects

Rules of thumb When processing a group of samples, identify the cell files that have the largest 
number of evaluation failures. This would be about ten percent of the cell files in the 
group. Use the graphic display described below to examine those cell files to identify 
any sample or system issues. 
When processing one or two samples use the graphic display to examine those cell files 
with evaluation failures greater than ten. 
In the event of substantial (greater than one hundred) evaluation failures the following 
guidelines may be helpful: 

• Failures limited to mostly bright or mostly dim control probes usually indicate 
debris or array defects. 

• Failures limited to mostly non-synthesized features often indicate non-specific 
binding and usually do not compromise any biological measurements. 

• Failures spanning both bright and dim probes often indicate gridding, scanning 
or other systematic issues. 

The relationship between Cell Summary Report results and biological results varies 
depending on the application. It is best to track these and determine trends for your 
laboratory and application. 
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Cell summary report algorithm

The algorithm’s goal is to use the probe design information to identify all probes that 
should have high intensities and make sure they in fact have high intensities. Similarly 
with the probes that should be dim. The features that fail the evaluation are totaled and 
flagged to enable their graphic display. 
Depending on the array/assay type, it is the target for the B1 probes that is spiked in 
and in others the target for the B2 probes is used. 
Thus, the first step of the algorithm is to determine which of the two probe types is 
brighter overall. The median for each of the B1 and the B2 probes is determined and if 
there is sufficient contrast (difference in median intensities) the probe type with the 
larger median is taken to be the bright probe type. 
If the contrast is insufficient an algorithm failure is reported. This kind of failure is 
typically only seen in the case of gross errors—such as use of the wrong library file, 
improper use of control reagents (spiking in both or neither of B1 and B2 control 
reagents) or rotation of the DAT image. The threshold is the calculated midpoint (or 
log midpoint) of the B1 and B2 medians. 
The algorithm examines each feature. If the feature is either B1, B2, or non-synthesized, 
then the intensity is compared against the threshold; otherwise, the feature is ignored. 
If the feature fails the threshold, then the feature is added to the total and the feature 
flagged to enable graphic display.
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GeneTitan library file installer

1. From the Launcher, double-click on GeneTitan Library File Installer.
The GeneTitan Library File Installer window appears. (Figure 431)

2. Click the Source Path’s Browse button.
A Browse For Folder window appears.

3. Navigate (as you normally would) to the source location of the library files you 
want to install.

4. Click Select Folder.
The available library file packages appear in the File Name and Path pane.
Note: Use the default Target path. Changing the target path is not recommended.

5. Click the check box(es) adjacent to the library filename you want to install, then 
click Install.
A progress bar appears.
After the installation is complete, an Installed successfully message appears.

6. Click OK to acknowledge the message, then close then the GeneTitan Library File 
Installer window.

Figure 431   GeneTitan Library File Installer
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7. Enter the email account the messages will be sent from in the From box.
8. Enter the email account(s) to receive the message in the To... Box
9. Enter the SMTP Server and Port information in the appropriate boxes.
10. You can click the Test button to send a test e-mail.
11. Select the Scanner or Fluidics tab, depending upon which instrument you want 

to select messages for (Scanner or Fluidics).
The message list displays the messages you can select from--they correspond to 
different types of failures or other conditions in the instrument.

12. Select and edit messages:
a. Select the check box next to the message ID.
b. Click in the subject or body column for the message and edit the text.

You can click the Default button to return to the original configuration.
13. Click Save to save the configuration changes.

Figure 432   Message List for Scanners
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Library file importer

Importing from CD 
or folders

1. From the Launcher, double-click on Library File Importer.
The Library File Importer window appears. (Figure 431)

2. Click on the Import parameters from a GCOS library file package CD or folder 
radio button, then click Next.
The Select Source of Library Files window appears.  (Figure 434)

3. Click the Browse button to select the drive location for files you want to import. 
The Browse for Folder window appears.

4. Navigate to your source location as you normally would, then click OK. 
5. Click the Browse button, to select a saving location for files you are importing. 

The Browse for Folder window appears.

Figure 433   Library file importer window

Figure 434   Select Source of Library Files 
window
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6. Navigate to your save location as you normally would, then click OK. 
7. At the Library File Importer window (after your source and save locations are 

set), click Next.

The Select Probe Array Types window appears (Figure 435) and displays a list of 
the library files available in the selected folder or CD with their location. Duplicate 
probe arrays types are grouped at the top of the list.

8. Click the appropriate check box or click Select All, then click Start. Click Unselect 
All to deselect your checked box(es).
A Status window (Figure 436) with a progress bar appears.

9. After processing has been successfully completed, click Finish. 
Note: If you have selected the same library file from two sources, a warning appears. 
Click OK to return to the Select Array window, then deselect the duplicate array 
package. If you have selected library files that are already installed, a Choose Library 
Version window appears. Click the radio buttons to choose the appropriate versions, 

Figure 435   Select Probe Array Type window
GeneChip™ Command Console™ (GCC) User Guide 365



Appendix D Installing library files and scripts
Library file importer D
then click OK.

Figure 436   Status window
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Fluidics script installer

1. From the Launcher, double-click on Fluidics Script Installer.
A Welcome window appears. (Figure 437)

2. Click Next.
The Select Software screen appears. (Figure 438)

3. Click Next.
The Select Directory window appears. (Figure 439)

Figure 437   Fluidics Scripts Installer

Figure 438   Select Software
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To install from a directory:
– Click the radio button.
– Click Browse.
– Navigate to the file location as you normally would.
– Click to select the protocol, then click OK.

The file location is now displayed.
– Click Next.

The Select Package window appears. (Figure 440)

To install from thermofisher.com
– Click the radio button.
– Enter your registered username (email) and password.
– Click Next.

The Select Package window appears. (Figure 440)

Figure 439   Select Source window

Figure 440   Select Package window
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4. Select the package you want to install, then click Next.
The Select Protocols window appears. (Figure 441)

5. Select the check box(es) of the protocols you want to install, then click Next.
The Summary window appears. (Figure 442)

6. Review the information and click Next.
An Install window appears with a progress bar.
When the install is completed, the Finish window appears.

7. Click Close.
Note: If you opened the Installer through the GCC Fluidics Control Software, you 
must close the software, then reopen it for the installed scripts to appear in the drop-
down lists.

Figure 441   Select Protocols

Figure 442   Summary window
GeneChip™ Command Console™ (GCC) User Guide 369



E Notification e-mails
Configuring notification e-mails

GCC provides e-mail notification of problems when:
• Running the GCS 3000 with AutoLoader
• Running the FS-450 Fluidics Station
• Running the GeneTitan Instrument
• Running the Data Uploader

You will need to get information on the SMTPPort and SMTPServer from your IT 
department.

To configure the email notification for GCC Fluidics control or GCC Scan control:

1. In the appropriate instrument control software, click the Email button; or
From the Edit menu, select Email Messages...
The GCC Email Configuration Editor opens (Figure 443).

2. Enter the email account the messages will be sent from in the From box.
3. Enter the email account(s) to receive the message in the To... Box
4. Enter the SMTP Server and Port information in the appropriate boxes.
5. You can click the Test button to send a test e-mail.

Figure 443   GCC Email Configuration Editor
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6. Select the Scanner or Fluidics tab, depending upon which instrument you want 
to select messages for (Scanner or Fluidics).
The message list displays the messages you can select from--they correspond to 
different types of failures or other conditions in the instrument.

7. Select and edit messages:
a. Select the check box next to the message ID.
b. Click in the subject or body column for the message and edit the text.

You can click the Default button to return to the original configuration.
8. Click Save to save the configuration changes.

Figure 444   Message List for Scanners
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GCC log files

The log files are produced by different GCC components. The logs provide a record of 
the tasks performed by different components, such as the migration tools and installer. 
These log files provide useful information for troubleshooting problems and may be 
requested by your support person. For details on how to collect and send log files, see 
ʺError logsʺ on page 40
The following files apply to both Cartridge Systems and GeneTitan Instruments. All 
the GCC log files from C:\Command_Console\Logs
The different log files include:

Other GCC Files
Your support person may need the following files for troubleshooting:

1. Library files (*.PARAMS, *.MASTER, *.WORKFLOW, *.SMD, *.MEDIA) located 
in C:\Command_Console\Library, excluding the large analysis library files 
(CDF, PSI, GRC). 

2. Provide a list of all sub folders and their contents under the library files folder 
located in C:\Command_Console\Library. Please ensure there are no duplicate 
library files, as these can cause problems.

3. GCC system configuration file located at 
C:\Command_Console\Configuration\Calvin.System.config

4. Pending job order files located in C:\Command_Console\Jobs
5. Other GCC related information, such as:

a. The number of files under C:\Command_Console\Data, including sub 
directory.

b. If the system is a networked system or a standalone system.
c. Other applications installed on the system, such as antivirus application, MS 

Office, Internet Explorer versions.

Systemlog.XML XML file with system information.

Workflow.log Text file with information on workflow status and 
history.

GCC_LibFileImporter. log 
(with date and time code)

Text file with info on use of the Library File Importer.
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GCC log files for cartridge systems

The following files are instrument-specific log files that apply to GCS 3000/FS 450 
Instruments.

GCC log files for GeneTitan systems

Log files for the GeneTitan Instrument control processes are placed in subdirectories 
of the Command Console\Logs\ folder. 
Your support person may need the following files for troubleshooting:

GeneTitan Fluidics

1. C:\Command_Console\Logs\96F\
a. subdirectories named by date (e.g. Log7-29-2009) 

– Collect all dated directories and contents since the GeneTitan app was started, 
not just the date of the event (some logging goes into files from the date the app 
started so this can be critical for us).

– Absolutely required are all the log directories from the date the run was started 
to the date of the event.

2. C:\Command_Console\Logs\96F\FluidicErrorLog - all files in this directory
3. C:\Command_Console\RAP2

The main user interface to this logging structure is file is 
C:\Command_Console\RAP2\RAP.html. 
• RAP.html contains historical information (since GCC 4.3 was installed) about 

what has been run on the system
• RAP.html contains links to locations within the RAP2 folder and to some 

locations the standard logs found in C:\Command_Console\Logs\96F
• The logging structure supplements the standard logs found in 

C:\Command_Console\Logs\96F. It does not replace it.
• The RAP2 folder is not on the 30 day log file cleaner path.

GeneTitan MC Imaging Device

1. C:\Affymetrix\GeneChipHTScanControlMC\Log - collect all dated directories 
and contents since the GeneTitan app was started

2. C:\Affymetrix\GeneChipHTScanControlMC\RunLog - collect all dated 
directories and contents since the GeneTitan app was started.

fluidics.log Text file with info on Fluidics Station use

scanner.log Text file with info on Scan Control use

FS.log (with date and time code) Text file with information on the Fluidics Script 
installation.
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Collecting GCS3000/FS450 log files

Log files are produced by different GCC components. The logs provide a record of the 
tasks performed by different components, such as the migration tools and installer. 
These log files provide useful information for troubleshooting problems and may be 
requested by your support person.

1. From the GCC Launcher, click Log Collector.
The Collect Logs window appears. (Figure 445)

2. Click on the Days drop-down to select the number of days worth of log files you 
need to collect.

3. Click Collect Logs.
A Collecting logs. Please wait... message appears. (Figure 446)
To terminate a log collection in progress, click Cancel.

After a few moments, a zip file containing your collected logs is placed onto your 
Desktop for easy access.

Figure 445   Logs Files Collector window

Figure 446   Logs Files Collector window
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Using TSV files for batch editing

You can no longer download batch registration or batch editing files in TSV (Tab-
Separated-Values) format in GCC, but you can use previously created TSV files. The 
format of TSV files is discussed here.
The header row in a TSV file includes special properties that define the file and the 
physical array:

Note: Specify either the Path or the Project for the files. Specifying both will return 
an error message.

Path
The path needs to be associated with a data root. You can assign a set of sample files to 
a particular project if you select that projectʹs folder in the Path field.
Note: Specify either the Path or the Project for the files. Specifying both will return an 
error message.

Project
Specifying a project for the Sample file will determine the folder the Sample file is 
created in.

File Name
Enter the name assigned to the Sample file to be created.

Path The path to where the Sample file is created. Can be used to place Sample 
files in project folders.

Project The project that the Sample (ARR) file is assigned to.

File Name Unique identifier for the Sample file.

Array Name Name assigned to the array during registration.

Probe Array 
Type

Part number for the array(s).

Barcode Barcode on the array(s).

Attributes Additional information about the sample and experiment that you can 
use to interpret your results.
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Barcode, array name and array type
If you are using Excel, you can select the probe array type from a drop-down list 
(Figure 447). The drop-down list can be disabled in Excel if you want to enter multiple 
arrays for each sample.

You can also enter multiple array information into the file.
Note: You can use custom barcodes to register an array in Batch Registration.

To enter multiple arrays:

1. Enter a comma-delimited list in the barcode column: FirstArrayBarcode, 
SecondArrayBarcode

2. Enter a comma-delimited list in the array name column: FirstArrayName, 
SecondArrayName

3. Enter a comma-delimited list in the Array Type column: FirstArrayType, 
SecondArrayType

Attributes
Enter the values for the attributes in the appropriate columns. 
GCC uses two types of attributes for Batch Registration:

• Template Attributes: Attributes that have been defined in a template. When you 
select templates for the downloaded batch registration file, the array attributes in 
those templates are included as headings in the batch registration file.

• User Attributes: Attributes that you add in the Batch Register file.You create a 
user attribute by entering the attribute name and other characteristics in the 
column header, and then entering attribute values in the appropriate cells.

Attributes need to have the following characteristics defined:
• AttributeName
• TemplateName (if any; not used for User Attributes)
• DataType

Different methods are used for defining attribute characteristics in TSV and Excel 
format, as described below.

TSV format
In TSV format, all of the attribute characteristics are defined in the column header, as 
shown in the template below.

Figure 447   List of probe 
arrays in Excel 
spreadsheet
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• Header format for Template Attribute: 
AttributeName:TemplateName:DataType

• Header format for User Attribute: AttributeName:*:DataType
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H Reconnector
Introduction

Use the Reconnector to restore file associations among Drop and Scan data files (DAT, 
CEL, and CHP) and a pre-registered Sample (ARR) file on the network.
The types of data and files used in GCC, the methods used to track relationships 
between files, and the types of problems that can occur are described below.
The GCC software tracks:

• Information about the experiment, sample, and array(s)
• Probe array data
• Other information about probe array processing

GCC uses the file types to store array information and data, as shown in Figure 448.

• Information about the sample, experiment, and physical array are collected in 
Sample (ARR) files.

• Probe array data generated during scanning and processing are collected in Data 
files of various types.
– Image Data (DAT)
– Cell Intensity Data (CEL)
– Probe Intensity Data (CHP)
Note: Array data files in GCC use the same file extensions as in GCOS, but they 
are in a different format; GCOS-format array data files cannot be viewed using 
GCC tools, such as the GCC Viewer. You can use DEC to convert GCOS-format 
files into GCC format.

Figure 448   File types used in GCC

Physical Array Name

Tissue Type B Array 1

Intensity (CEL) File

Tissue Type B Array 1.CEL

Probe Intensity (CHP) File

Tissue  Type B Array1.CHP

Audit File

Tissue Type B Array 1.AUDIT

Image (DAT) File

Tissue Type B Array 1.DAT

Sample (ARR) File

Tissue Type B.ARR

Grid Data (GRD) File

Tissue Type B Array 1.GRD

Jpeg Image (JPG) File

Tissue Type B Array 1.JPG
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The DAT, CEL and CHP data files all have parent-child relationships, as shown 
in Figure 449.

In GCC the lineage information for probe array data files is preserved using 
GUIDs, or Globally Unique Identifiers. A GUID is a number that is unique to that 
file. Each sample and data file is assigned a GUID for tracking file lineage 
information (Figure 450). 

• Other files containing additional information about the probe array processing
– Info about processing the array (AUDIT)
– Sub-grid information (GRD) (only for arrays with sub-grids)
– JPEG image (JPG) (only for arrays with sub-grids?)

Figure 449   File Hierarchy displayed in GCC

Figure 450   GUIDs for tracking relationships between Sample and Data files

Intensity (CEL) File(s) Probe Intensity (CHP) File(s)
Sample (ARR) File

File Name: Sample1.ARR

Sample1 ARR File GUID

Array Name: Sample1Array1

Sample1Array1 Array GUID

Image (DAT) File(s)

File Name: Sample1Array1.DAT

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID

File Name: Sample1Array1.CEL

Sample1Array1 CEL File GUID

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID

File Name: Sample1Array1.CHP

Sample1Array1 CHP File GUID

Sample1Array1 CEL File GUID

Sample1Array1 DAT File GUID

Sample1Array1 Array GUID
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Connecting files

Drop and scan data 
files and pre-
registered sample 
files

There are also circumstances where you can have multiple (commonly two) sample 
files for the same array, which is an error condition in GCC. This can happen when you 
perform scans on arrays with sample (ARR) files on a network data root and a problem 
arises with the network connection.
You can create Sample (ARR) files on any data root your GCC system has access to, 
including network data storage. (Figure 451)

However, you cannot create DAT files over a network connection to network data 
storage; instead, the DAT files are created in the default folder on the Scanner 
Workstation computer. (Figure 452)
This is done to protect the DAT file from any problems related to the networks, so that 
an array can always be scanned successfully even when a network is unreliable.

Figure 451   Creating a Sample (ARR) file on a network data root

Creating the Sample (ARR) File on the Network Data Root

Create a Sample (Arr) file for the sample and arrayon the Network Data Root using GCC Portal sample registration functions

Windows
Network

GCC Scanner Workstation Network Data Storage

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Researcher Folder

Scanner Workstation

Data Root

Default Folder
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The Upload Data function can be used to automatically transfer DAT and CEL files 
from the Default folder to the network data storage where the Sample (.ARR) file is 
located. (Figure 453)
Upload Data is useful when you wish to consolidate data from different workstation 
computers onto one network data storage site.

Figure 452   Creating DAT and CEL files on the Scanner Workstation default folder

Scanning the Array on the Scanner Workstation

Windows
Network

Scan the array using the Scanner Workstation. Since GCC cannot create a DAT file over a Windows network, the DAT and CEL file will be created 
on the Scanner Workstation Data Root.

GCC Scanner Workstation Network Data Storage

Image (DAT) File(s)

Tissue Type B Array 1.DAT

Intensity (CEL) File(

Tissue Type B Array 1.CEL

Scanner Workstation

Data Root

Default Folder

The DAT file  on the Scanner Workstation Data 
Root is linked with the Sample (ARR) file on the 
Network Data Root.

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Audit File

Tissue Type B Array 1.Audit

Researcher Folder
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If the network connection between the network data root and the scanner workstation 
fails during the scan, the actual scan isn’t affected. However, the links between the 
Sample file on the network data root and the DAT and CEL files on the Scanner 
workstation will be broken, and a a new Sample (ARR) file is created in the Scanner 
Workstation default folder (with the array barcode used as a name). (Figure 454)

Figure 453   Transferring the DAT and CEL files using the GCC Upload Data function

Transferring the DAT and CEL Data with GCC Data Upload

Windows
Network

GCC Scanner Workstation Network Data Storage

Finally we move the DAT and CEL file to the same folder as the ARR file on the Network Data Root using the GCC Upload Data function

Scanner Workstation

Data Root

Default Folder

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Image (DAT) File

Tissue Type B Array 1.DAT

Intensity (CEL) File

Tissue Type B Array 1.CEL

Researcher Folder

Audit File

Tissue Type B Array 1.Audit
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In this case, you cannot use the GCC Upload Data function to transfer the array data 
files to the Network Data Root. You can transfer the Sample and Data files manually, 
using Windows Explorer or another tool. (Figure 455)

Figure 454   Network Failure example

Network Failure when Performing a Scan for an Array File 
on a Network Data Root

Image (DAT) File(s)

Array_Barcode.DAT

Intensity (CEL) File(

Array_Barcode.CEL

If the Windows Network connection goes down before the scan is performed, the scan is performed as a Drop-In Scan. 
A new Sample (ARR) file is created on the Scanner Workstation using the chip barcode as a name. The barcode is also used as the Physical Array 
Name which is used to name the DAT and CEL files 

GCC Scanner Workstation
Network Data Storage

Scanner Workstation

Data Root

Physical Array Name

Array_Barcode

Sample (ARR) File

Array_Barcode.ARR

Audit File

Array_Barcode.Audit

Default Folder

Network Data Root

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Researcher Folder

Windows Network 
Connection Lost
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After transferring the Sample and Data files to the network data root, you can use the 
Connect Drop and Scan Data Files and pre-registered ARR file function of the 
Reconnect tool to associate the DAT and CEL files with the preregistered Sample File, 
and to merge the sample file data from the drop and scan files. (Figure 456)

Figure 455   Using the Sample File Merge function

Transferring the Drop and Scan Sample, DAT, CEL, and Audit Files

Image (DAT) File(s)

Array_Barcode.DAT

Intensity (CEL) File(s)

Array_Barcode.CEL

GCC Scanner Workstation
Network Data Storage

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Move the Sample, DAT, and CEL files from the Scanner Workstation to the Network Data Root folder. 
The sample files can be placed in the same folder since they will not have the same name.

Audit File

Array_Barcode.Audit

Scanner Workstation

Data Root

Default Folder

Researcher Folder

Physical Array Name

Array_Barcode

Sample (ARR) File

Array_Barcode.ARR

Windows Network 
Connection Lost
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Figure 456   Merging the Sample (ARR) files

Merging Sample (ARR) Files
Merge the Sample (arr) file and rename the data file using the special reconnect feature

Physical Array Name

Array_Barcode

Sample (ARR) File

Array_Barcode.ARR

Image (DAT) File

Tissue Type B Array 1.DAT

Intensity (CEL) File

Tissue Type B Array 1.CEL

GCC Scanner Workstation
Network Data Storage

Physical Array Name

Tissue Type B Array 1

Sample (ARR) File

Tissue Type B.ARR

Network Data Root

Audit File

Tissue Type B Array 1.Audit

Researcher Folder

Scanner Workstation

Data Root

Default Folder

Obsolete Folder

Windows Network 
Connection Lost
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Starting Reconnector

1. From the GCC Launcher, click Reconnector.
The Welcome to the Reconnector window appears. (Figure 457)

The Reconnect Drop and Scan Data Files and pre-registered ARR (batch operation) 
option enables you to:

– Select the folder with the files you wish to merge. Please ensure that the drop 
and scan ARR and associated data files (DAT, CEL, and CHP) and the pre-
registered ARR files are in the same source folder.

– Review and change the proposed relationships among the files in the folder.
– Reconnect the Drop and Scan data files with the pre-registered ARR files.

IMPORTANT!  All files to be reconnected in a particular operation must be in the same source 
folder and must be in GCC format before reconnecting.

Figure 457   Welcome window

IMPORTANT!  As a part of this operation the contents of the drop and scan ARR file will be 
merged with the pre-registered ARR file and the DAT, CEL, and CHP files will be renamed 
using the array name from the pre-registered ARR files.
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To merge data files associated with drop and scan ARR and pre-registered ARR files:

1. Make sure that the files you want to merge are all in the same folder, or in a sub-
folder within the folder

To select the folder:

1. Enter the path in the select folder location box; or
2. Click Browse.

The Browse for Folder window opens.
3. Navigate to the location of the folder, click to highlight it, then click OK.

The Drop and Scan data files and pre-registered Sample (ARR) files in the folder 
and its sub-folders are displayed in a file list window. (Figure 459)

Figure 458   Batch Reconnection - Drop and Scan Data Files and Pre-register ARR window
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The file list window has four columns:

Figure 459   Files displayed in the file list

Status Icon  Unmatched: Indicates unmatched file
 Error: Indicates naming match between incompatible files
 Matched: Indicates match between compatible files.
 Warning: Indicates compatible files with tentative parent-child 

connections but some information mismatch.

Drop and Scan ARR File Sample (ARR) file created during Drop and Scan.

Pre-register ARR File Sample (ARR) file created using sample registration functions of GCC 
Portal.

Status Messages if files are not compatible.

IMPORTANT!  Even though only the Drop and Scan ARR file is displayed in the window, the 
reconnect operation will connect all the associated data files (DAT, CEL, and CHP) with the pre-
registered ARR file.
GeneChip™ Command Console™ (GCC) User Guide 388



Appendix H Reconnector
Starting Reconnector H
Click the check box(es) to select/deselect (show/conceal) these different display 
options:

Use the bottom buttons to:
– Remove Selected - Remove selected/highlighted file(s).
– Break - Break current connections between files.
– Join - Join files that are not yet connected.

4. Click Filter to show a list of files that are not eligible for the merge operation. 
(Figure 460)

5. Click OK to close the Filter window.

To break the tentative connection between two files:

1. Click in the row with the files you want to break.
2. Click the Break button.

Note: You can only break connections previously joined files.

To join two unconnected files:

1. Select the files you wish to join by holding down the Ctrl key while you click on 
each file. (Figure 461)

Matched Files with tentative parent-child connections.

Unmatched Files with no tentative parent-child connections.

Error Incompatible files with tentative parent-child connections.

Warning Compatible files with tentative parent-child connections but some 
information mismatch.

Figure 460   Filter List
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2. Click the Join button.
Note: If the Join operation is not successful, an error message detailing the 
discrepancies appears. Acknowledge the message, then click OK.
If the Join operation is successful, the new parent-child relationship is displayed 
in the file list. (Figure 462)

Figure 461   Files selected for joining

Figure 462   Batch Reconnection window
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3. After joining is complete, click Reconnect to connect all matched files.
The Reconnect Status window appears. (Figure 463)

Batch Merge Status The Reconnect Status window displays the status of the different attempts at merging 
Sample (ARR) files. 

The list displays the files that have had their connections changed, with the following 
information:

Click Log (bottom left) to open a file giving log information about the reconnect 
operations.

Figure 463   Reconnect Status window

Status Icon  Unmatched: Indicates unmatched file

 Error: Indicates naming match between incompatible files

 Matched: Indicates match between compatible files.

 Warning: indicates compatible files with tentative parent-child 
connections but some information mismatch.

Parent File Parent file.

Child File Child file.

Status Status of connect operation.
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